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1.0 Define Phase
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1.1 Overview of Six Sigma
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Black Belt Training: Define Phase

1.1 Six Sigma Overview

1.1.1 What is Six Sigma

1.1.2 Six Sigma History

1.1.3 Six Sigma Approach Y = f(x)

1.1.4 Six Sigma Methodology

1.1.5 Roles and Responsibilities

1.2 Six Sigma Fundamentals

1.2.1 Defining a Process

1.2.2 VOC and CTQs

1.2.3 QFD

1.2.4 Cost of Poor Quality (COPQ)

1.2.5 Pareto Analysis (80 : 20 rule)

1.3 Lean Six Sigma Projects

1.3.1 Six Sigma Metrics

1.3.2 Business Case and Charter

1.3.3 Project Team Selection

1.3.4 Project Risk Management

1.3.5 Project Planning

1.4 Lean Fundamentals

1.4.1 Lean and Six Sigma

1.4.2 History of Lean

1.4.3 The Seven Deadly Muda

1.4.4 Five-S (5S)
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1.1.1 What is Six Sigma
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What is Six Sigma?

• What is “sigma”?

• In statistics, sigma (s) refers to “standard deviation,” which is a measure of variation.

• You will come to learn that variation is the enemy of any quality process. We need to 

understand, manage, and minimize process variation.

• What is “Six Sigma”?

• Six Sigma is an aspiration or goal of process performance.

• A Six Sigma “goal” is for a process average to operate approximately 6s away from 

customer’s high and low specification limits.
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What is Six Sigma?

• A process whose average is about 6s away from the customer’s high 

and low specification limits has abundant room to “float” before 

approaching the customer’s specification limits.

• A Six Sigma process only yields 3.4 defects for every million 

opportunities! In other words, 99.9997% of the products are defect-

free! 
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What is Six Sigma: Sigma Level

• Sigma level measures how many “sigma” there are between your 

process average and the nearest customer specification.

• Let us assume that your customers upper and lower specifications 

limits (USL & LSL) were narrower than the width of your process 

spread.

• The USL & LSL below stay about 1 standard deviation away from the 

process average. Therefore, this process operates at 1 sigma.
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What is Six Sigma: Sigma Level

• A process operating at 1 sigma has a defect rate of approximately 70%.

• This means that the process will generate defect-free 

products only 30% of the time. 

• What about processes with more than 1 sigma level?

• A higher sigma level means a lower defect rate. 

• Let us take a look at the defect rates of processes at different sigma 

levels.
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What is Six Sigma: Sigma Level

• This table shows each sigma level’s corresponding defect rate and 
DPMO (defects per million opportunities).

• The higher the sigma level, the lower the defective rate and DPMO.

• How does this translate into things you might easily relate to?
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What is Six Sigma: Sigma Level

• Let us take a look at processes operating at 3 sigma.

• 3 sigma processes have a defect rate of approximately 7%. What 

would happen if processes operated at 3 sigma?

• Virtually no modern computer would function*.

• 10,800,000 health care claims would be mishandled each year.

• 18,900 US savings bonds would be lost every month.

• 54,000 checks would be lost each night by a single large bank.

• 4,050 invoices would be sent out incorrectly each month by a modest-sized 

telecommunications company.

• 540,000 erroneous call details would be recorded each day from a regional 

telecommunications company.

• 270 million erroneous credit card transactions would be recorded each 

year in the United States.
(*http://www.qualityamerica.com)
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What is Six Sigma: Sigma Level

• What if processes operated with 1% defect rate?

• 20,000 lost articles of mail per hour*.

• Unsafe drinking water almost 15 minutes per day.

• 5,000 incorrect surgical operations per week.

• Short or long landings at most major airports each day.

• 200,000 wrong drug prescriptions each year.

• No electricity for almost 7 hours per month.

• Even at 1% defect rate, some processes would be unacceptable to you 
and many others.

• So what is Six Sigma?

• Sigma level is the measure!

• Six is the goal!
(* Implementing Six Sigma – Forest W. Breyfogle III)
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What is Six Sigma: The Methodology

• Six Sigma itself is the goal, not the method.

• In order to achieve Six Sigma, you need to improve your process 

performance by:

• Minimizing the process variation so that your process has enough room to 

fluctuate within customer’s spec limits 

• Shifting your process average so that it is centered between your 

customer’s spec limits.

• Accomplishing these two process improvements (along with 

stabilization and control), you can achieve Six Sigma.

• DMAIC is the systematic methodology prescribed to achieve Six 

Sigma.
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What is Six Sigma: The Methodology

• DMAIC is a systematic and rigorous methodology that can be applied 

to any process in order to achieve Six Sigma.

• It consists of 5 phases of a project:

• Define

• Measure

• Analyze

• Improve

• Control.

• You will be heavily exposed to many concepts, tools, and examples of 

the DMAIC methodology through this training.

• You will be capable of applying the DMAIC methodology to improve the 

performance of any process at the completion of the curriculum. 
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1.1.2 Six Sigma History
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Six Sigma History

Polaroid
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Six Sigma History

• The “Six Sigma” terminology was originally adopted by Bill Smith at 
Motorola in the late 1980s as a quality management methodology.

• As the “Father of Six Sigma,” Bill forged the path for Six Sigma through 
Motorola’s CEO Bob Galvin who strongly supported Bill’s passion and 
efforts.

• Starting from the late 1980s, Motorola extensively applied Six Sigma as 
a process management discipline throughout the company, leveraging 
Motorola University.

• In 1988, Motorola was recognized with the prestigious Malcolm 
Baldrige National Quality Award for its achievements in quality 
improvement.
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Six Sigma History

• Six Sigma has been widely adopted by companies as an efficient way 

of improving the business performance since General Electric 

implemented the methodology under the leadership of Jack Welch in 

the 1990s.

• As GE connected Six Sigma results to its executive compensation and 

published the financial benefits of Six Sigma implementation in their 

annual report, Six Sigma became a highly sought-after discipline of 

quality.
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Six Sigma History

• Most Six Sigma programs cover the aspects, tools, and topics of Lean 
or Lean Manufacturing.

• The two work hand in hand, benefitting each other.

• Six Sigma focuses on minimizing process variability, shifting the process 
average, and delivering within customer’s specification limits.

• Lean focuses on eliminating waste and increasing efficiency.

• Lean and its popularity began to form and gain significant traction in 
the mid 1960s with the Toyota initiative “TPS” or Toyota Production 
System. 

• The concepts and methodology of Lean, however, were fundamentally 
applied much earlier by both Ford and Boeing in the early 1900s.
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Six Sigma History

• Despite the criticism and immaturity of Six Sigma in many aspects, its 

history continues to be written with every company and organization 

striving to improve its business performance.

Polaroid
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1.1.3 Six Sigma Approach
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Six Sigma Approach: Y = f(x)

• The Six Sigma approach to problem solving uses a transfer function.

• A transfer function is a mathematical expression of the relationship 

between the inputs and outputs of a system.

• Y = f(x) is the relational transfer function that is used by all Six Sigma 

practitioners. 

• It is absolutely critical that you understand and embrace this concept.
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Six Sigma Approach: Y = f(x)

• “Y” refers to the measure or output of a process.

• Y is usually your primary metric

• Y is the measure of process performance that you are trying to improve.

• f(x) means “function of x.”

• x’s are factors or inputs that affect the Y

• Combined, the Y = f(x) statement reads “Y is a function of x.”

• In simple terms: “My process performance is dependent on certain x’s.”

• The objective in a Six Sigma project is to identify the critical x’s that 

have the most influence on the output (Y) and adjust them so that the Y 

improves.
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Six Sigma Approach: Y = f(x)

• Let us look at a simple example of a pizza delivery company that 

desires to meet customer expectations of on-time delivery.

• Measure = on-time pizza deliveries 

• Y = percent of on-time deliveries

• f(x) would be the x’s or factors that heavily influence timely deliveries 

• x1: might be traffic

• x2: might be the number of deliveries per driver dispatch

• x3: might be the accuracy of directions provided to the driver

• x4: might be the reliability of the delivery vehicle

• etc.

• The statement Y = f(x) in this example will refer to the proven x’s 

determined through the steps of a Six Sigma project.
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Six Sigma Approach: Y = f(x)

• With this approach, all potential x’s are 

evaluated throughout the DMAIC 

methodology.

• The x’s should be narrowed down until 

the vital few x’s that significantly influence 

“on-time pizza deliveries” are identified!

Y=f(x)

X8

X6

X1

X5
X7 X4

X3
X2
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Six Sigma Approach: Y = f(x)

• This approach to problem solving will take you through the process of 

determining all potential x’s that might influence on-time deliveries and 

then determining through measurements and analysis which x’s do

influence on-time deliveries.

• Those significant x’s become the ones used in the  Y = f(x) equation.

• The Y = f(x) equation is a very powerful concept and requires the ability 

to measure your output and quantify your inputs. 

• Measuring process inputs and outputs is crucial to effectively 

determining the significant influences to any process.
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1.1.4 Six Sigma Methodology
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Six Sigma Methodology

• Six Sigma follows a methodology that is conceptually rooted in the 

principles of a five-phase project. 

• Each phase has a specific purpose and specific tools and techniques 

that aid in achieving the phase objectives.

• The 5 phases of DMAIC:

1. Define

2. Measure

3. Analyze

4. Improve

5. Control
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Six Sigma Methodology

Define
• Define and quantify the problem 

and objective

Measure
• Baseline process, validate measures, and 

identify all possible x’s and dependent Y’s

Analyze • Analyze and validate causes 
identifying critical factors

Improve • Develop solutions

Control • Implement and 
sustain solutions
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Six Sigma Methodology: Define Phase

• The goal of the Define phase is to establish a solid foundation and 

business case for a Six Sigma project. 

• Define is arguably the most important aspect of any Six Sigma project.

• All successful projects start with a current state challenge or problem 

that can be articulated in a quantifiable manner. 

• It is not enough to just know the problem, you must quantify it and also 

determine the goal. 

• Once problems and goals are identified and quantified, the rest of the 

define phase will be about valuation, team, scope, project planning, 

timeline, stakeholders, Voice Of the Customer (VOC), and Voice Of the 

Business (VOB).
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Six Sigma Methodology: Define Phase

• Define Phase Tools and Deliverables

• Project Charter – Establish the: 

• Business Case

• Problem Statement

• Project Objective

• Project Scope

• Project Timeline

• Project Team.

• Stakeholder Assessment

• High-Level Pareto Chart Analysis

• High-Level Process Map

• VOC/VOB and CTQs Identified and Defined

• Financial Assessment
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Six Sigma Methodology: Measure Phase

• The goal of the Measure phase is to gather baseline information about 

the process (process performance, inputs, measurements, customer expectations 

etc.). 

• Throughout the Measure phase you will seek to achieve a few 

important objectives:

• Gather All Possible x's

• Assess Measurement System and Data Collection Requirements

• Validate Assumptions

• Validate Improvement Goals

• Determine COPQ (Cost of Poor Quality)

• Refine Process Understanding

• Determine Process Stability

• Determine Process Capability.
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Six Sigma Methodology: Measure Phase

• Measure Phase Tools and Deliverables

• Process Maps, SIPOC, Value Stream Maps

• Failure Modes and Effects Analysis (FMEA)

• Cause-and-Effect Diagram

• XY Matrix

• Six Sigma Statistics 
• Basic Statistics

• Descriptive Statistics

• Measurement Systems Analysis 
• Variable and/or Attribute Gage R&R 

• Gage Linearity and Accuracy or Stability

• Basic Control Charts

• Process Capability (Cpk, Ppk) and Sigma Levels

• Data Collection Plan
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Six Sigma Methodology: Analyze Phase

• The Analyze phase is all about establishing verified drivers. 

• In the DMAIC methodology, the Analyze phase uses statistics and 

higher-order analytics to discover relationships between process 

performance and process inputs (in other words, what are the root 

causes or drivers of the improvement effort). 

• Ultimately, the Analyze phase establishes a reliable hypothesis for 

improvement solutions. 

• Establish the Transfer Function Y = f(x)

• Validate the List of Critical x's and Impacts

• Create a Beta Improvement Plan (e.g., pilot plan).
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Six Sigma Methodology: Analyze Phase

• Analyze Phase Tools and Deliverables

• The Analyze phase is about proving and validating critical x’s using the 

appropriate and necessary analysis techniques. Examples include:

• Hypothesis Testing

• Parametric and Non-Parametric

• Regression

• Simple Linear Regression

• Multiple Linear Regression

• The Analyze phase is also about establishing a set of solution hypotheses 

to be tested and further validated in the Improve phase.
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Six Sigma Methodology: Improve Phase

• The goal of the Improve phase is. . .you guessed it! "make the 

improvement." Improve is about designing, testing, and implementing 

your solution. 

• To this point you have defined the problem and objective of the project, 

brainstormed possible x's, analyzed and verified critical x's. Now it's 

time to make it real!

• Statistically Proven Results from Active Study/Pilot

• Improvement/Implementation Plan

• Updated Stakeholder Assessment

• Revised Business Case with Return on Investment (ROI)

• Risk Assessment/Updated FMEA

• New Process Capability and Sigma.
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Six Sigma Methodology: Improve Phase

• Improve Phase Tools and Deliverables

• Any Appropriate Tool from Previous Phases

• Design of Experiment (DOE)

• Full Factorial

• Fractional Factorial

• Pilot or Planned Study Using:

• Hypothesis Testing

• Valid Measurement Systems

• Implementation Plan
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Six Sigma Methodology: Control Phase

• The last of the 5 core phases of the DMAIC methodology is the 

Control phase. 

• The goal of the Control phase is to establish automated and managed 

mechanisms to maintain and sustain your improvement.

• A successful control plan also establishes a reaction and mitigation 

plan as well as an accountability structure.
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Six Sigma Methodology: Control Phase

• Control Phase Tools and Deliverables

• Statistical Process Control (SPC/Control Charts)

• IMR, XbarS, XbarR, P, NP, U, C etc.

• Control Plan Documents

• Control Plan

• Training Plan

• Communication Plan

• Audit Checklist

• Lean Control Methods

• Poka-Yoke

• Five-S

• Kanban
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Six Sigma Methodology

Define

• Goal: Problem Statement, Objective, Business Case, Project Scope, Team

• Main Tools: Project Charter, Pareto, Process Maps

Measure

• Goal: Brainstorm/Prioritize Possible x’s, Validate measurement, Capability

• Tools: Basic Statistics, C & E, XY Matrix, Capability Analysis, MSA, Process 
Maps, Control Charts 

Analyze

• Goal: Identify critical x’s

• Tools: Hypotheses Tests (Normal/Non Normal), Regression and Correlation

Improve

• Goal: Design, Test, and Implement Improvement

• Tools: DOE, Implementation/Change/Communication Plan 

Control

• Goal: Lock-in the Improvement

• Tools: Control Plan, Poka-Yoke, SPC, SOPs, Training Plans etc. 

Six Sigma DMAIC Roadmap
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1.1.5 Roles and Responsibilities
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Roles and Responsibilities

• The various roles in a Six Sigma program are commonly referred to as 

“Belts.”

• In addition to Belts, there are also other key roles with specific 

responsibilities.

• Let us explore the different roles and their corresponding 

responsibilities in a Six Sigma program.
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Expert

Novice

Roles and Responsibilities

• Each of the four Six Sigma belts represents a different level of 

expertise in the field of Six Sigma. 

• Six Sigma Master Black Belt (MBB)

• Six Sigma Black Belt (BB)

• Six Sigma Green Belt (GB)

• Six Sigma Yellow Belt (YB)

• In addition to Belts, there are other critical and complementary roles:

• Champions

• Sponsors

• Stakeholders

• Subject Matter Experts (SMEs).
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Roles and Responsibilities: MBB

• The Master Black Belt (MBB) is the most experienced, educated, and 

capable Six Sigma expert.

• A typical MBB has managed dozens of Black Belt level projects. 

• The MBB can simultaneously lead multiple Six Sigma Belt projects 

while mentoring and certifying Black Belt and Green Belt candidates. 

• The MBB typically works with high-level operations directors, senior 

executives, and business managers to help with assessing and 

planning business strategies and tactics.
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Roles and Responsibilities: MBB

• MBB commonly advises management team on the cost of poor quality 
of an operation and consults on methods to improve business 
performance. 

• Typical Responsibilities of a MBB

• Identifies and defines the portfolio of projects required to support a 
business strategy

• Establishes scope, goals, timelines, and milestones

• Assigns and marshals resources

• Trains and mentors Green Belts and Black Belts

• Facilitates tollgates or checkpoints for Belt candidates

• Reports-out/updates stakeholders and executives

• Establishes organization’s Six Sigma strategy/roadmap

• Leads the implementation of Six Sigma.
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Roles and Responsibilities: BB

• The Black Belt (BB) is the most active and valuable experienced Six 

Sigma professional among all the Six Sigma Belts.

• A typical BB has 

• led multiple projects 

• trained and mentored various Green Belts candidates

• understood how to define a problem and drive effective solution.

• The BB is well rounded in terms of project management, statistical 

analysis, financial analysis, meeting facilitation, prioritization, and a 

range of other value-added capabilities, which makes a BB highly 

valuable asset in the business world.
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Roles and Responsibilities: BB

• BBs commonly serve as the dedicated resource continuing their line 

management role while simultaneously achieving a BB certification.

• Typical Responsibilities of a BB

• Project Management

• Defines projects, scope, teams etc.

• Marshals resources

• Establishes goals, timelines, and milestones

• Provides reports and/or updates to stakeholders and executives.
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Roles and Responsibilities: BB

• Typical Responsibilities of a BB (continued)

• Task Management

• Establishes the team’s Lean Sigma roadmap

• Plans and implements the use of Lean Sigma tools

• Facilitates project meetings

• Does project management of the team’s work

• Manages progress toward objectives.

• Team Management

• Chooses or recommend team members

• Defines ground rules for the project team

• Coaches, mentors, and directs project team

• Coaches other Six Sigma Belts

• Manages the team’s organizational interfaces.
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Roles and Responsibilities: GB

• The Green Belt (GB) is considered as a less intense version of Six 

Sigma professional than the Black Belt (BB). 

• A GB is exposed to all the comprehensive aspects of Six Sigma with 

less focus on the statistical theories and some other advanced 

analytical methodologies such as Design of Experiment (DOE).

• When it comes to project management, a GB has almost the same 

responsibilities as a BB.

• In general, the GB works on less complicated and challenging business 

problems than a BB.
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Roles and Responsibilities: GB

• Typical Responsibilities of a Green Belt

• Project Management

• Defines the project, scope, team etc.

• Marshals resources

• Sets goals, timelines, and milestones

• Reports-out/updates stakeholders and executives.

• Task Management

• Establishes the team’s Lean Sigma Roadmap

• Plans and implements the use of Lean Sigma tools

• Facilitates project meetings

• Does Project Management of the team’s work

• Manages progress toward objectives.

• Team Management

• Chooses or recommends team members

• Defines ground rules for the project team

• Coaches, mentors, and directs project team

• Coaches other Six Sigma Belts

• Manages the team’s organizational interfaces.
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Roles and Responsibilities: YB

• The Yellow Belt (YB) understands the basic objectives and methods of 

a Six Sigma project.

• YB has an elementary understanding about what other Six Sigma Belts 

(GB, BB, MBB) are doing to help them succeed.

• In a Six Sigma project, YB usually serves as a subject matter expert 

regarding some aspects of the process or project.

• Supervisors, managers, directors, and sometimes executives are 

usually trained at the YB level. 
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Roles and Responsibilities: YB

• Typical Responsibilities of a Yellow Belt

• Helps define process scope and parameters

• Contributes to team selection process

• Assists in information and data collection

• Participates in experiential analysis sessions (FMEA, Process Mapping, 
Cause and Effect etc.)

• Assists in assessing and developing solutions

• Delivers solution implementations.
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Roles and Responsibilities: Champions & Sponsors

• Champions and sponsors are those individuals (directors, 

executives, managers etc.) chartering, funding, or driving the Six 

Sigma projects that BBs and GBs are conducting.

• Champions and sponsors need to have a basic understanding of the 

concepts, tools, and techniques involved in the DMAIC methodology so 

that they can provide proper support and direction.
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Roles and Responsibilities: Champions & Sponsors

• Champions and sponsors play critical roles in the successful 

deployment of Six Sigma.

• Strong endorsement of Six Sigma from the leadership team is critical 

for success.

• Typical Responsibilities of a Champion/Sponsor

• Maintains a strategic oversight

• Establishes strategy and direction for a portfolio of projects

• Clearly defines success 

• Provides resolution for issues such as resources or politics

• Establishes routine tollgates or project reviews

• Clears the path for solution implementation

• Assists in project team formation.
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Roles and Responsibilities: Stakeholders

• Stakeholders are usually the recipients or beneficiaries of the success 

of a Six Sigma project.

• Stakeholders are individuals owning the process, function, or 

production/service line that a Six Sigma Belt focuses on improving the 

performance of.

• BBs and GBs need to keep strong working relationships with 

stakeholders because without their support, it would be extremely 

difficult to make the Six Sigma project a success.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

55



www.ABTU.edu

Roles and Responsibilities: SMEs

• Subject Matter Experts (SMEs) are commonly known as the experts 

of the process or subject matter.

• Six Sigma Belts should proactively look to key SMEs to round out their 

working project team.

• SMEs play critical roles to the success of a project.

• Based on SMEs’ extensive knowledge about the process, they have the 

experience to identify which solutions can work and which cannot work.

• SMEs who simply do not speak up can hurt the chances of the process’ 

success. 

• SMEs are also the same people who prefer to keep the status quo. Six 

Sigma Belts may find many of them unwilling to help implement the 

changes.
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Roles and Responsibilities

• Throughout this module we have reviewed the various common roles 

and corresponding responsibilities in any Six Sigma program:

• Six Sigma Master Black Belt

• Six Sigma Black Belt

• Six Sigma Green Belt

• Six Sigma Yellow Belt

• Champion and Sponsors

• Stakeholders

• Subject Matter Experts (SMEs)

• These Six Sigma belts and other roles are designed to deliver value to 

the business effectively and successfully.
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1.2. Six Sigma Fundamentals
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Black Belt Training: Define Phase

1.1 Six Sigma Overview

1.1.1 What is Six Sigma

1.1.2 Six Sigma History

1.1.3 Six Sigma Approach Y = f(x)

1.1.4 Six Sigma Methodology

1.1.5 Roles and Responsibilities

1.2 Six Sigma Fundamentals

1.2.1 Defining a Process

1.2.2 VOC & CTQs

1.2.3 QFD

1.2.4 Cost of Poor Quality (COPQ)

1.2.5 Pareto Analysis (80:20 rule)

1.3 Lean Six Sigma Projects

1.3.1 Six Sigma Metrics

1.3.2 Business Case and Charter

1.3.3 Project Team Selection

1.3.4 Project Risk Management

1.3.5 Project Planning

1.4 Lean Fundamentals

1.4.1 Lean and Six Sigma

1.4.2 History of Lean

1.4.3 The Seven Deadly Muda

1.4.4 Five-S (5S)
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1.2.1 Defining a Process
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Defining a Process

• The basic method of defining and understanding a process is the 

process map.

• Process maps help determine where and how a process begins as well 

as all the steps and decisions in between. 

• By learning the various types and methods of process maps, you can 

become adept at setting project scopes, identifying value-added and 

non-value-added steps, identifying problems in a process, etc.

• This module covers:

• High-level process maps

• Detailed process maps

• Functional maps.

• In the Measure section we will touch on several other types and 

methods of process mapping.
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What is a Process Map?

• A process map is a graphical representation of a process flow.

• It illustrates how the business process is accomplished step by step.

• It describes how the materials or information sequentially flow from one 

business entity to the next.

• It illustrates who is responsible for what between the process 

boundaries.

• It depicts the inputs and outputs of each individual process step.

• Always encourage your project team to map the current state of the 

process instead of the ideal state. Be honest with each other! 
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Process Map Basic Symbols

• The following four symbols are the most commonly used symbols in a 

process map.

Terminator (Oval):

Shows the start and end points in the process

Process (Rectangle):

Indicates a single process step.

Decision (Diamond):

Indicates a question with two choices (e.g. 

Yes/No)

Flow Line (Arrow):

Shows the direction of the process 

flow.
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Additional Process Symbols

• Additional Process Symbols:

Alternative Process:

Indicates a process step as an alternate of a normal step.

Predefined Process:

Indicates a formally-defined process step. Other 

documentation or instruction is needed to support further 

details of the step.

Manual Operation:

Indicates a process step conducted manually.

Preparation:

Indicates a preparation step.

Delay:

Indicates a waiting period in the process.
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Additional Process Symbols

• Additional File and Information Related Symbols:

Data (I/O):

Shows the inputs and outputs of a process.

Document:

Indicates a process step that results in a document.

Multi-Document:

Indicates a process step that results in multiple documents.

Stored Data:

Indicates a process step that stores data.

Magnetic Disk:

Indicates a database.
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Additional Process Symbols

• Additional Control of Flow Symbols:

Off-Page Connector:

Indicates the process flow continues onto another page.

Merge:

Indicates multiple processes merge into one.

Extract:

Indicates a process splits into multiple parallel processes.

Or:

Indicates a single data processing flow diverges to multiple 

branches with different criteria requirements.

Summing Junction:

Indicates multiple data processing flows converge into one.
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How to Plot a Process Map

• Step 1: Define the boundaries of the process you want to map.

• A process map can depict the flow of an entire process or a segment of it.

• You need to identify and define the beginning and ending points of the process 

before starting to plot.

• Use operational definitions where possible.
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How to Plot a Process Map

• Step 2: Define and sort the process steps with the flow.

• Consult with process owners and SMEs or observe the process in action to 

understand how the process is actually performed.

• Record the process steps and sort them according to the order of their 

occurrence.
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How to Plot a Process Map

• Step 3: Fill the step information into the appropriate process symbols 

and plot the diagram.

• In the team meeting of process mapping, place the sticky notes with 

different colors on a white board so you can move them around while the 

map is under-construction.

• The flow lines can be plotted directly on the white board. 

• Decision steps. Rotate the sticky note 45 degrees.

• When the map is completed on the white board, record the map using 

Excel, PowerPoint, Visio, Quality Companion, or other preferred software.
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How to Plot a Process Map

• Step 3:

• To illustrate the responsibility of different organizations involved in 

the process, use a Swim Lane Process Map.
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How to Plot a Process Map

• Step 4: Identify and record inputs/outputs and their corresponding 

specifications for each process step.

• The process map helps in understanding and documenting Y = f(x) of a 

process, where Y represents the outputs and x represents the inputs.

• The inputs of each process step can be controllable or non-controllable, 

standardized operational procedures, or noise. 

• Inputs are the source of variation in the process and need to be analyzed 

qualitatively and quantitatively.

• The outputs of each process step can be products, information, services, 

etc. They are the little Y’s within the process.
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How to Plot a Process Map

• Step 5: Evaluate the process map and adjust if needed.

• If the process is too complicated to be covered in one single process map, 

you may create additional detailed sub-process maps for further 

information.

• Number the process steps in the order of their occurrence for clarity.
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High Level Process Map

• Most high-level process maps are also referred to as flow charts. 

• The key to a high-level process map is to over-simplify the process 

being depicted so that it can be understood in its most generic form.

• As a general rule, high-level process maps should be no more than 4–

6 steps. 

• Below is an oversimplified version of a high-level process map for 

cooking a 10lb prime rib for a dozen holiday guests.
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Detailed Process Map

• Detailed process maps or multi-level maps take the high-level map 

much further.

• Detailed maps can be 2–4 levels deeper than your high-level process 

map. 

• A good guideline used to help create the second level is to take each 

step in the high level map and break it down into 2–4 steps (no more).

• Repeat this process (level 3, level 4 etc.) until reaching the desired 

level of detail.

• Some detailed maps are 2 or 3 levels deep, others can be 5–6 levels 

deep. Obviously, the deeper the levels, the more complex and the 

more burdensome.
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Detailed Process Map

• At right is our prime rib 

cooking example at level 

2 detail.

• This process map has a 

few more decision points 

and process steps.

• You can see that going 

only one more level 

deep adds a fair amount 

of information to the 

process map.
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Functional Process Map

• The functional map adds dimension to the high-level or detailed map. 

• The dimension added is identifying which function or job performs the step or makes 

the decision.

• Below is a generic example of a functional map. Note that functions are identified in 

horizontal lanes and each process step is placed in the appropriate lane based on 

which function performs the step. L
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1.2.2 VOC and CTQs
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Voice of the Customer

• VOC stands for “Voice of the Customer.”

• Voice of the customer is a term used for a data-driven plan to discover 

customer wants and needs. 

• VOC is an important component to a successful Six Sigma project.

• There are also other “Voices” that need to be heard when conducting 

projects. The 3 primary forms are:

• VOC: Voice of the Customer

• VOB: Voice of the Business

• VOA: Voice of the Associate.
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Gathering VOC

• Gathering VOC should be performed methodically.

• The two most popular methods of collecting VOC are

1. Indirect

2. Direct.

• 1. Indirect data collection for VOC involves passive information 

exchange: 

• Warranty claims 

• Customer complaints/compliments 

• Service calls 

• Sales reports.

• 2. Indirect methods are less effective, sometimes dated, require heavy 

interpretation, and are also more difficult to confirm. 
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Gathering VOC

• Direct data collection methods for VOC are active and planned 

customer engagements:

• Conducting interviews

• Conducting customer surveys

• Conducting market research

• Hosting focus groups.

• Direct methods are typically more effective for several reasons:

• Less need to interpret meaning

• Researchers can go a little deeper when interacting with customers

• Customers are aware of their participation and will respond better upon 

follow-up

• Researchers can properly plan engagements (questions, sample size, 

information collection techniques etc.).
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Gathering VOC

• Gathering VOC requires consideration of many factors such as product 
or services types, customer segments, manufacturing methods or 
facilities etc.

• All this information will influence the sampling strategy.

• Consider which factors are important and build a sample size plan 
around them.

• Also, consider response rates and adjust the initial sample strategy to 
ensure adequate input is received.

• Once a sampling plan is in place, collect data via the direct and indirect 
methods discussed earlier.

• After gathering VOC it will be necessary to translate it into something 
meaningful: CTQs.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

81



www.ABTU.edu

Critical to Quality: CTQ

• CTQ stands for Critical to Quality.

• CTQs are translated from VOC or 

“voice of the customer” feedback.

• VOC is often vague, emotional, or simply 

a generalization about products or services.

• CTQs are the quantifiable, measureable, and meaningful translations 

of VOC.

• Organizing VOC helps to identify CTQs. 

• One effective way to organize VOC is to group or bucket it using an 

affinity diagram.

• Affinity diagrams are ideal for large amounts of soft data resulting from 

brainstorming sessions or surveys.
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Affinity Diagram: Building a CTQ Tree

• Steps for conducting an Affinity Diagram exercise:

• Step 1: Clearly define the question or focus of the exercise (“Why are associates 
late for work?”).

• Step 2: Record all participant responses on note cards or sticky notes (this is the 
sloppy part, record everything!).

• Step 3: Lay out all note cards or post the sticky notes onto a wall.

• Step 4: Look for and identify common themes.

• Step 5: Begin moving the note cards or sticky notes into the themes until all 
responses are allocated.

• Step 6: Re-evaluate and make adjustments.
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Affinity Diagram: Building a CTQ Tree

• Define the question or focus 

• Record responses on note cards or sticky notes

• Display all note cards or sticky notes on a wall if necessary.
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Affinity Diagram: Building a CTQ Tree

• Look for and identify common themes within the responses. 
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Affinity Diagram: Building a CTQ Tree

• Group note cards or sticky notes into themes until all responses are 

allocated.

• Re-evaluate and make final adjustments.
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CTQ Tree

• Example of a generic CTQ tree transposed from a white board to a 

software package.
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Kano

• Another VOC categorization technique is the Kano.

• The Kano model was developed by Noriaki Kano in the 1980s.

• The Kano model is a graphic tool that further categorizes VOC and 

CTQs into 3 

distinct groups:

• Must Haves

• Performance Attributes

• Delighters.

• The Kano helps to identify CTQs that add incremental value vs. those 

that are simply requirements and having more is not necessarily better.
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Validating VOC and CTQs

• After determining all CTQs, 

confirm them with the customer.

• Confirming can be accomplished 

by conducting surveys through one 

or more of the following methods:

• Group sessions

• One-on-one meetings

• Phone interviews

• Electronic means (chat, email, social media etc.)

• Physical mail.

• Consider your confirming audience and try to avoid factors that may 

influence or bias responses such as inconvenience or overly 

burdensome time commitments.
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Translating CTQs to Requirements

• Lastly, CTQs must be transformed into specifics that can be built upon 

in a process.

• A requirements tree translates CTQs to meaningful and measureable 

requirements for production processes and products. L
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1.2.3 Quality Function Deployment
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History of QFD

• Developed by Shigeru Mizuno (1910–1989) and Yoji Akao (b. 1928) in 

Japan. Quality Function Deployment (QFD) aims to design products 

that assure customer satisfaction and value – the first time and every 

time.

• The QFD framework can be used for translating actual customer 

statements and needs (“The voice of the customer”) into actions and 

designs to build and deliver a quality product.
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What is QFD?

• Quality Function Deployment (QFD) is a construction methodology 

and quantification tool used to identify and measure customer’s 

requirements and transform them into meaningful and measureable 

parameters.

• QFD helps to prioritize actions to advance process or product to meet 

customer’s anticipations.

• QFD is an excellent tool for contact between cross-functional groups.
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Purpose of QFD

The quality function deployment has many purposes. Among the most 

important are:

• Market analysis to establish needs and expectations

• Examination of competitors’ abilities

• Identification of key factors for success

• Translation of key factors into product and process characteristics.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

94



www.ABTU.edu

Phases of QFD

Four Key Phases of QFD

• Phase I: Product Planning Including the “House of Quality” (Requirements 

Engineering Life Cycle)

• Phase II: Product Design (Design Life Cycles)

• Phase III: Process Planning (Implementation Life Cycle)

• Phase IV: Process Control (Testing Life Cycle)
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How to build a House of Quality

• Determine Customer Requirements (What’s from VOC/CTQ)

• Technical Specifications/Design Requirements (How’s)

• Develop Relationship Matrix (What’s and How’s)

• Prioritize Customer Requirements

• Conduct Competitive Assessments

• Develop Interrelationship (How’s)

• Prioritize Design Requirements
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House of Quality

Correlation Matrix 

[How’s vs. How’s]

Technical Specifications

[How’s]

Relationship Matrix

[What’s vs. How’s]

Degree of Technical Difficulty

Overall Importance Ratings

Technical Competitive Evaluations

Target Goals

Customer 

Requirements

[What’s]

How Much’s

Why’s

Customer 

Importance 

Rating

Customer 

Market 

Evaluation

[What’s vs. 

Why’s]
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Step 1: Determine Customer Requirements

• Identify the important customer requirements. These are the “What’s” 

and are typically determined through the VOC/CTQ process.

• Use the results from your requirements tree diagram as inputs for the 

customer requirements in your HOQ.

On-Time Delivery

Increase Product Quality

Alternative Solutions

Reduce Turn-Around Time

Optimize Resource

Reduce COPQ

High Productivity
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Step 2: Technical Specification

• Potential choices for product features

• Voice of Designers or Engineers

• Each “What” item must be refined to “How’s”
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Step 3: Develop Relationship Matrix (What’s & How’s)

• This is the center portion of the house. Each cell represents how each 

technical specification relates to each customer requirement.
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Step 4: Prioritize Customer Requirements

• This is the right portion of the house. Each cell represents customer 

requirements based on relative importance to customers and 

perceptions of competitive performance.
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Step 5: Competitive Assessments

• This is the extreme right portion of the house. Comparison of the 

organization’s product to competitors’ products.
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Step 6: Correlation Matrix

• This is the top portion of the house. It identifies the way “how” items 

either support (positive) or conflict (negative) with one another.

Strong Positive

Positive

Negative

Strong Negative

+9

+3

-3

-9
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Step 7: Prioritize Design Requirements

• Overall Importance Ratings

• Function of relationship ratings and customer prioritization ratings

• Technical Difficulty Assessment

• Similar to customer market competitive evaluations but conducted by 

the technical team L
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Step 7: Prioritize Design Requirements

• Technical Specification Competitive Evaluation

• Helps to establish the feasibility and realization of each “how” item

• Target Goals

• How much is good enough to satisfy the customer
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House of Quality

1

2

43 5

6

7
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Pros of QFD

• Focuses the design of the product or process on satisfying customer’s 

needs and wants.

• Improves the contact channels between customers, advertising, 

research and improvement, quality and production departments, which 

sustains better decision making.

• Reduces the new product development project period and cost.
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Cons of QFD

• The relationship matrix can be too obscure with many process inputs 

and/or many customer constraints.

• It can be very complicated and difficult to implement without 

experience.

• If throughout the process new ideas, specifications, or requirements 

are not discovered, you run the risk of losing team members’ trust in 

the process. 
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QFD Summary

When used properly, the quality function deployment is an extremely 

valuable approach to product/process design. 

There are many benefits of QFD that can only be realized when each 

step of the process is completed thoroughly:

• Logical way of obtaining information and presenting it

• Smallest product development cycle

• Considerably condensed start-up costs

• Fewer engineering alterations

• Reduced chance of supervision during design process

• Collaborating environment

• Preserving everything in characters.
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1.2.4 Cost of Poor Quality
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Cost of Poor Quality

• Cost of Poor Quality (COPQ) is the expense incurred due to 

waste, inefficiencies, and defects.

• The COPQ has been proven to range from 5% to 30% of gross sales 

for most companies.

• The COPQ can be staggering when considering process inefficiencies, 

hidden factories, defective products, rework, scrap, etc. 

• Understanding COPQ and where to look for it will help uncover process 

inefficiencies, defects, and hidden factories within your business.
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Cost of Poor Quality

• There are 7 common forms of waste that are often referred to as the “7 

deadly muda.” 

• Technically, there are more than 7 forms of waste but if you can 

remember these you will capture over 90% of your waste.

1. Defects

2. Overproduction

3. Over-Processing

4. Inventory

5. Motion

6. Transportation

7. Waiting
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Cost of Poor Quality

• The “7 deadly muda” are very important to understand. They are the 

best way to identify the COPQ.

• The presence of any muda causes many other forms of inefficiencies 

and hidden factories to manifest themselves.

• There are four key categories of 

costs related to muda:

1. Costs Related to Production

2. Costs Related to Prevention

3. Costs Related to Detection

4. Costs Related to Obligation
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COPQ: Costs Related to Production

• Costs related to production are the direct costs of the presence of 

muda. These forms of COPQ are usually understood and easily 

observable. They are in fact the “7 deadly muda” themselves.

1. Defects

2. Overproduction

3. Over-Processing

4. Inventory

5. Motion

6. Transportation

7. Waiting
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COPQ: Costs Related to Prevention

• Costs related to the prevention of muda are those associated with 

trying to reduce or eliminate any of the “7 deadly muda.”

• Costs for error proofing methods or devices

• Costs for process improvement and quality programs

• Costs for training and certifications

• etc.

• Any costs directly associated with the prevention of waste and defects 

should be included in the COPQ calculation.
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COPQ: Costs Related to Detection

• Costs related to the detection of muda are those associated with trying 

to find or observe any of the “7 deadly muda.”

• Costs for sampling

• Costs for quality control check points

• Costs for inspection costs

• Costs for cycle counts or inventory accuracy inspections

• etc.

• Any costs directly associated with the detection of waste and defects 

should be included in the COPQ calculation.
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COPQ: Costs Related to Obligation

• Costs related to obligation are those associated with addressing the 

muda that reaches a customer.

• Repair costs

• Warranty costs

• Replacement costs

• Customer returns and customer service overhead

• etc.

• Any costs directly associated with customer obligations should be 

included in the COPQ calculation.
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COPQ: Types of Cost

• There are two types of costs to be considered when determining COPQ

1. Hard Costs

• Tangible costs that can be traced to the income statement

2. Soft Costs

• Intangible costs: avoidance, opportunity costs, lost revenue etc.

• Calculating the COPQ

1. Determine the types of waste that are present in your process

2. Estimate the frequency of waste that occurs

3. Estimate the cost per event, item, or time frame

4. Do the math.
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1.2.5 Pareto Charts and Analysis
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Pareto Principle

• The Pareto principle is commonly known as the “law of the vital few” 

or “80:20 rule.”

• It means that the majority (approximately 80%) of effects come from a 

few (approximately 20%) of the causes. 

• This principle was first introduced in early 1900s and has been applied 

as a rule of thumb in various areas.

• Example of applying the Pareto principle:

• 80% of the defects of a process come from 20% of the causes.

• 80% of sales come from 20% of customers.
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Pareto Principle

• The Pareto principle helps us to focus on the vital few items that have 

the most significant impact.

• In concept, it also helps us to prioritize potential improvement efforts.

• Since this 80:20 rule was originally based upon the works of Wilfried 

Fritz Pareto (or Vilfredo Pareto), the Pareto principle and references to 

it should be capitalized because Pareto refers to a person (proper 

noun).

• Mr. Pareto is also credited for many works associated with the 80:20, some 

more loosely than others:

• Pareto’s Law

• Pareto efficiency

• Pareto distribution etc.
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Pareto Charts

• A Pareto chart is a chart of descending bars with an ascending 

cumulative line on the top.

• Sum or Count:

The descending bars on a Pareto chart may be set on a scale that 

represents the total of all bars or relative to the biggest bucket, 

depending on the software you are using.

• Percent to Total: A Pareto chart shows the percentage to the total for 

individual bars.

• Cumulative Percentage: A Pareto chart also shows the cumulative 

percentage of each additional bar. The data points of all cumulative 

percentages are connected into an ascending line on the top of all bars.
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Pareto Charts

• Case study time!

• Next we will use Minitab to run Pareto charts on exactly the same data set.

• Open the Minitab data file labeled Pareto and follow the instructions over 

the next few pages to run Pareto charts in Minitab.
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Create a Pareto Chart in Minitab

• Steps to generate a Pareto chart using Minitab:

1. Open the spreadsheet with the count data for individual categories.

2. Click on Stat → Quality Tools → Pareto Chart.

3. A new window with the title “Pareto Chart” pops up.

4. Select “Category” into the box “Defects or attribute data in” and “Count” into 

the box “Frequency in.”

5. Click “OK.”

6. The Pareto chart is created in a newly-generated window.
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Create a Pareto Chart in Minitab
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Create a Pareto Chart in Minitab

• The above Pareto chart generated in Minitab presents the count of defective products by team. 

• The bars are descending on a scale with the peak at 50, which is approximately the total count 

of all defective products for all teams. 

• The table below the chart contains counts, individual percentages, and cumulative percentages.

• The cumulative percentages are the red data points driving the red line that spans across the 

graphic.
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Pareto Analysis

• The Pareto analysis is used to identify the root causes by using 

multiple Pareto charts.

• In Pareto analysis, we drill down into the bigger buckets of defects and 

identify the root causes of defects that contribute heavily to total 

defects.

• This "drill down" approach effectively solves a significant portion of the 

problem.

• Next you will see an example of three-level Pareto analysis.

• The second-level Pareto is a Pareto chart that is a subset of the tallest bar 

on the first Pareto.

• The third-level Pareto is a subset of the tallest bar of the second-level 

Pareto. 
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Pareto Analysis: First Level

• First-level Pareto

• Shows the count of defective items by team

• Next level will only show the defective items of team 4
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Pareto Analysis: Second Level

• Second-level Pareto

• Shows the count of the defective items by section for only team 4

• Next level will only show the defective items of section 3
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Pareto Analysis: Third Level

• Third-level Pareto

• Shows the count of defective items by associate for only section 3 of team 4

• Next level will only show the defective items of Dave
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Pareto Analysis: Conclusion

• After drilling down three levels we find that most of the defective products are 

from Dave who is in Section 3 of Team 4.

• Determining what Dave might be doing differently and solving that problem 

can potentially fix about 30% of the entire defective products (13/44). 
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1.3 Six Sigma Projects
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Black Belt Training: Define Phase

1.1 Six Sigma Overview

1.1.1 What is Six Sigma

1.1.2 Six Sigma History

1.1.3 Six Sigma Approach Y = f(x)

1.1.4 Six Sigma Methodology

1.1.5 Roles and Responsibilities

1.2 Six Sigma Fundamentals

1.2.1 Defining a Process

1.2.2 VOC and CTQs

1.2.3 QFD

1.2.4 Cost of Poor Quality (COPQ)

1.2.5 Pareto Analysis (80:20 rule)

1.3 Lean Six Sigma Projects

1.3.1 Six Sigma Metrics

1.3.2 Business Case and Charter

1.3.3 Project Team Selection

1.3.4 Project Risk Management

1.3.5 Project Planning

1.4 Lean Fundamentals

1.4.1 Lean and Six Sigma

1.4.2 History of Lean

1.4.3 The Seven Deadly Muda

1.4.4 Five-S (5S)
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1.3.1 Six Sigma Metrics
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Six Sigma Metrics

• There are many Six Sigma metrics and/or measures of performance 

used by Six Sigma practitioners. 

• In addition to the ones we will cover here, several others (Sigma level, Cp, 

Cpk, Pp, Ppk, takt time, cycle time, utilization etc.) will be covered in other 

modules throughout this training.

• The Six Sigma metrics of interest here in the define phase are:

• Defects per Unit (DPU)

• Defects per Million Opportunities (DPMO)

• Yield (Y)

• Rolled Throughput Yield (RTY).
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Defects per Unit: DPU

• DPU stands for “Defects per Unit“

• DPU is the basis for calculating DPMO and RTY, which we will cover in 

the next few pages.

• DPU is found by dividing total defects by total units. 

• DPU = D/U

• For example, if you have a process step that produces an average of 

65 defects for every 598 units, then your DPU = 65/598 = 0.109.
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DPMO: Defects per Million Opportunities

• DPMO is one of the few important Six Sigma metrics that you should 

get comfortable with if you are associated with Six Sigma.

• In order to understand DPMO it is best if you first understand both the 

nomenclature and the nuances such as the difference between defect 

and defective. 

• Nomenclature

• Defects = D

• Unit = U

• Opportunity to have a defect = O
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DPMO: Defects per Million Opportunities

• In order to properly discuss DPMO, we must first explore the 

differences between "defects" and "defective." 

• Defective

• Defective suggests that the value or function of the entire unit or product has 

been compromised. 

• Defective items will always have at least one defect. Typically, however, it takes 

multiple defects and/or critical defects to cause an item to be defective. 

• Defect

• A defect is an error, mistake, flaw, fault, or some type of imperfection that 

reduces the value of a product or unit. 

• A single defect may or may not render the product or unit "defective" depending 

on the specifications of the customer. 

• Summary
• Defect means that part of a unit is bad. 

• Defective means that the whole unit is bad.
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DPMO: Defects per Million Opportunities

• Now let us turn our attention to defining "opportunities" so that we can 

fully understand Defects per Million Opportunities (DPMO). 

• Opportunities

• Opportunities are the total number of possible defects. 

• Therefore, if a unit has 6 possible defects, then each unit produced is equal to 6 

defect opportunities. 

• If we produce 100 units, then there are 600 defect opportunities. 
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DPMO: Defects per Million Opportunities

• Calculating Defects per Million Opportunities

• The equation is DPMO = (D/(U × O)) × 1,000,000

• Example: Let us assume:

• There are 6 defect opportunities per unit

• There are an average of 4 defects every 100 units.

• Opportunities = 6 × 100 = 600

• Defect rate = 4/600

• DPMO = 4/600 × 1,000,000 = 6,667 
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DPMO: Defects per Million Opportunities

• What is the reason or significance of 1,000,000? 

• Converting defect rates to a per million value becomes necessary 

when the performance of your process approaches Six Sigma. 

• When this happens, the number of defects shrinks to virtually nothing. 

In fact, if you recall from the “What is Six Sigma” module, sigma is 3.4 

defects per million opportunities. 

• By using 1,000,000 opportunities as the barometer we have the 

resolution in the measurement to count defects all the way up to Six 

Sigma. 
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RTY: Rolled Throughput Yield

• Rolled Throughput Yield (RTY) is a process performance measure 

that provides insight into the cumulative effects of an entire process. 

• RTY measures the yield for each of several process steps and 

provides the probability that a unit will come through that process 

defect-free. 

• RTY allows us to expose the "hidden factory" by providing visibility into 

the yield of each process step.

• This helps us identify the poorest performing process steps and gives 

us clues into where to look to find the most impactful process 

improvement opportunities.
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RTY: Rolled Throughput Yield

• Calculating RTY: 

• RTY is found by multiplying the yields of each process step.

• Let us take the 5-step process below and calculate the RTY using the 

multiplication method mentioned above. 

• The calculation is: RTY = 0.90 × 0.91 × 0.99 × 0.98 × 0.97 = 0.77

• Therefore, RTY = 77%.
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RTY: Rolled Throughput Yield

• You may have noticed that in order to calculate RTY we must 
determine the yield for each process step.

• Before we get into calculating yield, there are a few abbreviations that 
need to be declared.

• Abbreviations

• Defects = D

• Unit = U

• Defects per Unit = DPU

• Yield = Y

• e = 2.71828 (mathematical constant)
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RTY: Rolled Throughput Yield

• Calculating Yield

• The Yield of a process step is the success rate of that step or the 

probability that the process step produces no defects. 

• In order to calculate the yield, we need to know the DPU and then we 

can apply it to the yield equation below.

• Example

• Let us assume a process step has a DPU of 0.109 (65/598)

• Yield = 2.718 ^ -0.109 = 0.8967. Rounded, Yield = 90%. 

𝑌𝑖𝑒𝑙𝑑 = 𝑒−𝑑𝑝𝑢
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RTY: Rolled Throughput Yield

• Below is a table using the above process yield data that we used in the 

earlier RTY calculation.

• This table allows us to see the DPU and yield of each step as well as 

the RTY for the whole process.
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RTY: Using an Estimate of Yield

• Calculating RTY using Yield estimation

• It is possible to “estimate” yield by taking the inverse of 

DPU or simply subtracting DPU from 1.

• Yield Estimation = 1 − DPU

• Example Yield Estimate for process step 1: 1 − 0.10870 = 0.90

• RTY using the Yield Estimation Method

• RTY = 0.891 × 0.91 × 0.99 × 0.979 × 0.97 = 0.76 = 76%

NOTE: This method 

assumes max DPU is 1. 

Although this is not 

technically true, in practice 

its extremely rare to find 

processes with DPU greater 

than 1. If it is the case this 

method will not work.
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RTY: Using First Time Yield (FTY)

• In the previous discussion we calculated RTY using Yields calculated 

based on “Defects” per unit. What if we’re counting “Defectives”?

• First Time Yield (FTY) is the probability of producing a product or service 

defect free before rework

• FTY =
# 𝑁𝑜𝑛−𝐷𝑒𝑓𝑒𝑐𝑡𝑖𝑣𝑒 𝑈𝑛𝑖𝑡𝑠 𝑃𝑟𝑜𝑑𝑢𝑐𝑒𝑑 𝐵𝑒𝑓𝑜𝑟𝑒 𝑅𝑒𝑤𝑜𝑟𝑘

# 𝑈𝑛𝑖𝑡𝑠 𝐼𝑛𝑠𝑝𝑒𝑐𝑡𝑒𝑑

• FTY is also a good measure of process performance. It accounts for 

the hidden factory or rework in the process. Its simply based on 

defective units instead of defects per unit.

• You can still calculate RTY using First Time Yield: 

• RTY= FTY1 * FTY2 * FTY3 * FTY4 * FTY5
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1.3.2 Business Case and Charter
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Business Case and Project Charter

• Earlier we stated that DMAIC is a structured and rigorous methodology 

designed to be repeatedly applied to any process in order to achieve 

Six Sigma.

• We also stated that DMAIC was a methodology that refers to 5 phases 

of a project.

• Define, Measure, Analyze, Improve, and Control

• Given that the premise of the DMAIC methodology is project-based, we 

must take the necessary steps to define and initiate a project, hence 

the need for. . .

• Project Charters
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Project Charter

• The purpose of a project charter is to provide vital information about a 

project in a quick and easy-to-comprehend manner. 

• Project charters are used to get approval and buy-in for projects and 

initiatives as well as declaring: 

• The scope of work 

• Project teams 

• Decision authorities 

• Project lead

• Success measures 
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Project Charter Template
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Project Charter Key Elements

Project title, leader and sponsor are critical 

components. Identifying a lead helps keep 

order and accountability. Without a sponsor 

and approval there is no project

The primary metric is vital to understanding how 

you are measuring project success as well as 

being able to establish a baseline and goal.

The problem statement is a concrete factual statement 

declaring the projects baseline, goal, gap to goal and gap 

closure. It should also be explicit about timing.

The business case describes why this 

project is important to the business.

The secondary metric is a measure that help keep a project honest. 

Sometimes you’ll find improvement of a metric to the detriment of 

another. The secondary metrics helps bring visibility to this.

Be clear about 

the project 

timeline.

Identify constraints 

and project 

dependencies.

Identify project 

risks that the 

sponsor should be 

aware of.

Identify any other 

relevant project 

measures.

All formal project require 

approvals.

Identify people who have a vested 

interest in the project’s success.
Declare project team members 

and subject matter experts.
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Project Charter: Key Elements

• Title

• Projects should have a name, title, or some reference that identifies them. 

• Branding can be an important ingredient in the success of a project so be 

sure your project has a reference name or title.

• Leader

• Any projects needs a declared leader or someone who is responsible for 

project’s execution and success. 

• You may hear references to RACI throughout in your Six Sigma journey. 

• RACI stands for Responsible, Accountable, Consulted, Informed and 

identifies the people that play those roles. 

• Every project must have declared leaders indicating who is responsible and 

who is accountable. 
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Project Charter: Key Elements

• Business Case

• A business case is the quantifiable reason why the project is 

important.

• Business cases help shed light on problems. They explain why a 

business should care.

• Business cases must be quantified and stated succinctly.

• COPQ is a key method of quantification for any business case.
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Project Charter: Key Elements

• Problem Statement and Objective

• A properly written problem statement has an objective statement woven 

into it. 

• There should be no question as to the current state or the goal. 

• A gap should be declared, the gap being the difference between the 

present state and the goal state.

• The project objective should be to close the gap or reduce the gap by some 

reasonable amount.

• Valuation or COPQ is the monetary value assigned to the gap. 

• Lastly, a well-written problem statement refers to a timeline expected to be 

met. 
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Project Charter: Problem Statement Examples
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• Currently, process defect rates are 17% with a goal of 2%. This 

represents a gap of 15%, costing the business $7.4 million dollars. The 

goal of this project is to reduce this gap by 50% before Nov 2019 

putting process defect rates at 9.5% and saving $3.7MM. 

• Process cycle time has averaged 64 minutes since Q1 2019. However, 

production requirements put the cycle time goals at 48 min. This 16-

min gap is estimated to cost the business $296,000. The goal of this 

project is reduce cycle time by 16 min. by Q4 2019 and capture all 

$296,000 cost savings.
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Project Charter: Key Elements

• Metrics

• A measure of success is an absolute for any project. 

• Metrics give clarity to the purpose of the work.

• Metrics establish how the initiative will be judged.

• Metrics establish a baseline or “starting point.”

• For Six Sigma projects…metrics are mandatory!
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Project Charter: Key Elements

• Primary Metric

• The primary metric is a generic term for a Six Sigma project's most 
important measure of success. The primary metric is defined by the Black 
Belt, GB, MBB, or Champion. 

• A primary metric is an absolute MUST for any project and it should not be 
taken lightly. Here are a few characteristics of good primary metrics.

• Primary metrics should be:

• tied to the problem statement

• measureable

• expressed with an equation

• aligned to business objectives

• tracked at the proper frequency (hourly, daily, weekly, monthly etc.)

• expressed pictorially over time with a run chart, time series, or control chart

• validated with an MSA.
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Project Charter: Key Elements

• The primary metric is the reason for your work.

• It is the success indicator.

• It is your beacon. 

• The primary metric is of utmost importance and should be improved, 

but not at the expense of your secondary metric. 
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Project Charter: Key Elements

• Secondary Metric

• The secondary metric is the thing you do not want sacrificed on behalf of 

a primary improvement. 

• A secondary metric is one that makes sure problems are not just "changing 

forms" or "moving around." 

• The secondary metric keeps us honest and ensures we are not sacrificing 

too much for our primary metric. 

• If your primary metric is a cost or speed metric, then your secondary 

metric should probably be some quality measure.

• Example: If you were accountable for saving energy in an office building and 

your primary metric was energy consumption then you could shut off all the 

lights and the HVAC system and save tons of energy. . .except that your 

secondary metrics are probably comfort and functionality of the work 

environment. 
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Project Charter: Key Elements

• Elements of a Good Project Charters (continued)

• Scope Statement – defined by high-level process map

• Stakeholders Identified – who is affected by the project

• Approval Authorities Identified – who makes the final call

• Review Committees Defined – who is on the review team

• Risks and Dependencies Highlighted – identify risks and critical path items

• Project Team Declared – declare team members

• Project Timeline Estimated – set high-level timeline expectations.
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1.3.3 Project Team Selection
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Project Team Selection

• Six Sigma project team selection is the cornerstone of a successful Six 

Sigma project.

• Teams and Team Success

• A team is a group of people who share complementary skills and 

experience.

• A team will be dedicated to consistent objectives.

• Winning teams share similar and coordinated goals. 

• Teams often execute common methods or approaches.

• Team members hold each other accountable for achieving shared goals.
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Project Team Selection

• What makes a team successful?

• Shared goals

• Commitment

• Leadership

• Respect

• Effective communication 

• Autonomy

• Diversity (capabilities, knowledge, skills, experience etc.)

• Adequate resources.
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Project Team Selection

• Keys to Team Success
• Agreed focus on the goal or the problem at hand

• Focus on problems that have meaning to the business

• Focus on solvable problems within the scope of influence; a successful team does not 

seek unattainable solutions.

• Team Selection
• Selected teammates have proper skills and knowledge

• Adequately engaged management

• Appropriate support and guidance from their direct leader

• Successful teams use reliable methods
• Follow the prescribed DMAIC methodology

• Manage data, information, and statistical evidence

• Successful teams always have exceeds players
• Winning teams typically 

• Have unusually high standards.

• Have greater expectations of themselves and each other.

• Do not settle for average or even above average results.
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Project Team Selection

• Principles of Team Selection: 

• Select team members based on
• Skills required to achieve the objective

• Experience (Subject Matter Expertise)

• Availability and willingness to participate

• Team size (usually 4–8 members)
• Don’t go at it alone!

• Don’t get too many cooks in the kitchen!

• Members’ ability to navigate
• The process

• The company

• The political landscape

• Be sure to consider the inputs of others 
• Heed advice

• Seek guidance
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Project Team Development

• All teams experience the following four stages of development. It is helpful to 
understand these phases so that you can anticipate what your team is going 
to experience.

• The four stages of team development process:

• Forming

• Storming

• Norming

• Performing

• Teammates seek something different at each stage:

• In the forming stage they seek inclusion

• In the storming stage they seek direction and guidance

• In the norming stage they seek agreement

• In the performing stage they seek results.
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Project Team Development

• Patterns of a team in the Forming stage:

• Roles and responsibilities are unclear

• Process and procedures are ignored

• Scope and parameter setting is loosely attempted

• Discussions are vague and frustrating

• There is a high dependence on leadership for guidance

• Patterns of a team in the Storming stage:

• Attempts to skip the research and jump to solutions

• Impatience for some team members regarding lack of progress

• Arguments about decisions and actions of the team

• Team members establish their position

• Subgroups or small teams form

• Power struggles exist and resistance is present
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Project Team Development

• Patterns of a team in the Norming stage:

• Agreement and consensus start to form

• Roles and responsibilities are accepted

• Team members’ engagement increases

• Social relationships begin to form

• The leader becomes more enabling and shares authority

• Patterns of a team in the Performing stage: 

• Team is directionally aware and agrees on objectives

• Team is autonomous

• Disagreements are resolved within the team

• Team forms above average expectations of performance
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Project Team Development

• Well-structured and energized project teams are the essential 

components of any successful Six Sigma project.

• To have better chances of executing the project successfully, you will 

need to understand and effectively manage the team development 

process.
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1.3.4 Project Risk Management
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Risk

• Risk is defined as a future event that can impact the task/project if it 

occurs.
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What is Project Risk Management?

• The main purpose of risk management is to foresee potential risks 

that may inhibit the project deliverables from being delivered on time, 

within budget, and at the appropriate level of quality, and then to 

mitigate these risks by creating, implementing, and monitoring 

contingency plans. 

• Risk management is concerned with identifying, assessing, and 

monitoring project risks before they develop into issues and impact the 

project.

• Risk analysis helps to identify and manage potential problems that 

could impact key business initiatives or project goals.
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Three Basic Parameters of Risk Analysis

• Risk Assessment: 

• The process of identifying and evaluating risks, whether in absolute or 

relative terms.

• Risk Management:

• Project risk management is the effort of responding to risks throughout the 

life of a project and in the interest of meeting project goals and objectives.

• Risk Communication:

• Communication plays a vital role in the risk analysis process because it 

leads to a good understanding of risk assessment and management 

decisions.
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Why is Risk Analysis Necessary?

What can happen if you omit the risk analysis?

• Vulnerabilities cannot be detected

• Mitigation plans are introduced without proper justification

• Customer dissatisfaction

• Not meeting project goals

• Remake the whole system

• Huge cost and time loss
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Project Risk Analysis Steps

The project risk analysis process consists of the following steps that 
evolve through the life cycle of a project. 

• Risk Identification:

• Identify risks and risk categories, group risks, and define ownership.

• Risk Assessment:

• Evaluate and estimate the possible impacts and interactions of risks.

• Response Planning:

• Define mitigation and reaction plans.

• Mitigation Actions:

• Implement action plans and integrate them into the project.

• Tracking and Reporting:

• Provide visibility to all risks.

• Closing:

• Close the identified risk.
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Risk Identification

The first action of risk management is the identification

of individual events that the project may encounter

during its lifecycle.

The identification step comprises:

• Identify the risks

• Categorize the risks 

• Match the identified risks to categories

• Define ownership for managing the risks.
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Risk Identification

• Source of Risk: 

• Identification of risk sources provides a basis for systematically 

examining changing situations over time to uncover circumstances that 

impact the ability of the project to meet its objectives.
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Risk Identification

Source of 
Risk

Description

Human 
Resources

The risks originated from human resources (e.g., availability, skill etc.)

Physical  
Resources

The risks originated from physical resources (e.g., hardware or software,
availability of the required number at the right time etc.)

Technology
The risks originated from technology (e.g., development environment, new or
complex technologies, performance requirements, tools etc.)

Suppliers
The risks are associated with a supplier (e.g., delays in supplies, capability of
suppliers etc.)

Customer 
The risks derived from the customer (e.g., unclear requirements, requirement
volatility, change in project scope, delays in response etc.)

Security
The risks are associated with information security, security of personnel, security
of assets, and security of intellectual property

Legal The risks are associated with legal issues that may impact the project

Project 
management

The risks are associated with project management processes, organizational
maturity, and ability
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Risk Identification

Risk Parameters:

Parameters for evaluating, categorizing, and prioritizing 

risks include the following:

• Risk likelihood (i.e., probability of risk occurrence)

• Risk consequence (i.e., impact and severity of risk occurrence)

• Thresholds to trigger management activities.
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Risk Assessment

The risk assessment consists of evaluating the range of possible impacts 

should the risk occur. 

Follow these steps when assessing risks: 

1. Define the various impacts of each risk

2. Rate each impact based on a logical severity level 

3. Sort and evaluate risks by severity level

4. Determine if any controls already exist

5. Define potential mitigation actions.
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Risk Mitigation Planning

The risk owners are responsible for planning and implementing 

mitigation actions with support from the project team.  

• All team members, inclusive of partners and suppliers, may be 

requested to identify and develop mitigation measures for identified 

risks.

• The project core team members are responsible for identifying an 

appropriate action owner for each identified risk. 

• After mitigation actions are defined, the project core team will review 

the actions.

• The risk owner must track all mitigation actions and expected 

completion dates.

• The risk owner and the project core team members must hold all action 

owners accountable for the risk mitigation planning.
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Risk Mitigation Action Implementation

• The action implementation is the responsibility of the risk owner. 

• The action owners are responsible for the execution of the tasks or 

activities necessary to complete the mitigation action and eliminate or 

minimize the risk.

• The risk owner or the project manager will monitor completion dates of 

the mitigation action implementation.
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Risk Occurrence and Contingency Plans

• Whenever any risk occurs, the project team should implement 

contingency plans to ensure that project deliverables can be met. 

• The details of each occurrence should be recorded  in the risk register 

or other tracking tool.

• The risk register or risk management plan (see next slide) will be 

maintained by the project manager and reviewed on a regular basis.
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Risk Tracking and Reporting

• Risk tracking and reporting provides critical visibility to all risks. 

• Risk owners must report on the status of their mitigation actions.  

• Depending on the risk severity, project managers need to report the risk status of 

each category of risk to senior management.
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Risk Closure

• The risk owners are responsible for recommending the risk closure to 

the project manager. 

• A risk is closed only when the item is not considered a risk to the 

project anymore. 

• When a risk is closed, the project manager needs to update the risk 

status in the lessons learned document.
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Risk Analysis Features

The risk analysis should be:

• Systematic

• Comprehensive

• Data driven

• Adherent to evidence

• Logically sound

• Practically acceptable

• Open to critique

• Easy to understand.
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Project Risk Analysis Advantages

• Helps strategic and business planning

• Meets customer requirements

• Reduces schedule slips and cost overruns

• Promotes an effective usage of resources

• Promotes continuous improvement

• Helps to achieve project goals

• Minimizes surprises from customers and stakeholders

• Allows a quick grasp of new opportunities

• Enhances communication

• Reassures stakeholders that the project stays on track.
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1.3.5 Project Planning
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What is Project Management?

• Project management is the process of defining, planning, organizing, 

managing, leading, securing,  and optimizing the resources to achieve 

a set of planned goals and objectives.

• It is the application of knowledge, skills, tools, and techniques to project 

activities in order to meet project requirements.
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What is a Project Plan?

• A project plan is a crucial step in project management for achieving a 

project’s goals. 

• A project plan is a formal approved document used to guide and 

execute project tasks. 

• It provides an overall framework for managing project tasks, schedules, 

and costs.

• A project plan is a coordinating tool and communication device that 

helps teams, contractors, customers, and organizations define the 

crucial aspects of a project or program.
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Project Planning Stages

1. Determine project scope and objectives: Explore opportunities, 

identify and prioritize needs, consider project solutions.

2. Plan the project: Identify input and resources requirements such as 

human resources, materials, software, hardware, and budgets. 

3. Prepare the project proposal: Based on stakeholder feedback, plan 

the necessary resources, timeline, budget etc.

4. Implement the project: Implement the project by engaging 

responsible resources and parties. Ensure execution and compliance 

of the defined plans.

5. Evaluate the project: Regularly review progress and results. 

Measure the project’s effectiveness against quantifiable

requirements. 
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Planning and Scheduling Objectives

• To optimize the use of resources (both human and other resources).

• To increase productivity.

• To achieve desired schedules and deliverables.

• To establish an approach to minimize long-term maintenance costs.

• To minimize the chaos and productivity losses resulting from planned 
production schedules, priority changes, and non-availability of 
resources.

• To assess current needs and future challenges. 
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Project Planning Activities 

• Statement of work (SOW)

• Work breakdown structure (WBS)

• Resource estimation plan

• Project schedule

• Budget or financial plan

• Communication plan

• Risk management plan
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Project Planning Activities: SOW 

Statement of Work (SOW) is a formal document often accompanying a

contract that outlines specific expectations, limitations, resources and

work guidelines intended to define the work or project.

SOW’s:

• Define the scope of the project.

• Establish expectations and parameters of the project.

• Identify technical requirements for the project.

• Provide guidance on materials to be used.

• Establish timeline expectations.

• Etc.
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Project Planning Activities: WBS

Work Breakdown Structure (WBS) is a decomposition of project 

components into small and logical bodies of work or tasks.

Work Breakdown Structures:

• Identify all required components of a project.

• Cascades components into sub-components and tasks.

• WBS’s are not by themselves project plans or schedules but they are a 

necessary step to help establish project plans and timelines.

• WBS’s also enable logical reporting and summarizations of project progress
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Project Planning Activities: WBS

Work Breakdown Structure Example: below is an example of a WBS

for the assembly of a bicycle.
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Project Planning Activities: Resource Planning 

Resource Estimation Plan

• Estimate Resource Requirements (Use Your WBS)

• Parts, Hardware, Software, Human Resources etc.

• Plan resources

• Establish who is responsible for what and when.

• Determine quantity requirements and delivery dates etc.
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Project Planning Activities: Project Scheduling 

Project Scheduling:

• Assign beginning times to each activity in the WBS
(days are used for start and durations times in example below).

• Assign duration times to each activity in the WBS.

• Identify People Responsible and set completion dates.

• Represent schedules as Gantt charts or network diagrams.

• Identify critical dependencies between tasks.
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Project Planning Activities: Project Scheduling

Project Schedule – Gantt Chart:

• The advantage of a Gantt chart is its ability to display the status of each task/activity 

at a glance.

• Because it is a graphic representation, it is easy to demonstrate the schedule of tasks 

and timelines to all the stakeholders.
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Project Scheduling: Preparing a Gantt Chart in Excel

There are many tools available to create Gantt charts.  Some of the most 

common and compatible for businesses are: Microsoft Project, Visio and Excel. 

In Microsoft Excel we use the bicycle example:

1. Select rows & columns of your tasks, start times and durations.
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Project Scheduling: Preparing a Gantt Chart in Excel

2. On the Insert tab select Bar > Stacked Bar.

3. On the Design tab choose a design style from the style dropdown.

2

3
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Project Scheduling: Preparing a Gantt Chart in Excel

4. Activate the “start tasks” on your graph.

5. From the format tab select “format selection”.

45

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

204



www.ABTU.edu

Project Scheduling: Preparing a Gantt Chart in Excel

6. Select Fill > No Fill.

7. Select Shadow > Presets > No Shadow > Close.

7
6
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Project Scheduling: Preparing a Gantt Chart in Excel

8. Format your new Gantt chart to your own preferences.
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Project Scheduling: Critical Path Method

Critical Path Method (CPM) is a project modeling technique used to

identify the set of activities that are most influential to a projects

completion timeline.

• Critical Path tasks are those that others are dependent upon.

• Project timelines cannot be shortened without shortening the tasks or 

activities that are identified as critical path items.

Steps To Using The Critical Path Method

1. List all activities necessary to complete the project.

2. Determine the time or duration of each activity.

3. Identify the dependencies between the activities.

Use Your Work Breakdown Structure (WBS).
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Project Scheduling: Critical Path Method

Critical Path Method Example: Let’s continue with our bicycle example.
Note that the tasks in the WBS are already set to start based on their
dependencies.

• For example, Installing the wheels in step 1.1.5 requires the whole set of
steps in 1.2 to be completed so 1.1.5 starts on day 14 when the wheels are
ready.
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Project Scheduling: Critical Path Method

Continuing this example; the last task, 1.3.4 Adjusting the Brake System,

completes on day 23 and can’t begin until day 21 because the brake

system must be attached to the bike frame before being calibrated.
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Project Scheduling: Critical Path Method

Earlier if you noticed when we conducted our resource plan that we were out of tire

tubes then you might have managed your resources differently.

Let’s assume the tubes take 21 days to receive from the supplier. Below is the

adjustment to our Gantt chart. Notice that the project timeline is pushed out by 8 days,

finishing on day 31 instead of day 23.
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Project Scheduling: PERT

Program Evaluation & Review Technique (PERT): is a method of
evaluation that can be applied to time or cost.

• PERT provides a weighted assessment of time or cost

• PERT uses 3 parameters for estimation:

• Optimistic or Best Case Scenario represented by ‘O’.

• Pessimistic or Worst Case Scenario represented by ‘P’.

• Most Likely Scenario represented by ‘ML’.

• PERT Equation:

• The PERT equation provides for heavier weighting of the most likely
scenario but also considers the best and worst cases. In the event that a
best or worst case scenario is an extreme situation, the PERT will account
for it in a weighted manner.

(O + (4*ML) + P) / 6
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Project Scheduling: PERT

Let’s apply the PERT formula to our estimates of receiving our needed

tire tubes from the supplier and then change our schedule based on the

result.

• Your experience with this supplier tells you that they typically over estimate

the time required to deliver. Therefore, their 21 day lead time on the tubes

should be considered a “worst case scenario”.

• Procurement has indicated that tubes have arrived in as few as 6 days from

this supplier. So, your best case scenario is 6 days.

• The most likely scenario you decide will be the median of this suppliers

delivery time which is 10 days.

• Therefore: (O + (4*ML) + P) / 6
(6 + (4*10) + 21) / 6

(6 + 40 + 21) / 6

67 / 6 = 11
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Project Scheduling: PERT

Using 11 days in your project plan instead of 21 gives you a more confident estimate of

time and actually removes tire tubes as the primary detracting critical path item.
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Project Planning Activities 

Budget or Financial Plan

• Planned expenses

• Planned revenues

• Budget forecast
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Project Planning Activities 

Communication Plan

• Establish communication procedures among management, team 
members, and relevant stakeholders.

• Determine the communication schedule.

• Define the acceptable modes of communication.
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Project Planning Activities 

Risk Management Plan

• Identify the sources of project risks and estimate the effects of those 
risks. 

• Risks might arise from new technology, availability of  resources, lack 
of inputs from customers, business risks etc.

• Assess the impact of risk to the customers/stakeholders.

• Calculate the probability of risk occurrence based on previous similar 
projects or industry benchmarks

• Initiate mitigation and contingency plans

• Review risks on a periodic basis
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Project Planning Tools Advantages

• Project planning tools are very useful to organize and communicate project 
plans, status, and projections.

• They help link tasks and sub-tasks or other work elements to get a whole 
view of what needs to be accomplished.

• They allow a more objective comparison of alternative solutions and provide 
consistent coverage of responsibilities.

• They allow for effective scope control and change management.

• They facilitate effective communication with all project participants and 
stakeholders.

• They help define management reviews.

• They act as an effective monitoring mechanism for the project.

• They establish project baselines for progress reviews and control points.
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1.4 Lean Fundamentals
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Black Belt Training: Define Phase

1.1 Six Sigma Overview

1.1.1 What is Six Sigma

1.1.2 Six Sigma History

1.1.3 Six Sigma Approach Y = f(x)

1.1.4 Six Sigma Methodology

1.1.5 Roles and Responsibilities

1.2 Six Sigma Fundamentals

1.2.1 Defining a Process

1.2.2 VOC and CTQs

1.2.3 QFD

1.2.4 Cost of Poor Quality (COPQ)

1.2.5 Pareto Analysis (80:20 rule)

1.3 Lean Six Sigma Projects

1.3.1 Six Sigma Metrics

1.3.2 Business Case and Charter

1.3.3 Project Team Selection

1.3.4 Project Risk Management

1.3.5 Project Planning

1.4 Lean Fundamentals

1.4.1 Lean and Six Sigma

1.4.2 History of Lean

1.4.3 The Seven Deadly Muda

1.4.4 Five-S (5S)
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1.4.1 Lean and Six Sigma
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What is Lean?

• A lean enterprise intends to eliminate waste and allow only value to be 

pulled through its system.

• Lean manufacturing is characterized by:

• Identifying and driving value

• Establishing flow and pull systems

• Creating production availability and flexibility

• Zero waste

• Waste Elimination

• Waste identification and elimination

is critical to any successful lean

enterprise.

• Elimination of waste enables flow,

drives value, cuts cost, and provides 

flexible and available production.
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The 5 Lean Principles

• The following 5 principles of lean are taken from the book Lean 

Thinking (1996) by James P. Womack and Daniel T. Jones.

1. Specify value desired by customers.

2. Identify the value stream.

3. Make the product flow continuous.

4. Introduce pull systems where continuous flow is possible.

5. Manage toward perfection so that the number of steps and the amount of 

time and information needed to serve the customer continually falls.
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Lean & Six Sigma

• Lean and Six Sigma both have the 

objectives of producing high value (quality) 

at lower costs (efficiency).

• They approach these objectives in 

somewhat different manners but in the end, 

both Lean and Six Sigma drive out waste, 

reduce defects, improve processes, and 

stabilize the production environment.

• Lean and Six Sigma are a perfect 

combination of tools for improving quality 

and efficiency.

Lean

Eliminate 
Waste

Process 
Flow

Pull 
Systems

Easy 
Visual 

Approach

Six 
Sigma

Eliminate 
Defects

Process 
Yield

Capable 
Systems

Rigorous 
Analytical 
Approach

Quality & Value for the Customer

Efficiency for the Business
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1.4.2 History of Lean
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History of Lean

Polaroid
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History of Lean

• Lean thinking originated, as far as is known, the 1400s. 

• Henry Ford established the first mass production system in 1913 by 

combining standard parts, conveyors, and work flow.

• Decades later, Kiichiro Toyoda and Taiichi Ohno at Toyota improved 

and implemented various new concepts and tools (e.g., value stream, 

takt time, kanban etc.) based on Ford’s effort.

• Toyota developed what is known today as the Toyota Production 

System (TPS) based on lean principles.
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History of Lean

• Starting in the mid 1990s, Lean became extensively recognized and 

implemented when more and more Fortune 100 companies began to 

adopt Lean and Six Sigma.

• The term “Lean manufacturing” was introduced by James Womack in 

the 1990s.

• Lean and Six Sigma share similar objectives, work hand in hand, and 

have benefited from one another in the past 30 years.
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1.4.3 Seven Deadly Muda

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

228



www.ABTU.edu

The 7 Deadly Muda

• The Japanese word for waste is “muda.”

• There are 7 commonly recognized forms of waste, often referred to as 
the “7 deadly muda.” 

1. Defects

2. Overproduction

3. Over-Processing

4. Inventory

5. Motion

6. Transportation

7. Waiting
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The 7 Deadly Muda: Defects

• Defects or defectives are an obvious waste for any working 

environment or production system.

• Defects require rework during production and/or after the product is 

returned from an unhappy customer.

• Some defects are difficult to solve and they create “workarounds” and 

hidden factories.

• Eliminating defects is a sure way to improve product quality, customer 

satisfaction, and production costs.
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The 7 Deadly Muda: Overproduction

• Overproduction is wasteful because your system expends energy and 
resources to produce more materials than the customer or next 
function requires.

• Overproduction is one of the most detrimental of the seven deadly 
muda because it leads to many others:

• Inventory

• Transportation

• Waiting etc. 
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The 7 Deadly Muda: Over-processing

• Over-processing occurs any time 

more work is done than is required by 

the next process step, operation, or 

consumer.

• Over-processing also includes being over capacity (scheduling more 

workers than required or having more machines than necessary).

• Another form of over processing can be buying tools or software that 

are overkill (more precise, complex, or expensive than required).
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The 7 Deadly Muda: Inventory

• Inventory is an often overlooked waste. Look at the picture above and 

imagine all the time, materials, and logistics that went into establishing 

such an abundance of inventory.

• If this were your personal business, and inventory velocity was not 

matched with production, how upset would you be?
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The 7 Deadly Muda: Motion

• Motion is another form of waste often occurring 

as a result of poor setup, configuration, or 

operating procedures.

• Wasted motion can be experienced by machines 

or humans.

• Wasted motion is very common with workers 

who are unaware of the impact of small 

unnecessary movements in repetitive tasks.

• Wasted motion is exaggerated by repetition or 

recurring tasks.
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The 7 Deadly Muda: Transportation

• Transportation is considered wasteful 

because it does nothing to add value or 

transform the product.

• Imagine for a moment driving to and 

from work twice before getting out of 

your car to go into work. . .

• That is waste in the form of transportation.

• The less driving you have to do, the better.

• In a similar way, the less transportation a product has to endure, the 

better. There would be fewer opportunities for delay, destruction, loss, 

damage etc.
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The 7 Deadly Muda: Waiting

• Waiting is an obvious form of waste and is typically a symptom of an 
upstream problem.

• Waiting is usually caused by inefficiency, bottlenecks, or poorly-
designed work flows within the value stream.

• Waiting can also be caused by inefficient administration.

• Reduction in waiting time will require thoughtful applications of lean 
and process improvement.
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1.4.4 Five-S (5S)
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What is 5S?

• 5S is systematic method to organize, order, clean, and standardize a 

workplace…and to keep it that way!

• 5S is a methodology of organizing and improving the work environment.

• 5S is summarized in five Japanese words all starting with the letter S:

• Seiri (sorting)

• Seiton (straightening)

• Seiso (shining)

• Seiketsu (standardizing)

• Shisuke (sustaining)

• 5S was originally developed in Japan and is widely used to optimize 

the workplace to increase productivity and efficiency.
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Five-S (5S)

Sort Set in Order Shine

Standardize Sustain
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Goals of 5S

• Reduced waste

• Reduced cost

• Establish a work environment that is:
• self-explaining

• self-ordering

• self-regulating

• self-improving.

• Where there is/are no more:

• Wandering and/or searching

• Waiting or delaying

• Secret hiding spots for tools

• Obstacles or detours

• Extra pieces, parts, materials etc.

• Injuries

• Waste. 
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Benefits of 5S Systems

• Reduced changeovers 

• Reduced defects

• Reduced waste

• Reduced delays 

• Reduced injuries 

• Reduced breakdowns 

• Reduced complaints

• Reduced red ink

• Higher quality

• Lower costs

• Safer work environment

• Greater associate and equipment capacity.
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Reported Results of 5S Systems

• Cut in floor space: 60%

• Cut in flow distance: 80%

• Cut in accidents: 70%

• Cut in rack storage: 68%

• Cut in number of forklifts: 45%

• Cut in machine changeover time: 62%

• Cut in annual physical inventory time: 50%

• Cut in classroom training requirements: 55%

• Cut in nonconformance in assembly: 96%

• Increase in test yields: 50%

• Late deliveries: 0%

• Increase in throughput: 15%
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Sorting (Seiri)

• Go through all the tools, parts, equipment, 

supply, and material in the workplace.

• Categorize them into two major groups: needed 

and unneeded.

• Eliminate the unneeded items from the 

workplace. Dispose of or recycle those items.

• Keep the needed items and sort them in the 

order of priority. When in doubt…throw it out!
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Straightening (Seiton)

• Straightening in 5S is also called setting in 

order.

• Label each needed item.

• Store items at their best locations so that the 

workers can find them easily whenever they 

needed any item.

• Reduce the motion and time required to locate 

and obtain any item whenever it is needed. 

• Promote an efficient work flow path.

• Use visual aids like the tool board image on this 

page.
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Shining (Seiso)

• Shining in 5S is also called sweeping.

• Clean the workplace thoroughly.

• Maintain the tidiness of the workplace.

• Make sure every item is located at the specific 

location where it should be.

• Create the ownership in the team to keep the 

work area clean and organized.
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Standardizing (Seiketsu)

• Standardize the workstation and the layout of tools, equipment and 

parts.

• Create identical workstations with a consistent way of storing the items 

at their specific locations so that workers can be moved around to any 

workstation any time and perform the same task.
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Sustaining (Shisuke)

• Sustaining in 5S is also called self-discipline.

• Create the culture in the team to follow the first four S’s consistently.

• Avoid falling back to the old ways of cluttered and unorganized work 

environment.

• Keep the momentum of optimizing the workplace.

• Promote innovations of workplace improvement.

• Sustain the first fours S’s using:

• 5S Maps

• 5S Schedules

• 5S Job cycle charts

• Integration of regular work duties

• 5S Blitz schedules

• Daily workplace scans.
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Simplified Summary of 5S

1. Sort – “when in doubt, move it out.”

2. Set in Order – Organize all necessary tools, parts, and components 

of production. Use visual ordering techniques wherever possible.

3. Shine – Clean machines and/or work areas. Set regular cleaning 

schedules and responsibilities.

4. Standardize – Solidify previous three steps, make 5S a regular part 

of the work environment and everyday life.

5. Sustain – Audit, manage, and comply with established 5S guidelines 

for your business or facility.
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Five-S (5S)

• A few words about 5S and the Lean Enterprise

• As a method, 5S generates immediate improvements.

• 5S is one of many effective lean methods that create observable results.

• It is tempting to implement 5S alone without considering the entire value 

stream.

• However, it is advisable to consider a well-planned lean manufacturing 

approach to the entire production system.
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2.0 Measure Phase
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Black Belt Training: Measure Phase

2.1 Process Definition

2.1.1 Cause and Effect Diagrams

2.1.2 Cause and Effects Matrix

2.1.3 Process Mapping

2.1.4 FMEA: Failure Modes & Effects Analysis

2.1.5 Theory of Constraints

2.2 Six Sigma Statistics

2.2.1 Basic Statistics

2.2.2 Descriptive Statistics

2.2.3 Distributions and Normality

2.2.4 Graphical Analysis

2.3 Measurement System Analysis

2.3.1 Precision and Accuracy

2.3.2 Bias, Linearity, and Stability

2.3.3 Gage R&R

2.3.4 Variable and Attribute MSA

2.4 Process Capability

2.4.1 Capability Analysis

2.4.2 Concept of Stability

2.4.3 Attribute and Discrete Capability

2.4.4 Monitoring Techniques
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2.1 Process Definition
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Black Belt Training: Measure Phase

2.1 Process Definition

2.1.1 Cause and Effect Diagrams

2.1.2 Cause and Effects Matrix

2.1.3 Process Mapping

2.1.4 FMEA: Failure Modes & Effects Analysis

2.1.5 Theory of Constraints

2.2 Six Sigma Statistics

2.2.1 Basic Statistics

2.2.2 Descriptive Statistics

2.2.3 Distributions and Normality

2.2.4 Graphical Analysis

2.3 Measurement System Analysis

2.3.1 Precision and Accuracy

2.3.2 Bias, Linearity, and Stability

2.3.3 Gage R&R

2.3.4 Variable and Attribute MSA

2.4 Process Capability

2.4.1 Capability Analysis

2.4.2 Concept of Stability

2.4.3 Attribute and Discrete Capability

2.4.4 Monitoring Techniques
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2.1.1 Cause and Effect Diagram
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Effect

Affinity

Affinity

Cause

Cause

Affinity

Affinity

Affinity

Affinity

Cause

Cause

Cause

Cause

What is a Cause and Effect Diagram?

• A cause and effect diagram is also called a Fishbone Diagram or 

Ishikawa Diagram. It was created by Kaoru Ishikawa and is used to 

identify, organize, and display the potential causes of a specific effect 

or event in a graphical way similar to a fishbone.

• It illustrates the relationship between one specified event (output) and 

its categorized potential causes (inputs) in a visual and systematic way.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

255



www.ABTU.edu

Major Categories of Potential Causes 

• P4ME

• People: People who are involved in the process

• Methods: How the process is completed (e.g., procedures, policies, 

regulations, laws)

• Machines: Equipment or tools needed to perform the process

• Materials: Raw materials or information needed to do the job

• Measurements: Data collected from the process for inspection or 

evaluation

• Environment: Surroundings of the process (e.g., location, time, culture).
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How to Plot a Cause and Effect Diagram

• Step 1: Identify and define the effect/event being analyzed.

• Clearly state the operational definition of the effect/event of interest.

• The event can be the positive outcome desired or negative problem 

targeted to solve.

• Enter the effect/event in the end box of the Fishbone diagram and draw a 

spine pointed to it.
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How to Plot a Cause and Effect Diagram

• Step 1

Effect or Event 
Being Analyzed
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How to Plot a Cause and Effect Diagram

• Step 2: Brainstorm the potential causes or factors of the effect/event 

occurring.

• Identify any factors with a potential impact on the effect/event and include 

them in this step.

• Put all the identified potential causes aside for use later. 
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How to Plot a Cause and Effect Diagram

• Step 2 

Cause

Cause
Cause

Cause
Cause

Cause
Cause

Cause

Cause
Cause

Cause
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How to Plot a Cause and Effect Diagram

• Step 3: Identify the main categories of causes and group the potential 

causes accordingly.

• Besides P4ME (i.e., people, methods, machines, materials, measurements, 

and environment), you can group potential causes into other customized 

categories.

• Below each major category, you can define sub-categories and then 

classify them to help you visualize the potential causes.

• Enter each cause category in a box and connect the box to the spine. Link 

each potential cause to its corresponding cause category.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

261



www.ABTU.edu

How to Plot a Cause and Effect Diagram

• Step 3 

Effect or Event 
Being Analyzed

Machines

Environment

Methods

Measurements

People

Materials

Cause

CauseCause

CauseCause

Cause
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How to Plot a Cause and Effect Diagram

• Step 4: Analyze the cause and effect diagram. 

• A cause and effect diagram includes all the possible factors of the 

effect/event being analyzed. 

• Use a Pareto chart to filter causes the project team needs to focus on.

• Identify causes with high impact that the team can take action upon.

• Determine how to measure causes and effects quantitatively. Prepare for 

further statistical analysis.
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Benefits to Using Cause and Effect Diagram

• Helps to quickly identify and sort the potential causes of an effect.

• Provides a systematic way to brainstorm potential causes effectively 

and efficiently.

• Identifies areas requiring data collection for further quantitative 

analysis.

• Locates “low-hanging fruit.”
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Limitation of Cause and Effect Diagrams

• A cause and effect diagram only provides qualitative analysis of 

correlation between each cause and the effect.

• One cause and effect diagram can only focus on one effect or event at 

a time.

• Further statistical analysis is required to quantify the relationship 

between various factors and the effect and identify the root causes.
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Cause and Effect Diagram Example

• Case study:

• A real estate company is interested to find the root causes of high energy 

costs of its properties. 

• The cause and effect diagram is used to identify, organize, and analyze the 

potential root causes.
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Cause and Effect Diagram Example

• Step 1: Identify and define the effect/event being analyzed: high energy 

costs of buildings.

High Energy
Cost of Buildings
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Cause and Effect Diagram Example

• Step 2: Brainstorm the potential causes or factors of the high energy 

costs. 

Aged HVAC 

units
Poor 

maintenance of 

HVAC units

Bad energy
consuming habits

Inaccurate 

meteringBuilding 

materials

Temperature set 

point is too low in 

summer

Temperature set 

point is too high in 

winter

Most lights are still on 

during non-business 

hours

Building air 

leakage

Fuel prices 

increasing
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Cause and Effect Diagram Example

• Step 3: Identify the main categories of causes and group the potential 

causes accordingly. 

High Energy
Cost of Buildings

Machines

Environment

Methods

Measurements

People

Materials

Aged HVAC Units

Building Air 
Leakage

Inaccurate 
Metering

Lights On After 
Hours

Poor Maintenance 
of HVAC Units

Inefficient Building 
Materials

Temp Set point too 
low in summer

Bad Energy 
Consuming Habits

Temp Set Point 
too high in winter

Fuel Princes 
Increasing
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Cause and Effect Diagram Example

• Step 4: Analyze the cause and effect (C&E) diagram. 

• After completing the C&E diagram, the real estate company conducts further 
research on each potential root cause.

• It is discovered that:

• The utility metering is accurate

• The building materials are fine and there is not significant amount of air leakage from the 
building

• The fuel prices increased recently but were negligible

• Most lights are off during the non-business hours except that some lights have to be on for 
security purposes

• The temperature set points in the summer and winter are both adequate and reasonable

• The high energy costs are probably caused by the poor HVAC maintenance on aged units 
and the wasteful energy consuming habits.

• Next, the real estate company needs to collect and analyze the data to check whether 
root causes identified in the C&E diagram are statistically the causes of the high 
energy costs.
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2.1.2 Cause and Effects Matrix
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What is a Cause and Effect Matrix?

• The cause and effect matrix (XY Matrix) is a tool to help subjectively 

quantify the relationship of several X's to several Y's. 

• Among the Y's under consideration, two important ones should be the 

primary and secondary metrics of your Six Sigma project. 

• The X's should be derived from your cause and effect diagram. Let us 

take a peek as what it looks like on the next page.
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Cause and Effects Matrix
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How to Use a Cause and Effect Matrix

1. Across the top enter your output measures. These are the Y’s that are important to your 

project.

2. Next, give each Y a weight. Use a 1–10 scale, 1 being least important and 10 most 

important.

3. Below, in the leftmost column, enter all the variables you identified with your cause and 

effect diagram.

4. Within the matrix itself, rate the strength of the relationship between the X in the row and 

the corresponding Y in that column. Use a scale of 0, 3, 5, and 7.

5. Lastly, sort the “Score” column to order the most important X’s first.
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Cause and Effect Matrix Notes
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After You Have Completed the C&E Matrix

After you have completed your cause and effects matrix, build a strategy 

for validating and/or eliminating the x’s as significant variables to the 

Y=f(x) equation.

• Build a data collection plan

• Prepare and execute planned studies

• Perform analytics

• Review results with SMEs

• etc.
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2.1.3 Process Mapping
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What is a Process Map?

• Process mapping is an important aspect to begin understanding a process. 

It provides a visual display of the steps required to produce a good or service.

• There are various forms of process mapping techniques that are used in the 

DMAIC methodology. We have already covered three common and useful 

maps in our “Process Definition” section of the Define phase:

• High Level Process Map

• Detailed Process Map

• Functional Process Map

• Now we will explore a few other value process mapping techniques:

• SIPOC

• Value Stream

• Spaghetti Diagram

• Thought Process Map
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What is SIPOC? 

• A SIPOC (Suppliers-Input-Process-Output-Customers) is a high-level 

visualization tool to help identify and link the different components in a 

process.

• It is usually applied in the Measure phase in order to better understand 

the current state of the process and define the scope of the project.
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Key Components of a SIPOC

• Suppliers: vendors who provide the raw material, services, and 

information. Customers can also be suppliers sometimes.

• Input: the raw materials, information, equipment, services, people, 

environment involved in the process.

• Process: the high-level sequence of actions and decisions that results 

in the services or products delivered to the customers.

• Output: the services or products delivered to the customers and any 

other outcomes of the process.

• Customers: the end users or recipients of the services or products.
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How to Plot a SIPOC Diagram

• The first method:

• Step 1: Create a template that can contain the information of the five key 
components in a clear way.

• Step 2: Plot a high-level process map that covers five steps at maximum.

• Step 3: Identify the outputs of the process.

• Step 4: Identify the receipt of the process.

• Step 5: Brainstorm the inputs required to run each process step.

• Step 6: Identify the suppliers who provide the inputs.
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How to Plot a SIPOC Diagram

• The second method:

• Step 1: Create a template that can contain the information of the five key 
components in a clear way.

• Step 2: Identify the receipt of the process.

• Step 3: Identify the outputs of the process.

• Step 4: Plot a high-level process map that covers five steps at maximum.

• Step 5: Brainstorm the inputs required to run each process step.

• Step 6: Identify the suppliers who provide the inputs.
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Benefits of SIPOC Diagrams

• A SIPOC diagram provides more detailed information than process 

maps and it demonstrates how each component gets involved in the 

process.

• It helps visualize and narrow the project scope.

• It serves as a great communication tool to help different process 

owners understand the entire process, their specific roles and 

responsibilities.
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SIPOC Diagram Example

• Example of plotting a SIPOC diagram for Mom cooking scrambled 

eggs for two kids
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Creating a SIPOC

• Step 1: Vertically List High-Level Process

• If you followed the general rules for a high-level process map, then you 

should have no more than 4–6 steps for your process.

• List those steps in a vertical manner as depicted below.
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Creating a SIPOC

• Step 2: List Process Outputs
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Creating a SIPOC

• Step 3: List Output Customers
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Creating a SIPOC

• Step 4: List Process Inputs
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Creating a SIPOC

• Step 5: List Suppliers of Inputs
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SIPOC Benefits

• Visually communicate project scope

• Identify key inputs and outputs of a process

• Identify key suppliers and customers of a process

• Verify:

• Inputs match outputs for upstream processes

• Outputs match inputs for downstream processes.

• This type of mapping is effective for identifying opportunities for 

improvement of your process.

• If you have completed your high-level process map, follow the outlined 

steps to create a process map of Suppliers, Inputs, Process, Outputs, 

and Customer.
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What is Value Stream Mapping?

• Value stream mapping 

is a method to visualize 

and analyze the path of 

how information and raw 

materials are 

transformed into 

products or services 

customers receive.

• It is used to identify, 

measure, and decrease 

the non-value-adding 

steps in the current 

process.
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Non-Value-Added Activities

• Non-value-adding activities are activities in a process that do not add 

any other value to the products or services customers demand.

• Example of non-value-adding activities:

• Rework

• Overproduction

• Excess transportation

• Excess stock

• Waiting

• Unnecessary motion.

• Not all non-value-adding activities are unnecessary.
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How to Plot a Value Stream Map

• Plot the entire high-level process flow from when the customer places 

the order to when the customer receives the products or services in the 

end.

• A value stream map requires more detailed information for each step 

than the standard process map.

• Cycle time

• Preparation time

• Actual working time

• Available time

• Scrap rate

• Rework rate

• Number of operators

• Assess the value stream map of current process, identity and eliminate 

the waste.
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Spaghetti Chart

• A spaghetti chart is a graphical tool to map out the physical flow of 

materials, information, and people involved in a process. It can also 

reflect the distances between multiple workstations the physical flow 

has been through.

• A process that has not been streamlined has messy and wasteful 

movements of materials, information, and people, resembling a bowl of 

cooked spaghetti.
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How to Plot a Spaghetti Chart

• Step 1: Create a map of the work area layout.

• Step 2: Observe the current work flow and draw the actual work path 

from the very beginning of work to the end when products exit the work 

area.

• Step 3: Analyze the spaghetti chart and identify improvement 

opportunities.
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Spaghetti Chart Example
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Thought Process Mapping

• A thought process map is a graphical tool to help brainstorm, 

organize, and visualize the information, ideas, questions, or thoughts 

regarding reaching the project goal.

• It’s a popular tool often used at the beginning of a project in order to:

• identify knowns and unknowns

• communicate assumptions and risks

• discover potential problems and solutions

• identify resources, information, and actions required to meet the goal

• present relationship of thoughts.
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How to Plot a Thought Process Map

• Step 1: Define the project goal.

• Step 2: Brainstorm knowns and unknowns about the project.

• Step 3: Brainstorm questions and group the unknowns and questions 
into five phases (Define, Measure, Analyze, Improve, and Control).

• Step 4: Sequence the questions below the project goal and link the 
related questions.

• Step 5: Identify tools or methods that would be used to answer the 
questions.

• Step 6: Repeat steps 3 to 5 as the project continues.
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Thought Process Map Example

Deliver the pizza 

to clients in time

Transportation
Staff

System

Process

Car Battery

Traffic

How often?

Which area?

What time?

Training

Too few?

Scheduling

Routing

Process Map

Online ordering system

Phone ordering system
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2.1.4 FMEA
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What is FMEA? 

• The FMEA (Failure Modes and Effects Analysis) is an analysis technique to 

identify, evaluate, and prioritize a potential deficiency in a process so that the 

project team can design action plans to reduce the probability of the 

failure/deficiency occurring.

• FMEA is completed in cross-functional brainstorming sessions in which 

attendees have a good understanding of the entire process or of a segment 

of it.
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Basic FMEA Terms

• Process Functions

• Process steps depicted in the process map. FMEA is based on a process map and one 

step/function is analyzed at a time.

• Failure Modes

• Potential and actual failure in the process function/step. It usually describes the way in 

which failure occurs. There might be more than one failure mode for one process function.

• Failure Effects

• Impact of failure modes on the process or product. One failure mode might trigger multiple 

failure effects.

• Failure Causes

• Potential defect of the design that might result in the failure modes occurring. One failure 

mode might have multiple potential failure causes.

• Current Controls

• Procedures currently conducted to prevent failure modes from happening or to detect the 

failure mode occurring.
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Basic FMEA Terms

• Severity Score

• The seriousness of the consequences of a failure mode occurring.

• Ranges from 1 to 10, with 10 indicating the most severe consequence.

• Occurrence Score

• The frequency of the failure mode occurring. 

• Ranges from 1 to 10, with 10 indicating the highest frequency.

• Detection Score

• How easily failure modes can be detected. 

• Ranges from 1 to 10, with 10 indicating the most difficult detection.
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Basic FMEA Terms

• RPN (Risk Prioritization Number)

• The product of the severity, occurrence, and detection scores.

• Ranges from 1 to 1000. 

• The higher RPN is, the more focus the particular step/function needs.

• Recommended Actions

• The action plan recommended to reduce the probability of failure modes 

occurring.
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How to Conduct an FMEA

• Step 1: List the critical functions of the process based on the process 

map created.

• Step 2: List all potential failure modes that might occur in each function. 

One function may have multiple potential failures.

• Step 3: List all potential failure effects that might affect the process or 

product.

• Step 4: List all possible causes that may lead to the failure mode 

happening.

• Step 5: List the current control procedures for each failure mode. 
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How to Conduct an FMEA

• Step 6: Determine the severity rating for each potential failure mode.

• Step 7: Determine the occurrence rating for each potential failure cause.

• Step 8: Determine the detection rating for each current control 

procedure.

• Step 9: Calculate RPN (Risk Prioritization Number).

• Step 10: Rank the failures using RPN and determine the precedence of 

problems or critical inputs of the process. A Pareto chart might help to 

focus on the failure modes with high RPNs. The higher the RPN, the 

higher the priority the correction action plan.
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How to Conduct an FMEA

• Step 11: Brainstorm and create recommended action plans for each 
failure mode.

• Step 12: Determine and assign the task owner and projected 
completion date to take actions.

• Step 13: Determine the new severity rating if the actions are taken.

• Step 14: Determine the new occurrence rating if the actions are taken.

• Step 15: Determine the new detection rating if the actions are taken.

• Step 16: Update the RPN based on new severity, occurrence, and 
detection ratings.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

307



www.ABTU.edu

FMEA Example

Case study: 

• Joe is trying to identify, analyze, and eliminate the failure modes he 

experienced in the past when preparing his work bag before heading to 

the office every morning. He decides to run an FMEA for his process of 

work bag preparation.

• There are only two steps involved in the process.

• Putting the work files in the bag

• Putting a water bottle in the bag.
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FMEA Example

• Step 1: List the critical functions of the process based on the process map created.

• Step 2: List all the potential failure modes for each function.

• Step 3: List potential failure effects that might affect the process.
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FMEA Example

• Step 4: List all possible causes to the failure mode.

• Step 5: List any control procedures for each failure mode.

• Step 6: Determine the severity rating for each failure mode. 

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

310



www.ABTU.edu

FMEA Example

• Step 7: Determine the occurrence rating for each failure cause.

• Step 8: Determine the detection rating for each control.

• Step 9: Calculate the RPN (Risk Prioritization Number).
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FMEA Example

• Step 10: Rank the failures using the RPN and determine the precedence of problems 

or critical inputs of process. 

• Step 11: Brainstorm and create recommended action plans.

• Step 12: Determine and assign owners with completion dates.
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FMEA Example

• Steps 13-15: Determine new severity, occurrence and detection ratings if actions are 

taken.

• Step 16: Update RPN based on new ratings.
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2.1.5 Theory of Constraints
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What is the Theory of Constraints?

• Processes, systems, and organizations are vulnerable to their weakest 

part.

• Any manageable system is limited by constraints in its ability to 

produce more (and there is always at least one constraint).
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Performance Measures

Making sound financial decisions based on these three measures is a 

critical requirement.

• Throughput – rate at which a system generates money through sales.

• Operational Expense – money spent by the system to turn inventory 

into throughput.

• Inventory – money the system has invested in purchasing things it 

intends to sell.
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Five Focusing Steps

Objective: To ensure ongoing improvement 

efforts are focused on the constraints of 

a system.

1. Identify the system’s constraint(s).

2. Decide how to exploit the constraint(s).

3. Subordinate everything else to the decision in step 2.

4. Elevate the constraint(s).

5. If in previous steps a constraint has been broken, return to step 1, but 

do not allow inertia to cause a system’s constraint.
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Logical Thinking Processes

Focusing Step Thinking Process Tools

Identify the system’s 

constraint(s)

• Identify the problems

• Find the root causes
Cause and effect diagram

Decide how to exploit 

the constraint(s)
• Develop a solution Future reality tree

Subordinate everything 

else to the decision in 

step 2

• Identify the conflict 

preventing the solution

• Remove the conflict

Evaporating cloud

Elevate the constraint
• Construct and execute an 

implementation plan

Prerequisite tree

Transition tree

If in previous steps a constraint has been broken, return to step 1, but do not allow inertia to 

cause a system’s constraint

1

2

3

4

5
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Simulation Exercise

Resources needed:

• 3 “production line” participants

• 1 timer per each “production line” participant

• 5 small boxes of 15 widgets each (paperclips, pens/pencils, candy, 

etc.)

Widget Value Chain:

Get box of 

widgets and 

empty it

Count widgets 

and fill box

Return box to 

instructor

Participant 1 Participant 2 Participant 3
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Simulation Exercise

Widget Value Chain:

Get box of 

widgets and 

empty it

Count widgets 

and fill box

Return box to 

instructor

Participant 1 Participant 2 Participant 3

Five focusing steps:

1. Identify the system’s constraint(s).

2. Decide how to exploit the constraint(s). Quick improvements. Use what you have.

3. Subordinate everything else to the decision in step 2.

4. Elevate the constraint(s). If more improvement is needed, what actions are required?

5. If in previous steps a constraint has been broken, return to step 1, but do not allow inertia to 

cause a system’s constraint.
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2.2 Six Sigma Statistics
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Black Belt Training: Measure Phase

2.1 Process Definition

2.1.1 Cause and Effect Diagrams

2.1.2 Cause and Effects Matrix

2.1.3 Process Mapping

2.1.4 FMEA: Failure Modes & Effects Analysis

2.1.5 Theory of Constraints

2.2 Six Sigma Statistics

2.2.1 Basic Statistics

2.2.2 Descriptive Statistics

2.2.3 Distributions and Normality

2.2.4 Graphical Analysis

2.3 Measurement System Analysis

2.3.1 Precision and Accuracy

2.3.2 Bias, Linearity, and Stability

2.3.3 Gage R&R

2.3.4 Variable and Attribute MSA

2.4 Process Capability

2.4.1 Capability Analysis

2.4.2 Concept of Stability

2.4.3 Attribute and Discrete Capability

2.4.4 Monitoring Techniques
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2.2.1 Basic Statistics

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

323



www.ABTU.edu

What is Statistics?

• Statistics is the science of collection, analysis, interpretation, and 

presentation of data.

• In Six Sigma, we apply statistical methods and principles to 

quantitatively measure and analyze the process performance to reach 

statistical conclusions and help solve business problems.
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Types of Statistics

• Descriptive Statistics

• Describing what was going on

• Inferential Statistics

• Making inferences from the data at hand to more general conditions L
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Descriptive Statistics

• Descriptive statistics is applied to describe the main characteristics of 

a collection of data.

• Descriptive statistics summarizes the features of the data 

quantitatively.

• Descriptive statistics is descriptive only and it does not make any 

generalizations beyond the data at hand.

• The data used for descriptive statistics are for the purpose of 

representing or reporting.
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Inferential Statistics

• Inferential statistics is applied to infer the characteristics or 

relationships of the populations from which the data are collected.

• Inferential statistics draws statistical conclusions about the population 

by analyzing the sample data subject to random variation.

• A complete data analysis includes both descriptive statistics and 

inferential statistics.
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Statistics vs. Parameters

• The word statistic refers to a numeric measurement calculated using a 

sample data set, for example, sample mean or sample standard 

deviation. Its plural is statistics (the same spelling as “statistics” which 

refers to the scientific discipline).

• The parameter refers to a numeric metric describing the population, for 

example, population mean and population standard deviation. Unless 

you have the full data set of the population, you will not be able to know 

the population parameters.
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Continuous Variable vs. Discrete Variable

• Continuous Variable

• Measured

• There is an infinite number of values possible

• Examples: temperature, height, weight, money, time

• Discrete Variable

• Counted

• There is a finite number of values available

• Examples: count of people, count of countries, count of defects, count of 

defectives

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

329



www.ABTU.edu

Types of Data

• Nominal

• Categorical data

• Examples: a set of colors, the social security number

• Ordinal

• Rank-ordering data

• Examples: the first, second place in a race, scores of exams

• Interval

• Equidistant data

• Examples: temperature with Fahrenheit or Celsius scale

• Ratio

• The ratio between the magnitude of a continuous value and the unit value 

of the same category

• Examples: weight, length, time
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2.2.2 Descriptive Statistics
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Basics of Descriptive Statistics

• Descriptive statistics provides a quantitative summary for the data 

collected.

• It summarizes the main features of the collection of data.

• Shape

• Location

• Spread

• It is a presentation of data collected and it does not provide any 

inferences about a more general condition.
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Shape of the Data 

• Distribution is used to describe the shape of the data.

• Distribution (also called frequency distribution) summarizes the 

frequency of an individual value or a range of values of a variable 

(either continuous or discrete).

• Distribution is depicted as a table or graph.
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Shape of the Data

• Simple example of distribution

• We are tossing a fair die. The possible value we obtain from each tossing is 

a value between 1 and 6.

• Each value between 1 and 6 has a 1/6 chance to be hit for each tossing.

• The distribution of this game describes the relationship between every 

possible value and the percentage of times the value is being hit (or count 

of times the value is being hit).
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Shape of the Data

• Examples of continuous distribution

• Normal Distribution

• T distribution

• Chi-square distribution

• F distribution

• Examples of discrete distribution

• Binomial distribution

• Poisson distribution
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Location of the Data

• The location (i.e. central tendency) of the data describes the value 

where the data tend to cluster around.

• There are multiple measurements to capture the location of the data:

• Mean

• Median

• Mode.
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Mean

• The mean is the arithmetic average of a data set.

n is the number of values in the data set

• For example, we have a set of data: 2, 3, 5, 8, 5, and 9. The arithmetic 

mean of the data set is


=

=
n

i

ix
n

x
1

1

33.5
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958532
=
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Median

• The median is the middle value of the data set in numeric order.

• It separates the finite set of data into two parts: one with values higher 

that the median and the other with values lower than the median.

• For example, we have a set of data: 45, 32, 67, 12, 37, 54, and 28. The 

median is 37 since it is the middle value of the sorted list of values (i.e., 

12, 28, 32, 37, 45, 54, and 67).
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Mode

• The mode is the value that occurs most often in the data set.

• If no number is repeated, there is no mode for the data set.

• For example, we have a data set: 55, 23, 45, 45, 68, 34, 45, 55. The 

mode is 45 since it occurs most frequently.
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Spread of the Data

• The spread (i.e. variation) of the data describes the degree of data 

dispersing around the center value.

• There are multiple measurements to capture the spread of the data:

• Range

• Variance

• Standard Deviation.
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Range

• The range is the numeric difference between the greatest and smallest 

values in a data set.

• Only two data values (i.e., the greatest and the smallest values) are 

accounted for calculating the range.

• For example, we have a set of data: 34, 45, 23, 12, 32, 78, and 23. The 

range of the data is 78−12 = 66.
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Variance

• The variance measures how far on average the data points spread out 

from the mean.

• It is the average squared deviation of each value from its mean.

• It is the square of the sample standard deviation.

• All the data points are accounted for calculating the variance.
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Standard Deviation

• Standard deviation describes how far the data points spread away 

from the mean.

• It has the same measurement units as the data itself.

• It is simply the square root of the variance.

• All the data points are accounted for calculating the standard deviation.
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2.2.3 Normal Distribution & Normality
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What is Normal Distribution?

• The normal distribution is a probability distribution of a continuous 

random variable whose values spread symmetrically around the mean.

• A normal distribution can be completely described by using its mean 

(μ) and variance (σ2).

• When a variable x is normally distributed, we denote x ~ N(μ, σ2).
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Z Distribution

• The Z distribution is the simplest normal distribution with the mean 

equal to zero and the variance equal to one.

• Any normal distribution can be transferred to a Z distribution by 

applying

s

−
=

x
z

where

( )2,~ sNx 0s
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Z Score

• The Z Score is the measure of how many standard deviations an 

observation is above or below the mean. 

• Positive Z Scores indicate the observation is above the mean or “right 

of the mean”.

• Negative Z Scores indicate the observation is below the mean of “left of 

the mean”

• Calculate Z Score using the formula below:

s

−
=

x
z

where
x is the observation

μ is the mean of the population

σ is the standard deviation of the population

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

347



www.ABTU.edu

Shape of Normal Distribution

• The probability density function curve of normal distribution is bell-

shaped.

• Probability density function of normal distribution
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Location of Normal Distribution

• If a variable is normally distributed, the mean, the median, and the 

mode have the same value.

• The probability density curve of normal distribution is symmetric around 

a center value which is the mean, the median, and the mode at the 

same time.
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Spread of Normal Distribution

• The spread or variation of the normally-distributed data can be 

described using the variance or the standard deviation.

• The smaller the variance or the standard deviation, the less variability 

in the data set. L
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Empirical Rule

• The 68-95-99.7 rule or the empirical rule in statistics states that for a 

normal distribution:

• About 68% of the data fall within one standard deviation of the mean

• About 95% of the data fall within two standard deviations of the mean

• About 99.7% of the data fall within three standard deviations of the mean.
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Empirical Rule (68-95-99.7 Rule)

Image Attribution: Pearson Education Inc.
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Normality

• Not all the distributions with a bell shape are normal distributions.

• To check whether a group of data points are normally distributed, we 

need to run a normality test.

• There are different normality tests available:

• Anderson-Darling test

• Sharpiro-Wilk test

• Jarque-Bera test.

• More details of normality test will be introduced in the Analyze module.
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Normality Testing

• To check whether the population of our interest is normally distributed, 

we need to run normality test.

• Null Hypothesis (H0): The data points are normally distributed.

• Alternative Hypothesis (Ha): The data points are not normally distributed.

• There are many normality tests available. For example, Anderson-

Darling test, Sharpiro-Wilk test, Jarque-Bera test, and so on.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

354



www.ABTU.edu

Use Minitab to Run a Normality Test

• Case study: we are interested to know whether the height of 

basketball players is normally distributed.

• Data File: “One Sample T-Test” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): the height of basketball players is normally 

distributed.

• Alternative Hypothesis (Ha): the height of basketball players is not 

normally distributed.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

355



www.ABTU.edu

Use Minitab to Run a Normality Test

• Steps to run a normality test in Minitab

1) Click Stat → Basic Statistics → Normality Test.

2) A new window named “Normality Test” pops up.

3) Select “HtBk” as the “Variable.”

4) Click “OK.”

5) The normality test results appear in the new window.
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Use Minitab to Run a Normality Test
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Use Minitab to Run a Normality Test

• Null Hypothesis (H0): The 

data are normally 

distributed.

• Alternative Hypothesis (Ha): 

The data are not normally 

distributed.

• Since the p-value of the 

normality is 0.275 greater 

than alpha level (0.05), we 

fail to reject the null and 

claim that the data are 

normally distributed. 
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2.2.4 Graphical Analysis
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What is Graphical Analysis?

• In statistics, graphical analysis is a method to visualize the 

quantitative data.

• Graphical analysis is used to discover the structure and patterns in the 

data, explaining and presenting the statistical conclusions.

• A complete statistical analysis includes both quantitative analysis and 

graphical analysis.
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Graphical Analysis Example

• There are various graphical analysis tools available. Here are four most 

commonly used examples:

• Box Plot

• Histogram

• Scatter Plot

• Run Chart.
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Box Plot

• A box plot is a graphical method to summarize a data set by 

visualizing the minimum value, 25th percentile, median, 75th percentile, 

the maximum value, and potential outliers.

• A percentile is the value below which a certain percentage of data fall. 

For example, if 75% of the observations have values lower than 685 in 

a data set, then 685 is the 75th percentile of the data.
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Box Plot

Interquartile Range = 75th Percentile – 25th Percentile

25th Percentile 

(Q1)

75th Percentile

(Q3)

Median

(Q2)

Interquartile Range

(IQR)

Minimum (Minimum Value in the Data, Q1 – I.5*IQR) Maximum (Maximum Value in the Data, Q3 + I.5*IQR)

Minimum Value in the Data Maximum Value in the Data

Potential Outliers Potential Outliers
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How to Use Minitab to Generate a Box Plot 

• Data File: “Box Plot” tab in “Sample Data.xlsx”

• Steps to render a Box Plot in Minitab

1) Click Graph → Boxplot.

2) A new window named “Boxplots” pops up.

3) Click “OK” in the window “Boxplots.”

4) Another new window named “Boxplot – One Y, Simple” pops up.

5) Select “HtBk” as the “Graph Variables.”

6) Click the “Data View” button and a new window named “Boxplot – Data View” 
pops up.

7) Check the boxes “Median symbol” and “Mean symbol.”

8) Click “OK” in the window “Boxplot – Data View.”

9) Click “OK” in the window “Boxplot – One Y, Simple.”

10) The box plot appears automatically in the new window.
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How to Use Minitab to Generate a Box Plot 
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How to Use Minitab to Generate a Box Plot 

25th Percentile (Q1)

75th Percentile (Q3)
Median (Q2)

Mean
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Histogram

• A histogram is a graphical tool to present the distribution of the data.

• The X axis represents the possible values of the variable and the Y 

axis represents the frequency of the value occurring.

• A histogram consists of adjacent rectangles erected over intervals with 

heights equal to the frequency density of the interval. 

• The total area of all the rectangles in a histogram is the number of data 

values.
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Histogram

• A histogram can also be normalized. In this case, the X axis still 

represents the possible values of the variable, but the Y axis 

represents the percentage of observations that fall into each interval on 

the X axis.

• The total area of all the rectangles in a normalized histogram is 1.

• With the histogram, we have a better understanding of the shape, 

location, and spread of the data.
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Histogram

Histogram with frequency 

(count) as the Y axis

Normalized histogram with 

proportion (probability) as the Y axis
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How to Use Minitab to Generate a Histogram

• Data File: “Histogram” tab in “Sample Data.xlsx”

• Steps to render a histogram in Minitab

1) Click Stat → Basic Statistics → Graphical Summary.

2) A new window named “Graphical Summary” pops up.

3) Select “HtBk” as the “Variables.”

4) Click “OK.”

5) The histogram appears in the new window.
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How to Use Minitab to Generate a Histogram
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How to Use Minitab to Generate a Histogram
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Scatter Plot

• A scatter plot is a diagram to present the relationship between two 

variables of a data set.

• A scatter plot consists of a set of data points. 

• On the scatter plot, a single observation is presented by a data point 

with its horizontal position equal to the value of one variable and its 

vertical position equal to the value of the other variable.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

373



www.ABTU.edu

Scatter Plot

• A scatter plot helps to understand:

• Whether the two variables are related to each other or not

• How is the strength of their relationship

• What is the shape of their relationship

• What is the direction of their relationship

• Whether outliers are present.
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How to Use Minitab to Generate a Scatter Plot

• Data File: “Scatter Plot” tab in “Sample Data.xlsx”

• Steps to render a histogram in Minitab:

1) Click Graph → Scatterplot.

2) A new window named “Scatterplots” pops up.

3) Click “OK” in the window “Scatterplots” and another window named “Scatterplot –

Simple” pops up.

4) Select “MPG” as the “Y variables.”

5) Select “weight” as the “X variables.”

6) Click “OK.”

7) The scatter plot appears in the new window.
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How to Use Minitab to Generate a Scatter Plot
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How to Use Minitab to Generate a Scatter Plot
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Run Chart

• A run chart is a chart used to present the data in time order. It 

captures the process performance over time.

• The X axis of the run chart indicates the time and the Y axis indicates 

the observed values.

• Run chart looks similar to control charts except that a run chart does 

not have control limits plotted. It is easier to produce a run chart than a 

control chart.

• It is often used to identify the anomalies in the data and discover the 

pattern of data changing over time.
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How to Plot a Run Chart in Minitab

• Steps to plot a run chart in Minitab:

1) Data File: “Run Chart” tab in “Sample Data.xlsx.”

2) Click Stat → Quality Tools → Run Chart.

3) A new window named “Run Chart” pops up.

4) Select “Measurement” as the “Single Column.”

5) Enter “1” as the “Subgroup Size.”

6) Click “OK.”

7) The run chart appears automatically in the new window.
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How to Plot a Run Chart in Minitab
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How to Plot a Run Chart in Minitab

• Run charts are used to 

identify the trend, cycle, 

seasonal pattern, or 

abnormality in the data.

• The time series in this 

chart appears stable. 

• There are no extreme 

outliers, trending or 

seasonal patterns.
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Run Chart Example

• Following the previous 

“Run Chart” instructions, 

create a new chart using 

the data listed in the 

column “Cycle” in the 

“Run Chart” tab of 

“Sample Data.xlsx.”

• Notice the repeating 

pattern of the data. This 

could suggest 

something cyclical or 

seasonal.
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Run Chart Example

• Create another run chart 

using the data listed in 

column “Trend” in the 

“Run Chart” tab of 

“Sample Data.xlsx.”

• Notice the trending 

pattern represented by the 

data points successively 

declining.
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2.3 MSA (Measurement System Analysis)
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Black Belt Training: Measure Phase

2.1 Process Definition

2.1.1 Cause and Effect Diagrams

2.1.2 Cause and Effects Matrix

2.1.3 Process Mapping

2.1.4 FMEA: Failure Modes & Effects Analysis

2.1.5 Theory of Constraints

2.2 Six Sigma Statistics

2.2.1 Basic Statistics

2.2.2 Descriptive Statistics

2.2.3 Distributions and Normality

2.2.4 Graphical Analysis

2.3 Measurement System Analysis

2.3.1 Precision and Accuracy

2.3.2 Bias, Linearity, and Stability

2.3.3 Gage R&R

2.3.4 Variable and Attribute MSA

2.4 Process Capability

2.4.1 Capability Analysis

2.4.2 Concept of Stability

2.4.3 Attribute and Discrete Capability

2.4.4 Monitoring Techniques
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2.3.1 Precision and Accuracy
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What is Measurement System Analysis

• Measurement System Analysis (MSA) is a systematic method to 

identify and analyze the variation components in the measurement.

• It is a mandatory step in any Six Sigma project to ensure the data are 

reliable before making any data-based decisions.

• The MSA is the check point of data quality before we start any further 

analysis and draw any conclusions from the data.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

387



www.ABTU.edu

Data-Based Analysis

• Here are some examples of data-based analysis where MSA is the 

prerequisite:

• Correlation analysis

• Regression analysis

• Hypothesis testing

• Analysis of variance

• Design of experiments

• Multivariate analysis

• Statistical process control.
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Measurement System

• A measurement system is a process to obtain data.

• Y (output of the measurement system)

• Observed values

• X’s (inputs of the measurement system)

• True values

• Measurement errors

Measurement

System
Inputs (Xs) Output (Y)
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Measurement Errors

Observed Value = True Value + Measurement Error

• True Value

• The actual value we are interested to measure

• It reflects the true performance of the process we are measuring

• Measurement Error

• The errors brought in by measurement system

• Observed Value

• The observed/measured value obtained by the measurement system
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Measurement Errors

• Types of Observed Values:

• Continuous measurements

• Weight

• Height

• Money

• Discrete measurements

• Red/Yellow/Green

• Yes/No

• Ratings of 1–10

• A variable MSA is designed for continuous measurements and an 

attribute MSA is for discrete measurements.
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Measurement Errors

• Sources of measurement errors:

• Human

• Environment

• Equipment

• Sample

• Process

• Material

• Method.

• Fishbone diagrams can help to brainstorm the potential factors 

affecting the measurement system.
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Measurement Errors

• The more errors the measurement system brings in, the less reliable 

the observed values are.

• A valid measurement system brings in minimum amount of 

measurement errors.

• The goal of MSA is to qualify the measurement system by 

quantitatively analyzing its characteristics.
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Characteristics of a Measurement System

• Any measurement systems can be characterized by two aspects:

• Accuracy (location related)

• Precision (variation related).

• A valid measurement system is both accurate and precise. 

• Being accurate does not guarantee the measurement system is precise.

• Being precise does not guarantee the measurement system is accurate.
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Accuracy vs. Precision

• Accuracy:

• The level of closeness between the average observed value and the true 

value

• How well the observed value reflects the true value.

• Precision:

• The spread of measurement values

• How consistent the repeated measurements deliver the same values under 

the same circumstances.
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Accuracy vs. Precision

• Accurate and precise 

• high accuracy and high precision
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Accuracy vs. Precision

• Accurate and not precise

• high accuracy and low precision
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Accuracy vs. Precision

• Precise and not accurate 

• high precision and low accuracy
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Accuracy vs. Precision

• Not accurate and not precise 

• low accuracy and low precision
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MSA Conclusions

• If the measurement system is considered both accurate and precise, 

we can start the data-based analysis or decision making.

• If the measurement system is either not accurate or not precise, we 

need to identify the factor(s) affecting it and calibrate the measurement 

system until it is both accurate and precise.
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Stratification of Accuracy and Precision

• Accuracy

• Bias

• Linearity

• Stability

• Precision

• Repeatability

• Reproducibility
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2.3.2 Bias, Linearity and Stability
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Bias

• Bias is the difference between the observed value and the true value 

of a parameter or metric being measured.

• It is calculated by subtracting the reference value from the average 

value of the measurements.

Bias = Grand Mean – Reference Value

where the reference value is a standard agreed upon
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Bias

Average of the measurementsReference value

Distribution of measurements

Bias

• The closer the average of all measurements is to the reference level, the smaller the bias.

• The reference level is the average of measurements of the same items using the master 

or standard instrument.
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Bias

• To determine whether the difference between the average of observed 

measurement and the reference value is statistically significant (we will 

explain more details about statistical significance in the Analyze 

module), we can either conduct a hypothesis testing or compare the 

reference value against the confidence intervals of the average 

measurements.

• If the reference value falls into the confidence intervals, the bias is not 

statistically significant and can be ignored. Otherwise, the bias is 

statistically significant and must be fixed.
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Bias

• Potential causes of bias:

• Errors in measuring the reference value

• Lack of proper training for appraisers

• Damaged equipment or instrument

• Measurement instrument not calibrated precisely

• Appraisers read the data incorrectly.
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Linearity

• Linearity is the degree of the consistency of bias over the entire 

expected measurement range.

• It quantifies how the bias changes over the range of measurement.

• For example, a scale is off by 0.01 pounds when measuring an object 

of 10 pounds. However, it is off by 10 pounds when measuring an 

object of 100 pounds. The scale’s bias is not linear.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

407



www.ABTU.edu

Linearity
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Linearity

• Create a scatter plot for bias (Y-axis) and reference level (X-axis).

• Find a best fit linear regression line and compute the slope of the line.

• The closer the slope is to zero, the better the measurement system 

performs. 
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Linearity

• Formula of the linearity of a measurement system:

Linearity = |Slope| × Process Variation

where
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1

xi is the reference value;

yi is the bias at each reference level;

n is the sample size.
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Linearity

• Potential causes of linearity:

• Errors in measuring the lower end or higher end of the reference value

• Lack of proper training for appraisers

• Damaged equipment or instrument

• Measurement instrument not calibrated correctly at the lower or higher end 

of the measurement scale

• Innate nature of the instrument.
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Stability

• Stability is the consistency level needed to obtain the same values 

when measuring the same objects over an extended period of time.

• A measurement system that has low bias and linearity close to zero but 

cannot consistently perform well would not deliver reliable data.

• Stability is evaluated using control charts.
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Stability

Bias

BiasT
im

e
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Stability

• Control charts are used 

to evaluate the stability 

of a measurement 

system.

• When there are no data 

points out of control, the 

measurement system is 

considered stable.
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Stability

• Potential causes of instability:

• Inconsistent training for appraisers

• Damaged equipment or instrument

• Worn equipment or instrument

• Measurement instrument not calibrated

• Appraisers do not follow the procedure consistently.
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2.3.3 Gage R&R
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Repeatability 

• Repeatability evaluates whether the same appraiser can obtain the 

same value multiple times when measuring the same object using the 

same equipment under the same environment.

• It refers to the level of agreement between the repeated measurements 

of the same appraiser under the same condition.

• Repeatability measures the inherent variation of the measurement 

instrument.
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Reproducibility

• Reproducibility evaluates whether different appraisers can obtain the 

same value when measuring the same object independently.

• It refers to the level of agreement between different appraisers.

• It is not caused by the inherent variation of the measurement 

instrument. It reflects the variability caused by different appraisers, 

locations, gauges, environments etc.
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Gauge R&R

• Gauge R&R (i.e. Gauge Repeatability & Reproducibility) is a method to 

analyze the variability of a measurement system by partitioning the 

variation of the measurements using ANOVA (Analysis of Variance).

• Gauge R&R only addresses the precision of a measurement system. L
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Gauge R&R

• Data collection of a gauge R&R study:

• let k appraisers measure n random samples independently and repeat the 

process p times.

• Different appraisers perform the measurement independently.

• The order of measurement (e.g., sequence of samples and sequence 

of appraisers) is randomized.
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Gauge R&R

• The potential sources of variance in the measurement:

• Appraisers:

• Parts: 

• Appraisers × Parts:

• Repeatability:

• Variance Components

2

appraiserss
2

partss
2

partsappraiserss
2

ityrepeatabils

22222

ityrepeatabilpartsappraiserspartsappraiserstotal sssss +++= 
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Gauge R&R

• A valid measurement system has low variability in both repeatability 

and reproducibility so that the total variability observed can reflect the 

true variability in the objects (parts) being measured.

• Gauge R&R variance reflects the precision level of the measurement 

system.

222

partsappraisersappraisersilityreproducib += sss

2222

partsityrepeatabililityreproducibtotal ssss ++=

where

222

& ilityreproducibityrepeatabilRR sss +=
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Gauge R&R

• Variation Components

totaltotal ZVariation s= 0

ityrepeatabilityrepeatabil ZVariation s= 0

ilityreproducibilityreproducib ZVariation s= 0

partsparts ZVariation s= 0

where

2222

partsityrepeatabililityreproducibtotal ssss ++=

Z0 is a sigma multiplier that assumes a specific confidence level in the spread of the data. 
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Gauge R&R

• The percentage of variation R&R contributes to the total variation in the 

measurement:

%100% &
& =

total

RR
RR

Variation

Variation
onContributi

where
22

0& ilityreproducibityrepeatabilRR ZVariation ss +=

Measurement System % Study Var. % Contribution Distinct Categories

Acceptable 10% or less 1% or Less 5 or Greater

Marginal 10% - 30% 1% - 9%

Unacceptable 30% or Greater 9% or Greater Less than 5
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2.3.4 Variable and Attribute MSA
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Variable Gage R&R

• Whenever something is measured repeatedly or by different people or 

processes, the results of the measurements will vary. Variation comes 

from two primary sources: 

1. Differences between the parts being measured

2. The measurement system.

• We can use a gage R&R to conduct a measurement system analysis 

to determine what portion of the variability comes from the parts and 

what portion comes from the measurement system.

• There are key study results that help us determine the components of 

variation within our measurement system. 
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Key Measures of a Variable Gage R&R

• %Contribution: The percent of contribution for a source is 100 times the 
variance component for that source divided by the total variance.

• %Study Var (6*SD): The percent of study variation for a source is 100 
times the study variation for that source divided by the total variation. 

• %Tolerance (SV/Tolerance): The percent of spec range taken up by 
the total width of the distribution of the data based on variation from 
that source.

• Distinct Categories: The number of distinct categories of parts that the 
measurement system is able to distinguish. If a measurement system 
is not capable of distinguishing at least five types of parts, it is probably 
not adequate.
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Variable Gage R&R Guidelines (AIAG)

• Percent Tolerance and Percent Study Variation

• 10% or less – Acceptable

• 10% to 30% – Marginal

• 30% or greater – Unacceptable

• Percent Contribution

• 1% or less – Acceptable

• 1% to 9% – Marginal

• 9% or greater – Unacceptable

• Distinct Categories

• Look for five or more distinct categories to indicate that your measurement 

system is acceptable. 
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Guidelines for Distinct Categories

• Distinct categories is the number of categories of parts that your 

measurement system can distinguish. If it is below five, it is likely not 

able to distinguish between parts. 

Number of Categories Conclusion

Distinct Categories = 1
Measurement system cannot 

discriminate between parts

Distinct Categories = 2
Measurement system can only 

distinguish between high/low or 

big/small

Distinct Categories = 3 or 4
Measurement system is of little or 

no value

Distinct Categories = 5+
According to AIAG, the 

measurement system can 

acceptably discriminate parts
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Use Minitab to Implement a Variable MSA 

• Data File: “Variable MSA” tab in “Sample Data.xlsx”

• Step 1: Initiate the MSA study

1) Click on Stat → Quality Tools → Gage Study → Create Gage R&R Study Worksheet.

2) A new window named “Create Gage R&R Study Worksheet” pops up.

3) Select 10 as the “Number of Parts.”

4) Select 3 as the “Number of Operators.”

5) Select 3 as the “Number of Replicates.”

6) Enter the part name (e.g., Part 01, Part 02, Part 03, …).

7) Enter the operator name (e.g., Operator A, Operator B, Operator C).

8) Click on the “Options” button and another window named “Create Gage R&R Study 
Worksheet – Options” pops up.

9) Select the radio button “Do not randomize.”

10) Click “OK” in the window “Create Gage R&R Study Worksheet – Options.”

11) Click “OK’ in the window “Create Gage R&R Study Worksheet.”

12) A new data table is generated.
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Use Minitab to Implement a Variable MSA 
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Use Minitab to Implement a Variable MSA

• Step 2: Data collection

• In the newly-generated data table, Minitab 
has provided the data layout where we 
can add our actual measurement data 
when it’s collected.

• When you actually conduct a variable 
MSA in your work environment it would be 
necessary to set up your study just as we 
have in the previous steps and then you 
could collect your measurement data 
properly.

• However, for our purposes today, we have 
provided you with an MSA that is setup 
and data collected. We will use our 
“Variable MSA” tab in “Sample Data.xlsx,” 
for the next steps.

Your data collection plan is now setup 

for your variable MSA. In real life you 

would collect your measurement data 

adding it to this table.

For our purposes today, we have 

provided you with that data so that we 

can continue learning how to perform a 

variable MSA.
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Use Minitab to Implement a Variable MSA

• Step 4: Implement Gauge R&R (using our “Variable MSA” data in “Sample Data.xlsx)

1) Click Stat → Quality Tools → Gage Study → Gage R&R Study (Crossed).

2) A new window named “Gage R&R Study (Crossed)” appears.

3) Select “Part” as “Part numbers.”

4) Select “Operator” as “Operators.”

5) Select “Measurement” as “Measurement data.”

6) Click on the “Options” button and another new window named “Gage R&R 

Study (Crossed) – ANOVA Options” pops up.

7) Enter 5.15 as the “Study variation (number of standard deviations)”.

8) Click “OK” in the window “Gage R&R Study (Crossed) – ANOVA Options.”

9) Click “OK” in the window “Gage R&R Study (Crossed).”

10) The MSA analysis results appear in the new window and the session window.
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Use Minitab to Implement a Variable MSA
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Use Minitab to Implement a Variable MSA

• 5.15 is the recommended standard deviation multiplier by the 

Automotive Industry Action Group (AIAG). It corresponds to 99% of 

data in the normal distribution. If we use 6 as the standard deviation 

multiplier, it corresponds to 99.73% of the data in the normal 

distribution.

Confidence Level Sigma Multiplier

90% 3.29

95% 3.92

99% 5.15

99.73% 6
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Use Minitab to Implement a Variable MSA

• Step 5: Analyze the MSA results

• The percentage of variation that 

R&R contributes to the total 

variation is 27.86% and the 

precision level of this 

measurement system is at best 

“marginal” bordering on 

unacceptable.

• Actions should be required to 

calibrate the measurement 

system.
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Use Minitab to Implement a Variable MSA
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Use Minitab to Implement an Attribute MSA

• Data File: “Attribute MSA” tab in “Sample Data.xlsx” (an example in the 

AIAG MSA Reference Manual, 3rd Edition).

• Steps in Minitab to run an attribute MSA
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Use Minitab to Implement an Attribute MSA

• Step 1: Reorganize the original data into four new columns (i.e., 
Appraiser, Assessed Result, Part, and Reference).

1) Click Data → Stack → Blocks of Columns.

2) A new window named “Stack Blocks of Columns” pops up.

3) Select “Appraiser A,” “Part,” and “Reference” as block one.

4) Select “Appraiser B,” “Part,” and “Reference” as block two.

5) Select “Appraiser C,” “Part,” and “Reference” as block three.

6) Select the radio button of “New worksheet” and name the sheet “Data.”

7) Check the box “Use variable names in subscript column.”

8) Click “OK.”

9) The stacked columns are created in the new worksheet named “Data.”

10) Name the four columns from left to right in worksheet “Data”: Appraiser, 
Assessed Result, Part, and Reference. 
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Use Minitab to Implement an Attribute MSA
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Use Minitab to Implement an Attribute MSA
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Use Minitab to Implement an Attribute MSA

• Step 2: Run MSA using Minitab

1) Click Stat → Quality Tools → Attribute Agreement Analysis.

2) A new window named “Attribute Agreement Analysis” pops up.

3) Click in the blank box next to “Attribute column” and the variables appear in the list box on 
the left.

4) Select “Assessed Result” as “Attribute column.”

5) Select “Part” as “Samples.”

6) Select “Appraiser” as “Appraisers.”

7) Select “Reference” as “Known standard/attribute.”

8) Click the “Options” button and another window named “Attribute Agreement Analysis –
Options” pops up.

9) Check the boxes of both “Calculate Cohen’s kappa if appropriate” and “Display 
disagreement table.”

10) Click “OK” in the window “Attribute Agreement Analysis – Options.”

11) Click “OK” in the window “Attribute Agreement Analysis.”

12) The MSA results appear in the newly-generated window and the session window.
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Use Minitab to Implement an Attribute MSA
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Use Minitab to Implement an Attribute MSA

Within Appraiser Agreement 

Percent: the agreement 

percentage within each 

individual appraiser.
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Use Minitab to Implement an Attribute MSA

Each Appraiser vs. Standard 

Agreement Percent: the 

agreement percentage 

between each appraiser and 

the standard. It reflects the 

accuracy of the measurement 

system.
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Use Minitab to Implement an Attribute MSA

Between Appraiser Agreement 

Percent: the agreement percentage 

between different appraisers.

All Appraisers vs. Standard Agreement 

Percent: overall agreement percentage 

of both within and between appraisers. It 

reflects how precise the measurement 

system performs.
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Use Minitab to Implement an Attribute MSA

• Kappa statistic is a coefficient indicating the agreement percentage 
above the expected agreement by chance. 

• Kappa ranges from -1 (perfect disagreement) to 1 (perfect agreement). 

• When the observed agreement is less than the chance agreement, 
Kappa is negative.

• When the observed agreement is greater than the chance agreement, 
Kappa is positive.

• Rule of thumb: If Kappa is greater than 0.7, the measurement system is 
acceptable. If Kappa is greater than 0.9, the measurement system is 
excellent.
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Use Minitab to Implement an Attribute MSA

Kappa statistic of 

the agreement 

within each 

appraiser

Kappa statistic of the 

agreement between 

individual appraiser and 

the standard
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Use Minitab to Implement an Attribute MSA

Kappa statistic of the 

agreement between 

appraisers. They are greater 

than 0.7 and acceptable.

Kappa statistic of the overall 

agreement between 

appraisers and the standard. 

Again, greater than 0.7 

suggests an acceptable 

measurement system.
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2.4 Process Capability
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Black Belt Training: Measure Phase

2.1 Process Definition

2.1.1 Cause and Effect Diagrams

2.1.2 Cause and Effects Matrix

2.1.3 Process Mapping

2.1.4 FMEA: Failure Modes & Effects Analysis

2.1.5 Theory of Constraints

2.2 Six Sigma Statistics

2.2.1 Basic Statistics

2.2.2 Descriptive Statistics

2.2.3 Distributions and Normality

2.2.4 Graphical Analysis

2.3 Measurement System Analysis

2.3.1 Precision and Accuracy

2.3.2 Bias, Linearity, and Stability

2.3.3 Gage R&R

2.3.4 Variable and Attribute MSA

2.4 Process Capability

2.4.1 Capability Analysis

2.4.2 Concept of Stability

2.4.3 Attribute and Discrete Capability

2.4.4 Monitoring Techniques
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2.4.1 Capability Analysis
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What is Process Capability?

• The process capability measures how well the process performs to 

meet given specified outcome.

• It indicates the conformance of a process to meet given requirements 

or specifications.

• Capability analysis helps to better understand the performance of the 

process with respect to meeting customer’s specifications and identify 

the process improvement opportunities.
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Process Capability Analysis Steps

• Step 1: Determine the metric or parameter to measure and analyze.

• Step 2: Collect the historical data for the parameter of interest.

• Step 3: Prove the process is statistically stable (i.e., in control).

• Step 4: Calculate the process capability indices.

• Step 5: Monitor the process and ensure it remains in control over time. 

Update the process capability indices if needed.
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Process Capability Indices

• Process capability can be presented using various indices depending 

on the nature of the process and the goal of the analysis.

• Popular process capability indices:

• Cp

• Pp

• Cpk

• Ppk

• Cpm
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Cp

• Cp stands for capability of the process.

within

p
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USL and LSL are the upper and lower specification limits.

n is the sample size.
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Cp

• Cp measures the process’ potential capability to meet the two-sided 

specifications.

• It does not take the process average into consideration.

• High Cp indicates the small spread of the process with respect to the 

spread of the customer specifications.

• Cp is recommended when the process is centered between the 

specification limits.

• Cp works when there are both upper and lower specification limits.
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Pp

• Pp stands for performance of the process.
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USL and LSL are the upper and lower specification limits.

n is the sample size.
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Pp

• Similar to Cp, Pp measures the capability of the process to meet the 

two-sided specifications.

• It only focuses on the spread and does not take the process 

centralization into consideration.

• It is recommended when the process is centered between the 

specification limits.

• Cp considers the within-subgroup standard deviation and Pp considers 

the total standard deviation from the sample data.

• Pp works when there are both upper and lower specification limits.
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Cpk

• Cpk stands for the capability of the process with a k factor adjustment.

ppk CkC −= )1(

where

2

LSLUSL

m
k

−

−
=



2

LSLUSL
m

+
=

μ is the process mean; n is the sample size.

USL and LSL are the upper and lower specification limits.
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Cpk

• The formulas to calculate Cpk can also be expressed as follows:
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
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USL and LSL are the upper and lower specification limits.
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Cpk

• Cpk measures the process’ actual capability by taking both the variation 

and average of the process into consideration.

• The process does not need to be centered between the specification 

limits to make the index meaningful.

• Cpk is recommended when the process is not in the center between the 

specification limits.

• When there is only a one-sided limit, Cpk is calculated using Cpu or Cpl.
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Cpk

• Cpk for upper specification limit:

• Cpk for lower specification limit:

within

pu

USL
C

s





−
=

3

within

pl

LSL
C

s





−
=

3

USL and LSL are the upper and lower specification limits.

μ is the process mean.
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Ppk

• Ppk stands for the performance of the process with a k factor 

adjustment.

ppk PkP −= )1(

where

2

LSLUSL

m
k

−

−
=



2

LSLUSL
m

+
=

USL and LSL are the upper and lower specification limits.

μ is the process mean.
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Ppk

• The formulas to calculate Ppk can also be expressed as follows:














−



−
=

overalloverall

pk

LSLUSL
P

s



s



3
,

3
min

)(4 nc

s
overall=s


−

−
=

i j

ij

n

xx
s

1

)( 2

)34(

)1(4
4

−

−
=

n

n
c

USL and LSL are the upper and lower specification limits.

μ is the process mean. n is the sample size.
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Ppk

• Similar to Cpk, Ppk measures the process capability by taking both the 

variation and the average of the process into consideration.

• Ppk solves the decentralization problem Pp cannot overcome.

• Cpk considers the within-subgroup standard deviation, while Ppk

considers the total standard deviation from the sample data.

• When there is only a one-sided specification limit, Ppk is calculated 

using Ppu or Ppl.
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Ppk

• Ppk for upper specification limit:

• Ppk for lower specification limit:

overall

pu

USL
P

s





−
=

3

overall

pl

LSL
P

s





−
=

3

USL and LSL are the upper and lower specification limits.
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Cpm

• Cp, Pp, Cpk, and Ppk all consider the variation of the process. Cpk and 

Ppk take both the variation and the average of the process into 

consideration when measuring the process capability.

• It is possible that the process average fails to meet the target 

customers require while the process still remains between the 

specification limits. Cpm (Taguchi’s capability index) helps to capture the 

variation from the specified target.
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Cpm

• Formula to calculate Cpm

22 )(3

),min(

Ts

TUSLLSLT
Cpm

−+

−−
=



USL and LSL are the upper and lower specification limits.

T is the specified target.

μ is the process mean.

Note: Cpm can work only if there is a target value specified.
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Interpreting Capability

• Interpreting the results of a capability analysis is very dependent upon the nature of 
the business, product and/or customer. The Automotive Industry Action Group 
(AIAG) suggests that:

• Pp and Ppk should be > 1.67

• Cp and Cpk should be > 1.33.

• The reality is that anything greater than 1.0 is a fairly capable process but your 
business needs to assess the costs vs. benefits of achieving capability greater 
than 1.67 or even higher. Below is a simple table for quick interpretation

• If you’re dealing with customer safety or life and death influences then obviously 
the product necessitates a capability greater than 2.0.

Index Value Interpretation Sigma Level

Cpk <1.0 Not Very Capable <3

Cpk 1.0-1.99 Capable 3-6

Cpk >2.0 Very Capable >6
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Use Minitab to Run a Process Capability Analysis

• Data File: “Capability Analysis” tab in “Sample Data.xlsx”

• Steps in Minitab to run a process capability analysis:

1) Click Stat → Basic Statistics → Normality Test.

2) A new window named “Normality Test” pops up.

3) Select “HtBk” as the variable and Click “OK.”

4) The histogram and the normality test results appear in the new window.

5) In this example, the p-value is 0.275, greater than the alpha level (0.05). We fail to reject the hypothesis and 

conclude that the data are normally distributed.

6) Click Stat → Quality Tools → Capability Analysis → Normal.

7) A new window named “Capability Analysis (Normal Distribution)” pops up.

8) Select “HtBk” as the single column and enter “1” as the subgroup size.

9) Enter “6” as the “Lower spec” and “7” as the “Upper spec”

10) Click “Options” button and another new window named “Capability Analysis (Normal Distribution) – Options” 

pops up.

11) Enter “6.5” as the target and click “OK.”

12) Click “OK” in the “Capability Analysis (Normal Distribution)” window. The capability analysis results are displayed.
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Use Minitab to Run a Process Capability Analysis
L

e
a

n
 S

ix
 S

ig
m

a
 T

ra
in

in
g

 -
M

T
B

©
 A

m
e

ric
a

n
 B

&
T

 U
n

iv
e

rs
ity

472



www.ABTU.edu

Use Minitab to Run a Process Capability Analysis
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Use Minitab to Run a Process Capability Analysis
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Use Minitab to Run a Process Capability Analysis

• If the p-value of the normality test is smaller than the alpha level (0.05), we 

reject the null hypothesis and conclude that the data are not normally 

distributed. In this case we run a non-normal analysis.

1) Click Stat → Quality Tools → Capability Analysis → Nonnormal

2) A new window named “Capability Analysis (Nonnormal Distribution)” pops up.

3) Select “HtBk” as the single column.

4) Enter “6” as the “Lower spec” and “7” as the “Upper spec.”

5) Click “Options” button and another new window named “Capability Analysis (Nonnormal 

Distribution) – Options” pops up.

6) Enter “6.5” as the target and click “OK.”

7) Click “OK” in the “Capability Analysis (Nonnormal Distribution)” window.

8) The capability analysis results appear in the new window.
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Use Minitab to Run a Process Capability Analysis
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Use Minitab to Run a Process Capability Analysis
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2.4.2 Concept of Stability
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What is Process Stability?

• A process is said to be stable when:

• the process is in control

• the future behavior of the process is predictable at least between some 

limits

• there is only random variation involved in the process.

• the causes of variation in the process are only due to chance or common 

causes

• there are not any trends, patterns, or outliers in the control chart of the 

process. 
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Root Causes of Variation in the Process

• Common Cause:

• Chance

• Random and anticipated

• Natural noise

• Inherent in the process

• Unable to be eliminated from the process.

• Special Cause:

• Assignable cause

• Unanticipated

• Unnatural pattern

• Signal of changes in the process

• Able to be eliminated from the process.
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Control Charts

• Control charts are the graphical tools to analyze the stability of a 

process.

• A control chart is used to identify the presence of potential special 

causes in the process and to determine whether the process is 

statistically in control.

• If the samples or calculations of samples are all in control, the process 

is stable and the data from the process can be used to predict the 

future performance of the process.
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Popular Control Charts

• I-MR Chart

• Xbar-R Chart

• Xbar-S Chart

• C Chart

• U Chart

• P Chart

• NP Chart

• EWMA Chart

• CUSUM Chart

Note: More details of the control charts will be introduced in the Control module.
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Process Stability vs. Process Capability

• Process stability indicates how stable a process performed in the past. 

• When the process is stable, we can use the data from the process to 
predict its future behavior.

• Process capability indicates how well a process performs with respect 
to meeting the customer’s specifications. 

• The process capability analysis is valid only if the process is 
statistically stable (i.e., in control, predictable).

• Being stable does not guarantee that the process is also capable. 
However, being stable is the prerequisite to determine whether a 
process is capable.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

483



www.ABTU.edu

2.4.3 Attribute & Discrete Capability
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Process Capability Analysis for Binomial Data

• If we are measuring the count of defectives in each sample set to 

assess the process performance of meeting the customer 

specifications, we use “%Defective” (percentage of items in the 

samples that are defective) as the process capability index.

overall

defectives

N

N
=%Defective

where Ndefectives is the total count of defectives in the samples 

and Noverall is the sum of all the sample sizes.
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Process Capability Analysis for Poisson Data

• If we are measuring the count of defects in each sample set to assess 

the process performance of meeting the customer specifications, we 

use Mean DPU (defects per unit of measurement) as the process 

capability index.

overall

defects

N

N
DPU =

where Ndefects is the total count of defects in the samples and 

Noverall is the sum of all the units in the samples.
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2.4.4 Monitoring Techniques
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Capability and Monitoring

• In the Measure phase of the project, process stability analysis and 

process capability analysis are used to baseline the performance of 

current process.

• A stable process means we can expect the same process capability in 

the future.

• In the Control phase of the project, process stability analysis and 

process capability analysis are combined to monitor whether the 

improved process is maintained consistently as expected.
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3.0 Analyze Phase
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Black Belt Training: Analyze Phase

3.1 Patterns of Variation

3.1.1 Multi-Vari Analysis

3.1.2 Classes of Distributions

3.2 Inferential Statistics

3.2.1 Understanding Inference

3.2.2 Sampling Techniques and Uses

3.2.3 Sample Size

3.2.4 Central Limit Theorem

3.3 Hypothesis Testing

3.3.1 Goals of Hypothesis Testing

3.3.2 Statistical Significance

3.3.3 Risk; Alpha and Beta

3.3.4 Types of Hypothesis Tests

3.4 Hypothesis Testing: Normal Data

3.4.1 One and Two Sample T-Tests

3.4.2 One sample variance

3.4.3 One Way ANOVA

3.5 Hypothesis Testing: Non-Normal Data

3.5.1 Mann-Whitney

3.5.2 Kruskal-Wallis

3.5.3 Moods Median

3.5.4 Friedman

3.5.5 One Sample Sign

3.5.6 One Sample Wilcoxon

3.5.7 One and Two Sample Proportion

3.5.8 Chi-Squared (Contingency Tables)

3.5.9 Test of Equal Variances
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3.1 Patterns of Variation
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Black Belt Training: Analyze Phase

3.1 Patterns of Variation

3.1.1 Multi-Vari Analysis

3.1.2 Classes of Distributions

3.2 Inferential Statistics

3.2.1 Understanding Inference

3.2.2 Sampling Techniques and Uses

3.2.3 Sample Size

3.2.4 Central Limit Theorem

3.3 Hypothesis Testing

3.3.1 Goals of Hypothesis Testing

3.3.2 Statistical Significance

3.3.3 Risk; Alpha and Beta

3.3.4 Types of Hypothesis Tests

3.4 Hypothesis Testing: Normal Data

3.4.1 One and Two Sample T-Tests

3.4.2 One sample variance

3.4.3 One Way ANOVA

3.5 Hypothesis Testing: Non-Normal Data

3.5.1 Mann-Whitney

3.5.2 Kruskal-Wallis

3.5.3 Moods Median

3.5.4 Friedman

3.5.5 One Sample Sign

3.5.6 One Sample Wilcoxon

3.5.7 One and Two Sample Proportion

3.5.8 Chi-Squared (Contingency Tables)

3.5.9 Test of Equal Variances
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3.1.1 Multi-Vari Analysis
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What is Multi-Vari Analysis?

• Multi-Vari analysis is a graphic-driven method to analyze the effects 

of categorical inputs on a continuous output.

• Y: continuous variable

• X’s: discrete categorical variables. One X may have multiple levels.

• It studies how the variation in the output changes across different 

inputs and helps us quantitatively determine the major source of 

variability in the output.

• Multi-Vari charts are used to visualize the source of variation. They 

work for both crossed and nested hierarchies.
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Hierarchy

• Hierarchy is a structure of objects in which the relationship of objects 

can be expressed similar to an organization tree. 

• Each object in the hierarchy is described as above, below, or at the 

same level as another one.

• If object A is above object B and they are directly connected to each other 

in the hierarchy tree, A is B’s parent and B is A’s child.

• In Multi-Vari analysis, we use the hierarchy to present the relationship 

between categorical factors (inputs). 

• Each object in the hierarchy tree indicates a specific level of a factor 

(input).

• There are generally two types of hierarchies: crossed and nested.
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Crossed Hierarchy

• In the hierarchy tree, if one child item has more than one parent item at 

the higher level, it is a crossed relationship.
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Nested Hierarchy

• In the hierarchy tree, if one child item only has one parent item at the 

higher level, it is a nested relationship.
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Use Minitab to Perform Multi-Vari Analysis

• Data File: “Multi-Vari” tab in “Sample Data.xlsx.”

• Case study: 

• ABC company produces 10 kinds of units with different weights. Operators 

measure the weights of the units before sending them out to customers.

• Multiple factors could have an impact on the weight measurements. The ABC 

company wants to have a better understanding of the main source of variability 

existing in the weight measurement.

• The ABC company randomly selects 3 operators (Joe, John, and Jack) each of 

whom measures the weights of 10 different units. For each unit, there are 3 

items sampled.
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Use Minitab to Perform Multi-Vari Analysis

• Step 1: 

1. Click Stat → Quality Tools → Multi-Vari Chart. 

• Step 2:

1. A window named “Multi-Vari Chart” pops up.

2. Select “Measurement” as the “Response,” “Unit” as “Factor 1,” and “Operator” 

as “Factor 2.”
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Use Minitab to Perform Multi-Vari Analysis
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Use Minitab to Perform Multi-Vari Analysis

• Step 3:

1) Click “Options” button.

2) A new window named “Multi-Vari Chart” appears.

3) Check the box of “Display individual data points.”

4) Click “OK.”

5) Click “OK again.”
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Use Minitab to Perform Multi-Vari Analysis

• Step 4:

1) A Multi-Vari chart is generated automatically.

2) Analyze the chart to determine the major source of the variation in the 

output.
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Interpreting Minitab’s Multi-Vari Analysis

• Here is the Multi-Vari chart. The blue lines connect all 

the mean measurements 

of individual units.

The maximum and minimum 

points present the range of 

measurements for each unit. 

The center point presents 

the mean measurement for 

each unit. 

The red dotted line 

connects the means of 

individual operators.
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Interpreting Minitab’s Multi-Vari Analysis

• Based on the Multi-Vari chart, the measurement of units range from 0.4 to 1.1.

• Joe’s and John’s mean measurements stay between 0.8 and 0.9. Jack’s mean 
is slightly lower than both Joe’s and John’s. 

• John has the worst variation when measuring the same kind of unit because 
John has the highest difference between the maximum and minimum bars for 
any kind of unit.

• By observing the black lines of three operators, it seems like all three operators’ 
measurements follow the same pattern. The operator-to-operator variability is 
not large.

• The unit-to-unit variability is large and it could be the main source of variation in 
measurements.
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3.1.2 Classes of Distribution
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What is Probability?

• Probability is the likelihood of an event occurring.

• The probability of event A occurring is written as P(A).

• Probability is a percentage between 0% and 100%. The higher the probability, the 

more likely the event will happen.

• When probability is equal to 0%, it indicates that the event will take place with no 

chance.

• When probability is equal to 100%, it indicates the event will definitely take place 

without any uncertainty.

• Example of probability: when tossing a coin, there is 50% chance that the head lands 

face up and 50% chance that the head lands face down.
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Probability Property

• The probability of event A not occurring:

To be, or not to be: that is the question.

William Shakespeare
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Probability Property

• The probability of event A OR B OR both events occurring:

• If event A and B are mutually exclusive: 

and 

)()()( BPAPBAP +=

)()()()( BAPBPAPBAP  −+=

0)( =BAP 

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

508



www.ABTU.edu

Probability Property

• The probability of event A AND B occurring together:

• If event A and B are independent of each other:

and 

)()|()( BPBAPBAP =

)()|( APBAP =

)()()( BPAPBAP =
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Probability Property

• The probability of event A occurring given event B taking place: 

)(

)(
)|(

BP

BAP
BAP


= where 0)( BP
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What is Distribution?

• Distribution (or probability distribution) describes the range of possible 

events and the possibility of each event occurring.

• In statistical terms, distribution is the probability of each possible value 

of a random variable when the variable is discrete, or the probability of 

a value falling in a specific interval when the variable is continuous.
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Probability Mass Function

• PMF (Probability Mass Function) is a function describing the probability 

of a discrete random variable equal to a particular value.

• Here is the probability mass function chart for a fair die.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

512



www.ABTU.edu

Probability Density Function

• PDF (Probability Density Function) is a function used to retrieve the 

probability of a continuous random variable falling within a particular 

interval.

• The probability of a variable falling within a particular region is the 

integral of the probability density function over the region.

• Here is the probability density function chart of a standard normal 

distribution.
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Advantages of Distribution

• Distributions capture the most basic features of data

• Shape

• Which distribution family may the data belong to?

• Is the data symmetric? 

• Are the tails of the data flat?

• Center

• Where is the midpoint of the data?

• Scale

• What is the range of data? 
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Measures of Skewness and Kurtosis

• The shape, center (i.e., location), and scale (i.e., variability) are three 

basic data characteristics that probability distributions capture.

• Skewness and kurtosis are the two more advanced characteristics of 

the probability distribution. L
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Skewness

• Skewness is a measure of the asymmetry degree of the probability 

distribution.

• The mathematical definition of the skewness is 

• The skewness of a normal distribution is zero.

• When the distribution looks symmetric to the left side and the right side 

of the center point, the skewness is close to zero.

• Potential causes of skewness:

• Extreme values exist in the data

• Data have a lower or higher bound.

where µ3 is the third moment about the mean and σ is the standard deviation.
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Skewness

• Left Skew

• Skewness < 0

• The left tail of the distribution is longer than the right tail.

• Right Skew

• Skewness > 0

• The right tail of the distribution is longer than the left tail.
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Kurtosis

• Kurtosis is a measure of the peakedness of the probability distribution.

• The mathematical definition of the excess kurtosis is 

• The kurtosis of a normal distribution is zero.

• Distributions with a zero excess kurtosis are called mesokurtic.

• The distribution with a high kurtosis has a more distinct peak and fatter, 

longer tails.

• The distribution with a low kurtosis has a more rounded peak and thinner, 

shorter tails.

where µ4 is the fourth moment about the mean and σ is the standard deviation. L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

518



www.ABTU.edu

Kurtosis

• Leptokurtic

• Excess Kurtosis > 0

• A sharper peak near the mean, declining rapidly, and fatter tails.

• Platykurtic

• Excess Kurtosis < 0

• A flatter top near the mean, declining slowly, and thinner tails.
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Multimodal Distribution

• In statistics, a continuous probability distribution with two or more 

different unimodal distributions is called a multimodal distribution.

• A unimodal distribution has only one local maximum which is equal 

to its global maximum.

• A multimodal probability distribution has more than one local maximum.

• Example: a bivariate, multimodal distribution 
(Image source: S&P 500 Composite 20-year total real returns)
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Bimodal Distribution

• In statistics, a continuous probability distribution with two 

different unimodal distributions is called a bimodal 

distribution.

• A bimodal probability distribution has two local maxima.

• By mixing two unimodal distributions with different means, 

the mixture distribution is not necessarily a bimodal 

distribution.

• The mixture of two normal distributions with the same 

standard deviation is a bimodal distribution only if the 

difference between their means is at least twice their 

common standard deviation.
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Examples of Discrete Distributions

• Binomial Distribution

• Poisson Distribution
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Binomial Distribution

• Assume there is an experiment with n independent trials, each of which 

only has two potential outcomes (i.e., yes/no, fail/pass). p is the 

probability of one outcome and (1 – p) is the probability of the other.

• Binomial distribution is a discrete probability distribution describing 

the probability of any outcome of the experiment.

• Excel formula for binomial distribution:

• BINOMDIST(number_s, trials, probability_s, cumulative)
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Binomial Distribution

• PMF of Binomial Distribution

the probability of getting k successes in n trials:

• Mean of Binomial Distribution

• Variance of Binomial Distribution
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Poisson Distribution

• Poisson distribution is a discrete probability distribution describing 

the probability of a number of events occurring at a known average rate 

and in a fixed period of time. The expected number of occurrences in 

this fixed period of time is λ.

• Excel formula for Poisson distribution

• POISSON(x, mean, cumulative)
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Poisson Distribution

• PMF of Poisson Distribution

the probability of getting k occurrences in n trials

• Mean of Poisson Distribution

• Variance of Poisson Distribution
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Examples of Continuous Distributions

• Normal Distribution

• Exponential Distribution

• Weibull Distribution

• Student’s t distribution

• Chi-square distribution

• F distribution
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Normal Distribution

• Normal distribution is a continuous probability distribution describing random 

variables which cluster around the mean.

• Its probability density function is a bell-shaped curve. But not all the bell-shaped 

PDFs are from normal distributions.

• It is the most extensively used distribution.

• Excel formula for normal distribution

• NORMDIST(x, mean, standard_dev, cumulative)

• The Empirical Rule (68-95-99.7 rule) for normal distribution:

• about 68% of the data stay within σ from the mean

• about 95% of the data stay within 2σ from the mean

• about 99.7% of the data stay within 3σ from the mean. 
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Normal Distribution

• PDF of Normal Distribution

• Mean of Normal Distribution

• Variance of Normal Distribution
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Exponential Distribution

• Exponential distribution is a continuous probability distribution 

describing the probability of events occurring at a known constant 

average rate between points of time.

• The exponential distribution is very similar to the Poisson distribution, 

except that the former is built on continuous variables and the latter is 

built on discrete variables.

• Excel formula for exponential distribution

• EXPONDIST(x, lambda, cumulative)
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Exponential Distribution

• PDF of Exponential Distribution

• Mean of Exponential Distribution

• Variance of Exponential Distribution





=
−

0
);(

xe
xf




ox 

ox



1

2

1



L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

531



www.ABTU.edu

Weibull Distribution

• Weibull distribution is a continuous probability distribution which is 

widely used to model a great variety of data due to its flexibility.

• K is the shape parameter and λ is the scale parameter. Both are 

positive numbers.

• Excel formula for Weibull distribution

• WEIBULL(x, alpha, beta, cumulative)
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Weibull Distribution

• PDF of Weibull Distribution

• Mean of Weibull Distribution

• Variance of Weibull Distribution
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Student’s T Distribution

• Student’s t distribution is a continuous probability distribution that 

resembles a normal distribution.

• When n random samples were drawn from a normally-distributed 

population with the mean μ and the standard deviation σ, then

follows a t distribution with (n – 1) degrees of freedom.

• Its probability density function is a bell-shaped curve but with heavier 

tails than those of the normal distribution.
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Student’s T Distribution

• PDF of Student’s T Distribution

• Mean of Student’s T Distribution

• Variance of Student’s T Distribution
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Chi-Square Distribution

• Chi-square distribution is a continuous probability distribution of the 

sum of  squares of multiple independent standard normal random 

variables.

• If Y1, Y2, …, Yk are a group of independent normal distributed variables, 

each with mean 0 and standard deviation 1, then

follows a chi-square distribution with k degrees of freedom. 
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Chi-Square Distribution

• PDF of Chi-Square Distribution

• Mean of Chi-Square Distribution

• Variance of Chi-Square Distribution
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F Distribution

• F distribution is a continuous probability distribution which arises in 

the analysis of variance or test of equality between two variances.

• If and      are independent variables with chi-square distributions 

with     and      degrees of freedom, 

follows a F distribution.
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F Distribution

• PDF of F Distribution

• Mean of F Distribution

• Variance of F Distribution
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Use Minitab to Fit a Distribution

• Case study: we are interested to fit the height data of basketball 

players into a distribution.

• Data File: “One Sample T-Test” tab in “Sample Data.xlsx”

• Steps to fit a distribution in Minitab:

1) Click Stat → Quality Tools → Individual Distribution Identification.

2) A new window named “Individual Distribution Identification” pops up.

3) Click in the box next to “Single Column” and the name of the series of our 

interest appears in the list box on the left.

4) Select “HtBk” as the “Single Column.”

5) Click “OK.”

6) Multiple windows appear displaying the distribution fitting results.
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Use Minitab to Fit a Distribution
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Use Minitab to Fit a Distribution
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Use Minitab to Fit a Distribution

• The distribution fitting 

report is displayed in 

the session window. 

• When the p-value of 

goodness-of-fit test is 

higher than the alpha 

level (0.05), the specific 

distribution fits the data 

well.
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Use Minitab to Fit a Distribution

• To fit a specific distribution, in the window 

“Individual Distribution Identification”, click 

on the radio button “Specify.”

• Uncheck the boxes of “Distribution 2,” 

“Distribution 3,” and “Distribution 4.”

• In the dropdown menu next to “Distribution 

1,” select the distribution of interest and 

click “OK”.

• In this example, we select “Normal” (i.e., 

normal distribution).
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Use Minitab to Fit a Distribution

• The result of fitting the specified 

distribution (normal distribution 

in this case) is generated in a 

new window.

• Since the p-value of the 

goodness-of-fit test is 0.275, 

higher than the alpha level 

(0.05), the variable HtBk is 

normally distributed.
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3.2 Inferential Statistics
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Black Belt Training: Analyze Phase

3.1 Patterns of Variation

3.1.1 Multi-Vari Analysis

3.1.2 Classes of Distributions

3.2 Inferential Statistics

3.2.1 Understanding Inference

3.2.2 Sampling Techniques and Uses

3.2.3 Sample Size

3.2.4 Central Limit Theorem

3.3 Hypothesis Testing

3.3.1 Goals of Hypothesis Testing

3.3.2 Statistical Significance

3.3.3 Risk; Alpha and Beta

3.3.4 Types of Hypothesis Tests

3.4 Hypothesis Testing: Normal Data

3.4.1 One and Two Sample T-Tests

3.4.2 One sample variance

3.4.3 One Way ANOVA

3.5 Hypothesis Testing: Non-Normal Data

3.5.1 Mann-Whitney

3.5.2 Kruskal-Wallis

3.5.3 Moods Median

3.5.4 Friedman

3.5.5 One Sample Sign

3.5.6 One Sample Wilcoxon

3.5.7 One and Two Sample Proportion

3.5.8 Chi-Squared (Contingency Tables)

3.5.9 Test of Equal Variances
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3.2.1 Understanding Inference
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What is Statistical Inference?

• Statistical inference is the process of making inferences regarding the 

characteristics of an unobservable population based on the 

characteristics of an observed sample.

• We rely on sample data to draw conclusions about the population from 

which the sample is drawn.

• Statistical inference is widely used since it is difficult or sometimes 

impossible to collect the entire population data.
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Outcome of Statistical Inference

• The outcome or conclusion of statistical inference is a statistical 

proposition about the population.

• Examples of statistical propositions:

• Estimating a population parameter

• Identifying an interval or a region where the true population parameter 

would fall with some certainty

• Deciding whether to reject a hypothesis made on characteristics of the 

population of interest

• Making predictions

• Clustering or partitioning data into different groups.
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Population and Sample

• A statistical population is an entire set of objects or 

observations about which statistical inferences are to be 

drawn based on its sample.

• It is usually impractical or impossible to obtain the data for the entire 

population. For example, if we are interested in analyzing the population of all 

the trees, it is extremely difficult to collect the data for all the trees that existed 

in the past, exist now, and will exist in the future.

• A sample is a subset of the population (like a piece of the pie above). It is 

necessary for samples to be representative of the population. 

• The process of selecting a subset of observations within a population is 

referred to as sampling.
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Population and Sample

• Population Parameters (Greek letters)

• Mean: μ

• Standard deviation: σ

• Variance: σ2

• Median: η

• The population parameter is the numerical summary of a population. 

• The sample statistic is the numerical measurement calculated based 

on a sample of that population. It is used to estimate the true population 

parameter.

• Sample Statistics (Roman letters)

• Sample Mean: 

• Standard deviation: S

• Variance: S 2

• Median: 

_

X

~

X
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Descriptive Statistics vs. Statistical Inference

• Descriptive Statistics 

• Descriptive statistics summarize the characteristics of a collection of data.

• Descriptive statistics are descriptive only and they do not make any 

generalizations beyond the data at hand.

• Data used for descriptive statistics are for the purpose of representing or 

reporting.

• Statistical Inference

• Statistical inference makes generalizations from a sample at hand of a 

population.

• Data used for statistical inference are for the purpose of making inferences 

on the entire population of interest.

• A complete statistical analysis includes both descriptive statistics and 

statistical inference.
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Error Sources of Statistical Inference

• Statistical inference uses sample data to best approximate the true 

features of the population.

• A valid sample must be unbiased and representative of the population.

• Two sources of error in statistical inference:

• Random sampling error

• Selection bias.
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Error Sources of Statistical Inference

• Random Sampling Error

• Random variation due to observations being selected randomly

• It is inherent to the sampling process and beyond one’s control.

• Selection Bias

• Non-random variation due to inadequate design of sampling

• It can be improved by adjusting the sampling size and sampling strategy.
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3.2.2 Sampling Techniques
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What is Sampling?

• Sampling is the process of selecting objects or observations from a 

population of interest about which we wish to make a statistical 

inference.

• It is extensively used to collect information about a population, which 

can represent physical or intangible objects.
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Advantages of Sampling

• It is usually impractical or impossible to collect the data of an entire 

population:

• High cost

• Time consuming

• Unavailability of historical records

• Dynamic nature of the population.

• Advantages of sampling a representative subset of the population:

• Lower cost

• Faster data collection

• Easier to manipulate.
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Uses of Sample

• With valid samples collected, we can draw statistical conclusions about 

the population of our interest.

• There are two major uses of samples in making statistical inference:

• Estimation: estimating the population parameters using the sample 

statistics.

• Hypothesis testing: testing a statement about the population characteristics 

using sample data.

• This module covers sample size calculation for estimation purposes 

only. Sample size calculations for hypothesis testing purposes will be 

covered in the Hypothesis Testing module.
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Basic Sampling Steps

1) Determine the population of interest

2) Determine the sampling frame

3) Determine the sampling strategy

4) Calculate the sample size

5) Conduct sampling
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Population

• Population in statistics is the entire set of objects or observations 

about which we are interested to draw conclusions or make 

generalizations based on some representative sample data.

• A population can be either physical or intangible.

• Physical: trees, customers, monitors etc.

• Intangible: credit score, pass/fail decisions etc.

• A population can be static or dynamic

• Characteristics of individuals are relatively static over time

• Items making up the population continue to change or be generated over 

time

• The population covers all the items with characteristics we are 

interested to analyze.
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Sampling Frame

• In the ideal situation, the scope of a population could be defined.

• Example: Mary is interested to know how the soup she is cooking tastes. 

The population is simply the pot of soup.

• However, in some other situations, the population cannot be identified 

or defined precisely.

• Example: to collect the information for an opinion poll, we do not have a list 

of all the people in the world at hand.

• A sampling frame is a list of items of the population (preferably the 

entire population; if not, approximate population).

• Example: The telephone directory would be a sampling frame for opinion 

poll data collection.
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Basic Sampling Strategies

• Simple Random Sampling

• Matched Random Sampling

• Stratified Sampling

• Systematic Sampling

• Proportional to Size Sampling

• Cluster Sampling
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Simple Random Sampling

• Simple random samples are selected in such a way that each item in 

the population has an equal chance of being selected.

• There is no bias involved in the sample selection. Such selection 

minimizes the variation between the characteristics of samples and the 

population.

• It is the basic sampling strategy.
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Matched Random Sampling

• Matched random samples are samples randomly selected in pairs, 

each of which has the same attribute.

• Example:

• Researchers are interested in understanding the weight of twins.

• Researchers are interested in understanding the patients’ blood pressure 

before and after taking some medicine.
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Stratified Sampling

• A population can be grouped or “stratified” into distinct and 

independent categories. An individual category can be considered as a 

sub-population. Stratified samples are randomly selected in each 

category of the population.

• The categories can be gender, region, income level etc.

• Stratified sampling requires advanced knowledge of the population 

characteristics. 

• Example: A fruit store wants to measure the quality of all their oranges. They decide 

to use stratified sampling by region to collect sample data. Since about 40% of their 

oranges are from California, 40% of the sample is selected from the California 

oranges sub-population.
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Systematic Sampling

• Systematic samples are selected at regular intervals based on an 

ordered list where items in the population are arranged according to a 

certain criterion.

• Systematic sampling has a random start and then every ith item is 

selected going forward.

• For example, we are sampling the every 5th unit produced on the 

production line.
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Cluster Sampling

• Cluster sampling is a sampling method in which samples are only 

selected from certain clusters or groups of the population.

• It reduces the cost and time spent on the sampling but bears the risk 

that the selected clusters are biased.

• For example, selecting samples from the region where researchers are 

located so that the cost and time spent on travelling is reduced.
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Sampling Strategy Decision Factors

• When determining the sampling strategy, we need to consider the 

following factors:

• Cost and time constraints

• Nature of the population of interest

• Availability of advanced knowledge of the population

• Accuracy requirement.
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Sample Size

• The sample size is a critical element that can influence the results of 

statistical inference.

• The smaller the sample size, the higher the risk that the sample 

statistic will not reflect the true population parameter.

• The greater the sample size, the more time and money we will spend 

on collecting the samples.
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Sample Size Factors

• Is the variable of interest continuous or discrete?

• How large is the population size?

• How much risk do you want to take regarding missing the true 

population parameters?

• What is the acceptable margin of error you want to detect?

• How much is the variation in the population?
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Sample Size Calculation for Continuous Data

• Sample size equation for continuous data

where

n0 is the number of samples.

is the Z score when risk level is α/2.

• When α is 0.05, it is 1.96. 

• When α is 0.10, it is 1.65.

s is the estimation of standard deviation in the population

d is the acceptable margin of error.
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Sample Size Calculation for Continuous Data

• When the sample size calculated using the formula 

exceeds 5% of the population size, we use a correction formula to calculate 

the final sample size. 
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n0 is the sample size calculated using equation
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Sample Size Calculation for Discrete Data

• Sample size equation for discrete data

where

n0 is the number of samples.

is the Z score when risk level is α/2.
• When α is 0.05, it is 1.96. 

• When α is 0.10, it is 1.65.

s is the estimation of standard deviation in the population.

d is the acceptable margin of error.

p is the proportion of one type of event occurring (e.g., proportion of passes).

p × (1 – p) is the estimate of variance.
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Sample Size Calculation for Discrete Data

• When the sample size calculated using the formula

exceeds 5% of the population size, we use a correction formula to 

calculate the final sample size. 
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n0 is the sample size calculated using equation
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Sampling Errors

• Random Sampling Error

• Random variation due to observations being selected randomly

• It is inherent in the sampling process and beyond one’s control.

• Selection Bias

• Non-random variation due to inadequate design of sampling

• It can be improved by adjusting the sampling size and sampling strategy.
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3.2.3 Sample Size
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Sample Size

• The sample size is a critical element that can influence the results of 

hypothesis testing.

• The smaller the sample size, the higher the risk that the statistical 

conclusions will not reflect the population relationship.

• The greater the sample size, the more time and money we will spend 

on collecting the samples.
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Sample Size Calculation

• General sample size formula for continuous data

• General sample size formula for discrete data
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Sample Size Calculation

• n is the number of observations in the sample.

• α is the risk of committing a false positive error.

• β is the risk of committing a false negative error.

• s is the estimation of standard deviation in the population

• d is the size of effect you want to be able to detect.

• p is the proportion of one type of event occurring (e.g. proportion of 

passes).
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Use Minitab to Calculate the Sample Size

• Case study:

• We are interested in comparing the average retail price of a product 

between two states.

• We will run a hypothesis test on the two sample means to determine 

whether there is a statistically significant difference between the retail price 

in the two states.

• The average retail price of the product is $23 based on our estimation and 

the standard deviation is 3. We want to detect at least a $2 difference with 

a 90% chance when it is true and we can tolerate the alpha risk at 5%

• What should the sample size be?
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Use Minitab to Calculate the Sample Size

• Steps to calculate the sample size in Minitab

1) Click Stat → Power and Sample Size → 2-Sample t.

2) A window named “Power and Sample Size for 2-Sample t” appears.

3) Enter “2” as “Differences.”

4) Enter “0.9” as “Power values.”

5) Enter “3” as “Standard deviation.”

6) Click “OK.”

7) The sample size calculation results appear in a new window.
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Use Minitab to Calculate the Sample Size
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Use Minitab to Calculate the Sample Size

• The sample size for 

each group is 49 based 

on the sample size 

calculator.

• When the absolute value 

of the difference to 

detect decreases, the 

power decreases 

accordingly if the sample 

size is kept the same.
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Use Minitab to Calculate the Sample Size

• 0.05 is the significance level by default.

• To customize the significance level, click on the “Options” button in the 

window “Power and Sample Size for 2-Sample t,” specify the 

significance value in the box, and click “OK.”
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3.2.4 Central Limit Theorem
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What is Central Limit Theorem?

• The Central Limit Theorem is one of the fundamental theorems of 

probability theory.

• It states a condition under which the mean of a large number of 

independent and identically-distributed random variables, each of 

which has a finite mean and variance, would be approximately normally 

distributed.
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What is Central Limit Theorem?

• Let us assume Y1, Y2, …, Yn is a sequence of n i.i.d. random variables, 

each of which has finite mean μ and variance σ2, where σ2 > 0. 

• When n increases, the sample average of the n random variables is 

approximately normally distributed, with the mean equal to μ and 

variance equal to σ2/n, regardless of the common distribution Yi follows 

where i = 1, 2, …, n.
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Independent and Identically Distributed

• A sequence of random variables is independent and identically 

distributed (i.i.d.) if each random variable is independent of others and 

has the same probability distribution as others.

• It is one of the basic assumptions in Central Limit Theorem. L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

589



www.ABTU.edu

Central Limit Theorem Example

• Let us assume we have10 fair die at hand. 

• Each time we roll all 10 die together we record the 

average of the 10 die.

• We repeat rolling the die 50 times until we will 

have 50 data points.

• Upon doing so, we will discover that the probability 

distribution of the sample average approximates 

the normal distribution even though a single roll of 

a fair die follows a discrete uniform distribution.
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Central Limit Theorem Explained in Formulas 

• Let us assume Y1, Y2, …, Yn are i.i.d. random variables with

As , the distribution of       becomes approximately normally 

distributed with

( ) YiYE =

2)var( YiY s=

where

where

− Y

 20 Ys

→n Y

( ) YYE =

n
Y Y

Y

2
2)var(

s
s ==
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Central Limit Theorem Application

• Use the sample mean to estimate the population mean.

• If the assumptions of Central Limit Theorem are met, 

)()( YEYE i = where ni ,...,2,1=
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Central Limit Theorem Application

• Use standard error of the mean to measure the standard deviation of 

the sample mean estimate of a population mean. 

• Standard deviation of the population mean

n

s
SE

Y
=

where s is the standard deviation of the sample and n is the sample size.

n
SD

Y

s
=

where σ is the standard deviation of the population and n is the sample size.
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Central Limit Theorem Application

• Use a larger sample size, if economically feasible, to decrease the 
variance of the sampling distribution.

• The larger the sample size, the more precise the estimation of the 
population parameter.

• Use a confidence interval to describe the region which the population 
parameter would fall in.

• The sample distribution approximates the normal distribution in which 
95% of the data stays within two standard deviations from the center.

• Population mean would fall in the interval of two standard errors of the 
mean away from the sample mean, 95% of the time.
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Confidence Interval

• The confidence interval is an interval where the true population 

parameter would fall within a certain confidence level.

• A 95% confidence interval indicates that the population parameter 

would fall in that region 95% of the time or we are 95% confident that 

the population parameter would fall in that region.

• 95% is the most commonly used confidence level.

• Confidence interval is used to describe the reliability of a statistical 

estimate of a population parameter.
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Confidence Interval

• The width of a confidence interval depends on:

• Confidence level

• Sample size

• Variability in the data.

• The higher the confidence level, the wider the confidence interval.

• The smaller the sample size, the wider the confidence interval.

• The more variability, the wider the confidence interval.
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Confidence Interval of the Mean

• Confidence interval of the population mean μY of a continuous variable 
Y is

is the sample mean

is the standard deviation of the population

is the sample size

is the Z score when risk level is α/2. 

• When α is 0.05, it is 1.96.

• When α is 0.10, it is 1.65.

is (1 – confidence level).

• When confidence level is 95%, α is 5%.

• When the confidence level is 90%, α is 10%. 

















+








−

n
ZY

n
ZY

ss


22

,

where

Y

s
n

2
Z

 Special Note: Since 95% is the 

most commonly used confidence 

level, 0.05 is the most commonly 

used α (also called alpha level).
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Minitab: Calculate the Confidence Interval of the Mean

• Data File: “Central Limit Theorem” tab in “Sample Data.xlsx”

1) Click Stat → Basic Statistics → Graphical Summary.

2) A new window named “Graphical Summary” pops up.

3) Select “Cycle Time (Minutes)” as the variable.

4) The confidence level is 0.95 by default.

5) Click “OK.”

6) A new window named “Summary for Cycle Time (Minutes)” pops up.
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Minitab: Calculate the Confidence Interval of the Mean
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Minitab: Calculate the Confidence Interval of the Mean

The 95% confidence 

interval of the mean is 

shown in the newly-

generated “Summary 

for Cycle Time 

(Minutes).”
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Minitab: Calculate the Confidence Interval of the Mean

• The confidence level is 95% by default.

• In order to see the confidence interval of “Cycle Time (Minutes)” at other confidence levels, 

we need to enter the confidence level of our interest in the window “Graphical Summary” 

and click “OK.”

• The following example shows how to generate

90% confidence interval of the mean.
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3.3 Hypothesis Testing
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Black Belt Training: Analyze Phase

3.1 Patterns of Variation

3.1.1 Multi-Vari Analysis

3.1.2 Classes of Distributions

3.2 Inferential Statistics

3.2.1 Understanding Inference

3.2.2 Sampling Techniques and Uses

3.2.3 Sample Size

3.2.4 Central Limit Theorem

3.3 Hypothesis Testing

3.3.1 Goals of Hypothesis Testing

3.3.2 Statistical Significance

3.3.3 Risk; Alpha and Beta

3.3.4 Types of Hypothesis Tests

3.4 Hypothesis Testing: Normal Data

3.4.1 One and Two Sample T-Tests

3.4.2 One sample variance

3.4.3 One Way ANOVA

3.5 Hypothesis Testing: Non-Normal Data

3.5.1 Mann-Whitney

3.5.2 Kruskal-Wallis

3.5.3 Moods Median

3.5.4 Friedman

3.5.5 One Sample Sign

3.5.6 One Sample Wilcoxon

3.5.7 One and Two Sample Proportion

3.5.8 Chi-Squared (Contingency Tables)

3.5.9 Test of Equal Variances
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3.3.1 Goals of Hypothesis Testing
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What is Hypothesis Testing?

• A hypothesis test is a statistical method in which a specific hypothesis 

is formulated about a population, and the decision of whether to reject 

the hypothesis is made based on sample data.

• Hypothesis tests help to determine whether a hypothesis about a 

population or multiple populations is true with certain confidence level 

based on sample data.
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Hypothesis Testing Examples

• Hypothesis testing tries to answer whether there is a difference 

between different groups or there is some change occurring.

• Are the average SAT scores of graduates from high school A and B the 

same?

• Is the error rate of one group of operators higher than that of another 

group?

• Are there any non-random causes influencing the height of kids in one 

state?

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

606



www.ABTU.edu

What is Statistical Hypothesis?

• A statistical hypothesis is an assumption about one or multiple 

population.

• It is a statement about whether there is any difference between 

different groups.

• It can be a conjecture about the population parameters or the nature of 

the population distributions.

• A statistical hypothesis is formulated in pairs:

• Null Hypothesis

• Alternative Hypothesis.
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Null and Alternative Hypotheses

• Null Hypothesis (H0) states that:

• there is no difference in the measurement of different groups

• no changes occurred

• sample observations result from random chance.

• Alternative Hypothesis (H1 or Ha) states that:

• there is a difference in the measurement of different groups

• some changes occurred

• sample observations are affected by non-random causes.
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Null and Alternative Hypotheses

• A statistical hypothesis can be expressed in mathematical language by 

using population parameters (Greek letters) and mathematical 

symbols.

• Population Parameters
(Greek letters)

• Mean: μ

• Standard deviation: σ

• Variance: σ2

• Median: η

• Mathematical Symbols

• Equal: =

• Not equal: ≠

• Greater than: >

• Smaller than: <
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Null and Alternative Hypotheses

• Examples of null and alternative hypotheses written in mathematical 

language.

H0: μ1 = μ2

H1: μ1 ≠ μ2

H0: σ1 = 0

H1: σ1 ≠ 0

H0: η1 = 10

H1: η1 > 10

H0: μ1 = 10

H1: μ1 < 10
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Hypothesis Testing Conclusion

• There are two possible conclusions of hypothesis testing:

• Reject the null

• Fail to reject the null.

• When there is enough evidence based on the sample information to 

prove the alternative hypothesis, we reject the null.

• When there is not enough evidence or the sample information is not

sufficiently persuasive, we fail to reject the null.
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Decision Rules in Hypothesis Testing

Sampling distribution based 

on the null hypothesis 

The critical value is derived from statistical 

tables. Different hypotheses use different 

statistical tables. It is the threshold value to 

determine whether to reject the null.

The fail to reject region is the non-shaded area under the 

sampling distribution and not beyond the critical value. It is the 

opposite area of critical region.

The test statistic is calculated based on a function of 

sample data. Different hypotheses use different formulas 

to calculate test statistic. It can be any value along the x 

axis.

The critical region is the shaded area 

under the sampling distribution and 

beyond the critical value. The critical 

value defines the boundary of critical 

region.

α
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Decision Rules in Hypothesis Testing

• The test statistic in hypothesis testing is a value calculated using a 

function of the sample. 

• Test statistics are considered the sample data’s numerical summary 

that can be used in hypothesis testing. 

• Different hypothesis tests have different formulas to calculate the test 

statistic.

• The critical value in hypothesis testing is a threshold value to which 

the test statistic is compared in order to determine whether the null 

hypothesis is rejected.

• The critical value is obtained from statistical tables.

• Different hypothesis tests need different statistical tables for critical 

values.
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Decision Rules in Hypothesis Testing

• When the test statistic falls into the fail to reject region, we fail to reject 

the null and claim that there is no statistically significant difference 

between the groups. 

• When the test statistic falls into the critical region, we reject the null and 

claim that there is a statistically significant difference between the 

groups.
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Decision Rules in Hypothesis Testing

• The proportion of the area under the sampling distribution and beyond 

the critical value indicates α risk (also called α level). The most 

commonly selected α level is 5%. 

• The proportion of the area under the sampling distribution and beyond 

the test statistic is the p-value. It is the probability of getting a test 

statistic at least as extreme as the observed one, given the null is true.
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Decision Rules in Hypothesis Testing

• When the p-value is smaller than the α level, we reject the null and 

claim that there is a statistically significant difference between different 

groups. 

• When the p-value is higher than the α level, we fail to reject the null 

and claim that there is no statistically significant difference between 

different groups. 
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Steps in Hypothesis Testing

• Step 1: State the null and alternative hypothesis.

• Step 2: Determine α level.

• Step 3: Collect sample data.

• Step 4: Select a proper hypothesis test.

• Step 5: Run the hypothesis test.

• Step 6: Determine whether to reject the null.
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3.3.2 Statistical Significance
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Statistical Significance

• In statistics, an observed difference is statistically significant if it is 

unlikely that the difference occurred by pure chance, given a 

predetermined probability threshold. 

• Statistical significance indicates that there are some non-random 

factors causing the result to take place.

• The statistical significance level in hypothesis testing indicates the 

amount of evidence which is sufficiently persuasive to prove that a 

difference between groups exists not due to random chance alone.
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Practical Significance

• An observed difference is practically significant when it is large enough 

to make a practical difference.

• A difference between groups that is statistically significant might not be 

large enough to be practically significant.

• In some business situations, statistical differences can have little to no 

meaning because the difference is not large enough to be practical for 

a business to act upon.
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Example

• You started to use the premium gas recently, which was supposed to 

make your car run better. 

• After running a controlled experiment to measure the performance of 

the car before and after using the premium gas, you performed a 

statistical hypothesis test and found that the difference before and after 

was statistically significant.

• Using premium gas did improve the performance.

• However, due to the high cost of the premium gas, you decided that the 

difference was not large enough to make you pay extra money for it. In 

other words, the difference is not practically significant.
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3.3.3 Risk; Alpha & Beta
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Errors in Hypothesis Testing

• In statistical hypothesis testing, there are two types of errors:

• Type I Error

• a null hypothesis is rejected when it is true in fact.

• Type II Error

• a null hypothesis is not rejected when it is not true in fact.
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Type I Error

• Type I error is also called false positive, false alarm, or alpha (α) error.

• Type I error is associated with the risk of accepting false positives.

• It occurs when we think there is a difference between groups but in fact 

there is none.

• Example: telling a patient he is sick and in fact he is not.
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Alpha (α)

• α indicates the probability of making a type I error. It ranges from 0 to 1.

• α risk is the risk of making a type I error.

• 5% is the most commonly used α.

• (100% – α) is the confidence level which is used to calculate the confidence intervals.

• When making a decision on whether to reject the null, we compare the p-value 

against α:

• If p-value is smaller than α, we reject the null

• If p-value is greater than α, we fail to reject the null.

• To reduce the α risk, we decrease the α value to which the p-value is compared.
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Type II Error

• Type II error is also called false negative, oversight, or beta (β) error.

• Type II error is associated with the risk of accepting false negatives.

• It occurs when we think there is not any difference between groups but 

in fact there is.

• Example: telling a patient he is not sick and in fact he is.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

626



www.ABTU.edu

Beta (β)

• β indicates the probability of making a type II error. It ranges from 0 to 1.

• β risk is the risk of making a type II error.

• 10% is the most commonly used β.

• (100% – β) is called power, which denotes the probability of detecting a 

difference between groups when in fact the difference truly exists.

• To reduce the β risk, we increase the sample size.

• When holding other factors constant, β is inversely related to α.
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3.3.4 Types of Hypothesis Tests
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Two Types of Hypothesis Tests

• Two-tailed hypothesis test

• It is also called two-sided hypothesis test

• It is a statistical hypothesis test in which the critical region is split into two 

equal areas, each of which stays on one side of the sampling distribution.

• One-tailed hypothesis test

• It is also called one-sided hypothesis test

• It is a statistical hypothesis test in which the critical region is only on one 

side of the sampling distribution.
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Two-Tailed Hypothesis Test

• A two-tailed hypothesis test is used when we care about whether there 

is a difference between groups and we do not care about the direction 

of the difference.

• Examples of a two-tailed hypothesis test:

The null hypothesis (H0) is rejected when:

• the test statistic falls into either half of the critical region

• the test statistic is either sufficiently small or sufficiently large

• the absolute value of the test statistic is greater than the absolute value of 

the critical value.

• A two-tailed hypothesis test is the most commonly used hypothesis 

test. In the next modules we will cover more details about it.

H0: μ1 = 10

Ha: μ1 ≠ 10
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Two-Tailed Hypothesis Test

α/2α/2

Acceptance 

Region
Critical Region
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One-Tailed Hypothesis Test

• A one-tailed hypothesis test is used when we care about one direction 

of the difference between groups.

• Examples of one-tailed hypothesis tests:

• The null hypothesis is rejected when the test statistic:

• falls in the critical region which exists on the right side of the sampling 

distribution

• is sufficiently large

• is greater than the critical value.

H0: μ1 = 10

Ha: μ1 > 10
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One-Tailed Hypothesis Test

α

Acceptance 

Region
Critical Region
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One-Tailed Hypothesis Test

• Examples of one-tailed hypothesis test

• The null hypothesis is rejected when the test statistic:

• falls into the critical region which only exists on the left side of the sampling 

distribution

• is sufficiently small

• is smaller than the critical value.

H0: μ1 = 10

Ha: μ1 < 10
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One-Tailed Hypothesis Test

α

Acceptance 

Region

Critical Region
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3.4 Hypothesis Tests: Normal Data
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Black Belt Training: Analyze Phase

3.1 Patterns of Variation

3.1.1 Multi-Vari Analysis

3.1.2 Classes of Distributions

3.2 Inferential Statistics

3.2.1 Understanding Inference

3.2.2 Sampling Techniques and Uses

3.2.3 Sample Size

3.2.4 Central Limit Theorem

3.3 Hypothesis Testing

3.3.1 Goals of Hypothesis Testing

3.3.2 Statistical Significance

3.3.3 Risk; Alpha and Beta

3.3.4 Types of Hypothesis Tests

3.4 Hypothesis Testing: Normal Data

3.4.1 One and Two Sample T-Tests

3.4.2 One sample variance

3.4.3 One Way ANOVA

3.5 Hypothesis Testing: Non-Normal Data

3.5.1 Mann-Whitney

3.5.2 Kruskal-Wallis

3.5.3 Moods Median

3.5.4 Friedman

3.5.5 One Sample Sign

3.5.6 One Sample Wilcoxon

3.5.7 One and Two Sample Proportion

3.5.8 Chi-Squared (Contingency Tables)

3.5.9 Test of Equal Variances
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3.4.1 One & Two Sample T-Tests
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What is a T-Test?

• In statistics, a t-test is a hypothesis test in which the test statistic 

follows a Student t distribution if the null hypothesis is true.

• We apply a t-test when the population variance (σ) is unknown and we 

use the sample standard deviation (s) instead. L
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What is One Sample T-Test?

• One sample t-test is a hypothesis test to study whether there is a 

statistically significant difference between a population mean and a 

specified value.

• Null Hypothesis (H0): μ = μ0

• Alternative Hypothesis (Ha): μ ≠ μ0

where μ is the mean of a population of our interest and μ0 is the 

specific value we want to compare against.
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Assumptions of One Sample T-Test

• The sample data drawn from the population of interest are unbiased 

and representative.

• The data of the population are continuous.

• The data of the population are normally distributed.

• The variance of the population of our interest is unknown.

• One sample t-test is more robust than the z-test when the sample size 

is small (< 30).
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Normality Test

• To check whether the population of our interest is normally distributed, 

we need to run normality test.

• Null Hypothesis (H0): The data are normally distributed.

• Alternative Hypothesis (Ha): The data are not normally distributed.

• There are a lot of normality tests available:

• Anderson-Darling

• Sharpiro-Wilk

• Jarque-Bera etc.
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Test Statistic and Critical Value of One Sample T-Test

• Test Statistic

• Critical Value

• tcrit is the t-value in a Student t distribution with the predetermined 

significance level α and degrees of freedom (n –1).

• tcrit values for a two-sided and a one-sided hypothesis test with the same 

significance level α and degrees of freedom (n – 1) are different.
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Decision Rules of One Sample T-Test

• Based on the sample data, we calculated the test statistic tcalc, which is 

compared against tcrit to make a decision of whether to reject the null.

• Null Hypothesis (H0): μ = μ0

• Alternative Hypothesis (Ha): μ ≠ μ0

• If |tcalc| > tcrit, we reject the null and claim there is a statistically 

significant difference between the population mean μ and the specified 

value μ0. 

• If |tcalc| < tcrit, we fail to reject the null and claim there is not any 

statistically significant difference between the population mean μ and 

the specified value μ0. 
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Use Minitab to Run a One-Sample T-Test

• Case study: We want to compare the average height of basketball 

players against 7 feet.

• Data File: “One Sample T-Test” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): μ = 7

• Alternative Hypothesis (Ha): μ ≠ 7
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Use Minitab to Run a One-Sample T-Test

• Step 1: Test whether the data are normally distributed

1) Click Stat → Basic Statistics → Normality Test.

2) A new window named “Normality Test” pops up.

3) Select “HtBk” as the variable.

4) Click “OK.”

5) A new window named “Probability Plot of HtBk” appears, which covers the 

results of the normality test.
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Use Minitab to Run a One-Sample T-Test
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Use Minitab to Run a One-Sample T-Test

• Null Hypothesis (H0): The data are 

normally distributed.

• Alternative Hypothesis (Ha): The data 

are not normally distributed.

• Since the p-value of the normality is 

0.275, which is greater than alpha level 

(0.05), we fail to reject the null and 

claim that the data are normally 

distributed. 

• If the data are not normally distributed, 

you need to use hypothesis tests other 

than the one sample t-test.
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Use Minitab to Run a One-Sample T-Test

• Step 2: Run the one-sample t-test

1) Click Stat → Basic Statistics → 1 Sample t.

2) A new window named “1 Sample t (Test and Confidence Interval)” pops up.

3) Click in the blank box under “Samples in columns” and “HtBk” appears in the list 

box on the left.

4) Select “HtBk” as the “Samples in columns.”

5) Check the box of “Perform hypothesis test.”

6) Enter the hypothesized value “7” into the box next to “Perform hypothesis test.”

7) Click “OK.”

8) The one-sample t-test result appears automatically in the session window.
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Use Minitab to Run a One-Sample T-Test
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Use Minitab to Run a One-Sample T-Test

• Null Hypothesis (H0): μ = 7

• Alternative Hypothesis (Ha): μ ≠ 7

• Since the p-value is smaller than 

alpha level (0.05), we reject the 

null hypothesis and claim that 

average of basketball players is 

statistically different from 7 feet. 
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What is Two Sample T-Test?

• Two sample t-test is a hypothesis test to study whether there is a 

statistically significant difference between the means of two 

populations.

• Null Hypothesis (H0): μ1 = μ2

• Alternative Hypothesis (Ha): μ1 ≠ μ2

where μ1 is the mean of one population and μ2 is the mean of the other 

population of our interest.
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Assumptions of Two Sample T-Tests

• The sample data drawn from both populations are unbiased and 

representative.

• The data of both populations are continuous.

• The data of both populations are normally distributed.

• The variances of both populations are unknown.

• Two sample t-test is more robust than a z-test when the sample size is 

small (< 30).
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Three Types of Two Sample T-Tests

1. Two sample t-test when the variances of two populations are 

unknown but equal

• Two sample t-test (when σ2
1 = σ2

2)

2. Two sample t-test when the variances of the two population are 

unknown and unequal

• Two sample t-test (when σ2
1 ≠ σ2

2)

3. Paired t-test when the two populations are dependent of each other

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

654



www.ABTU.edu

Test of Equal Variance

• To check whether the variances of two populations of interest are 

statistically significant different, we use the test of equal variance.

• Null Hypothesis (H0): 

• Alternative Hypothesis (H1):

• An F-test is used to test the equality of variances between two normally 

distributed populations.
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Test of Equal Variance

• An F-test is a statistic hypothesis test in which the test statistic follows 

an F-distribution when the null hypothesis is true.

• The most known F-test is the test of equal variance for two normally 

distributed populations.

• The F-test is very sensitive to non-normality. When any one of the two 

populations is not normal, we use the Brown-Forsythe test for checking 

the equality of variances. 
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Test of Equal Variance

• Test Statistic

• Critical Value

• Fcrit is the F value in a F distribution with the predetermined significance 

level α and degrees of freedom (n1 – 1) and (n2 – 1).

• Fcrit values for a two-sided and a one-sided F-test with the same 

significance level α and degrees of freedom (n1 – 1) and (n2 – 1) are 

different.

2

2

2

1

s

s
Fcalc =

where
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Test of Equal Variance

• Based on the sample data, we calculated the test statistic Fcalc, which is 

compared against Fcrit to make a decision of whether to reject the null.

• Null Hypothesis (H0):

• Alternative Hypothesis (Ha):

• If Fcalc > Fcrit, we reject the null and claim there is a statistically 

significant difference between the variances of the two populations.

• If Fcalc < Fcrit, we fail to reject the null and claim there is not any 

statistically significant difference between the variances of the two 

populations.
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Test Statistic & Critical Value of a Two Sample T-Test when  σ2
1 =  σ2

2

• Test Statistic

• Critical Value
tcrit is the t value in a Student t distribution with the predetermined significance level α and degrees of 
freedom (n1 + n2 – 2).

tcrit values for a two-sided and a one-sided t-test with the same significance level α and degrees of 
freedom (n1 + n2 – 2) are different.
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spooled

are the sample means of the two populations of our interest.1Y and 2Y

n1 and n2 are the sample sizes. n1 is not necessarily equal to n2.

spooled is a pooled estimate of variance. s1 and s2 are the sample 

standard deviations.
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Test Statistic & Critical Value of a Two Sample T-Test when  σ2
1 ≠  σ2

2

• Test Statistic

• Critical Value
tcrit is the t value in a Student t distribution with the predetermined significance level α and degrees of 
freedom df calculated using the formula above.

tcrit values for a two-sided and a one-sided t-test with the same significance level α and degrees of 
freedom df are different.
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are the sample means of the two populations of our interest.and1Y 2Y

n1 and n2 are the sample sizes. n1 is not necessarily equal to n2.

s1 and s2 are the sample standard deviations.
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Test Statistic & Critical Value of a Paired T-Test

• Test Statistic

• Critical Value
tcrit is the t value in a Student t distribution with the predetermined significance level α and degrees of 
freedom (n – 1).

tcrit values for a two-sided and a one-sided t-test with the same significance level α and degrees of freedom 
(n – 1) are different.

n
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d
t

d
calc =

where

is the average of d.d

n is the sample size of either population of interest. 

sd is standard deviation of d.

d is the difference between each pair of data. 
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Decision Rules of a Two Sample T-Test

• Based on the sample data, we calculated the test statistic tcalc, which is 

compared against tcrit to make a decision of whether to reject the null.

• Null Hypothesis (H0): μ1 = μ2

• Alternative Hypothesis (Ha): μ1 ≠ μ2

• If |tcalc| > tcrit, we reject the null and claim there is a statistically 

significant difference between the means of the two populations.

• If |tcalc| < tcrit, we fail to reject the null and claim there is not any 

statistically significant difference between the means of the two 

populations.
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Use Minitab to Run a Two-Sample T-Test

• Case study: We are trying to compare the average retail price of a 

product in state A and state B.

• Data File: “Two-Sample T-Test” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): μ1 = μ2

• Alternative Hypothesis (Ha): μ1 ≠ μ2
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Use Minitab to Run a Two-Sample T-Test

• Step 1: Test the normality of the retail price for both state A and B.

1) Click Stat → Basic Statistics → Graphical Summary.

2) A window named “Graphical Summary” pops up.

3) Select “Retail Price” as the “Variables.”

4) Click in the blank box right below “By variables (optional)” and “State” 

appears in the list box on the left.

5) Select the “State” as the “By variables (optional).”

6) Click “OK.”

7) The normality test results would appear in the new windows.
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Use Minitab to Run a Two-Sample T-Test
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Use Minitab to Run a Two-Sample T-Test

• Null Hypothesis (H0): The 
data are normally distributed.

• Alternative Hypothesis (Ha): 
The data are not normally 
distributed.

• Both retail price data of state 
A and B are normally 
distributed since the p-values 
are both greater than alpha 
level (0.05).

• If any of the data series is not 
normally distributed, we need 
to use other hypothesis 
testing methods other than 
the two sample t-test.
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Use Minitab to Run a Two-Sample T-Test

• Step 2: Test whether the variances of the two data sets are equal.

• Null Hypothesis (H0):

• Alternative Hypothesis (Ha):

1) Click Basic Statistics → 2 Variances.

2) A new window named “2 Sample Variance” pops up.

3) Click in the blank box of “Samples” and “Retail Price” appears in the list box on the left.

4) Select “Retail Price” as the “Samples.”

5) Click in the blank box of “Sample ID” and “State” appears in the list box on the left.

6) Select “State” as the “Sample ID.”

7) Click “Options” and select “Use test and confidence intervals based on normal distribution”

8) Click “OK.” to the “Options” dialogue box

9) Click “OK.” to the 2 Variances (Test Confidence Intervals) window. 

10) The results show up in the session window.
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Use Minitab to Run a Two-Sample T-Test
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Use Minitab to Run a Two-Sample T-Test

• Because the retail prices at state A and state 

B are both normally distributed, an F test is 

used to test their variance equality. 

• The p-value of F test is 0.870, greater than 

the alpha level (0.05), so we fail to reject the 

null hypothesis and we claim that the 

variances of the two data sets are equal. We 

will use the two sample t-test (when σ2
1 = σ2

2) 

to compare the means of the two groups.

• If σ2
1 ≠ σ2

2, we will use the two sample t-test 

(when σ2
1 ≠ σ2

2) to compare the means of the 

two groups.
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Use Minitab to Run a Two-Sample T-Test

• Step 3: Run two-sample t-test to compare the means of two groups.

1) Click Stat → Basic Statistics → 2-Sample t.

2) A new window named “2-Sample t for the Mean” pops up.

3) Click in the blank box right next to “Samples” and the “Retail Price” appears in the 
list box on the left.

4) Select “Retail Price” as the “Samples.”

5) Click in the blank box right next to “Sample ID” and the “State” appears in the list 
box on the left.

6) Select “State” as the “Sample ID.”

7) Click “Options” 

8) Check the box “Assume equal variances.” 

9) Click “OK.” in the “Options” window.

10)Click “OK” in the 2-Sample t window

11)The results of the two-sample t-test (when σ1 = σ2) appear automatically in the 
session window.
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Use Minitab to Run a Two-Sample T-Test
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Use Minitab to Run a Two-Sample T-Test

Since the p-value of the t-test 

(assuming equal variance) is 0.665, 

greater than the alpha level (0.05), we 

fail to reject the null hypothesis and 

we claim that the means of the two 

data sets are equal. 
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Use Minitab to Run a Two-Sample T-Test

• If the variances of the two groups do not equal, 
we will need to use the two-sample t-test 
(when σ1 ≠ σ2) to compare the means of the 
two groups.
• In the window of “2-Sample (Test and Confidence 

Interval),” uncheck the box next to “Assume 
equal variances” and run the 2-sample t-test 
again.

• Since the p-value of the t-test (assuming 
unequal variance) is 0.666, greater than the 
alpha level (0.05), we fail to reject the null 
hypothesis and we claim that the means of two 
groups are equal.
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Use Minitab to Run a Paired T-Test

Case study: 

• We are interested to know whether the average salaries ($1000/yr.) of 

male and female professors at the same university are the same.

• Data File: “Paired T-Test” tab in “Sample Data.xlsx”

• The data were randomly collected from 22 universities. For each university, 

the salaries of a male and female professors were randomly selected. 

• Null Hypothesis (H0): μmale – μfemale = 0

• Alternative Hypothesis (Ha): μmale – μfemale ≠ 0
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Use Minitab to Run a Paired T-Test

• Step 1: Create a new column of the difference between the two data 

sets of interest and name it “Difference.”
(Note: if your data already has a column for “Difference” with data in it, this step will not be necessary.)

1) Right click on the newly-generated column, “Difference.”

2) Select “Formulas” and then “Assign Formula to Column.”

3) A new window named “Assign Formula to C3 (Difference)” pops up.

4) Enter “ ‘MALES’-‘ FEMALES’ ” into the box right below “Expression.”

5) Click “OK.”

6) The values would appear in the column “Difference.”
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Use Minitab to Run a Paired T-Test
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Use Minitab to Run a Paired T-Test

• Step 2: Test whether the difference is normally distributed.

• Null Hypothesis (H0): The difference between two data sets is normally 

distributed.

• Alternative Hypothesis (Ha): The difference between two data sets is not 

normally distributed.

1) Click Stat → Basic Statistics → Normality Test.

2) A new window named “Normality Test” pops up. 

3) Select “Difference” as the “Variable.”

4) Click “OK.”

5) The normality test results would appear in the new window.
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Use Minitab to Run a Paired T-Test
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Use Minitab to Run a Paired T-Test

• The p-value of the 

normality test is 0.287, 

greater than the alpha level 

(0.05), so we fail to reject 

the null hypothesis and we 

claim that the difference is 

normally distributed.

• When the difference is not 

normally distributed, we 

need other hypothesis 

testing methods.
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Use Minitab to Run a Paired T-Test

• Step 3: Run the paired t-test to compare the means of two dependent 

data sets.

1) Click Stat → Basic Statistics → Paired t.

2) A new window named “Paired t (Test and Confidence Interval)” pops up.

3) Click in the blank box right next to “First Sample” and the three columns 

names appear in the list box on the left.

4) Select “MALES” as “First Sample.”

5) Select “FEMALES” as “Second Sample.”

6) Click “OK.”

7) The paired t-test results appears in the session window.
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Use Minitab to Run a Paired T-Test
L

e
a

n
 S

ix
 S

ig
m

a
 T

ra
in

in
g

 -
M

T
B

©
 A

m
e

ric
a

n
 B

&
T

 U
n

iv
e

rs
ity

681



www.ABTU.edu

Use Minitab to Run a Paired T-Test

• The p-value of the paired t-test is 

0.213, greater than the alpha level 

(0.05), so we fail to reject the null 

hypothesis and we claim that there is 

no statistically significant difference 

between the salaries of male and 

those of female professors.
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3.4.2 One Sample Variance
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What is One Sample Variance Test?

• One sample variance test is a hypothesis testing method to study 

whether there is a statistically significant difference between a 

population variance and a specified value.

• Null Hypothesis (H0):

• Alternative Hypothesis (Ha):

where σ2 is the variance of a population of our interest and       is the specific 

value we want to compare against.

2
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2 ss =
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Chi-Square Test

• A chi-square test is a statistical hypothesis test in which the test 

statistic follows a chi-square distribution when the null hypothesis is 

true.

• A chi-square test can be used to test the equality between the variance 

of a normally distributed population and a specified value. 
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Chi-Square Test

• Test Statistic

• Critical Value

• is the χ2 value in a χ2 distribution with the predetermined 

significance level α and degrees of freedom (n – 1). 

• values for a two-sided and a one-sided χ2-test with the same 

significance level α and degrees of freedom (n –1) are different.

2

0

2
2 )1(

s


sn
calc

−
=

where

s2 is the observed variance and n is the sample size. 

2

0s is the specified value we compare against.
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2
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Chi-Square Test

• Based on the sample data, we calculated the test statistic , which is 

compared against        to make a decision of whether to reject the null.

• Null Hypothesis (H0):

• Alternative Hypothesis (Ha):

• If , we reject the null and claim there is a statistically significant 

difference between the population variance and the specified value.

• If , we fail to reject the null and claim there is not any 

statistically significant difference between the population variance and 

specified value.

2

calc

2

crit

2

0

2 ss =
2

0

2 ss 

22

critcalc  

22

critcalc  
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Use Minitab to Run a One Sample Variance Test

• Case study: We are interested in comparing the variance of the height 

of basketball players with zero.

• Data File: “One Sample T-Test” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): σ
2 = 0

• Alternative Hypothesis (Ha): σ
2 ≠ 0
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Use Minitab to Run a One Sample Variance Test

• Step 1: Test whether the data are normally distributed

1. Click Stat → Basic Statistics → Normality Test.

2. A new window named “Normality Test” pops up.

3. Select “HtBk” as the “Variable.”

4. Click “OK.”

5. The normality test result appears in the new window.
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Use Minitab to Run a One Sample Variance Test
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Use Minitab to Run a One Sample Variance Test

• Null Hypothesis (H0): The data are 

normally distributed.

• Alternative Hypothesis (Ha): The 

data are not normally distributed.

• Since the p-value of the normality 

is 0.275, greater than alpha level 

(0.05), we fail to reject the null 

and claim that the data are 

normally distributed. 

• If the data are not normally 

distributed, you need to use other 

hypothesis tests.
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Use Minitab to Run a One Sample Variance Test

• Step 2: Check if the population variance is equal to the specified value (zero). 

1) Click Stat → Basic Statistics → 1 Variance.

2) A new window named “1 Variance” appears.

3) Click in the blank box below “Columns” and “HtBk” appears in the list box on the left.

4) Check the box of “Perform hypothesis test.”

5) Select “Hypothesized variance” from the dropdown menu.

6) Enter “0” as the “Hypothesized variance.”

7) Click “OK.”

8) An alert window pops up saying “Invalid hypothesized value. The following value is too 
small: “0”. Please specify: A single numeric constant. Value > 0.”

9) Click “OK” in the alert message window.

10)Enter “0.0000000001” as the “Hypothesized variance” instead.

11)Click “OK.”

12)The one sample variance test appears in new window.
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Use Minitab to Run a One Sample Variance Test
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Use Minitab to Run a One Sample Variance Test

Since the p-value of the one sample 

variance test is smaller than alpha level 

(0.05), we reject the null and claim that 

the population variance is statistically 

different from zero.

Another way to see whether the 

population variance is statistically 

different from zero is to check whether 

zero stays between the upper and 

lower confidence interval boundaries of 

the variance. If yes, we fail to reject the 

null hypothesis and claim that the 

population variance is not statistically 

different from zero.
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3.4.3 One Way ANOVA
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What is One-Way ANOVA?

• One-way ANOVA (one-way analysis of variance) is a statistical method 

to compare means of two or more populations.

• Null Hypothesis (H0): 

• Alternative Hypothesis (Ha): at least one μi is different, where i is any value 

from 1 to k.

• It is a generalized form of the two sample t-test since a two sample t-

test compares two population means and one-way ANOVA compares k

population means where k ≥ 2.

k === ...21
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Assumptions of One-Way ANOVA

• The sample data drawn from k populations are unbiased and 

representative.

• The data of k populations are continuous.

• The data of k populations are normally distributed.

• The variances of k populations are equal.
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How ANOVA Works

• ANOVA compares the means of different groups by analyzing the 

variances between and within groups.

• Let us say we are interested in comparing the means of three normally 

distributed populations. We randomly collected one sample for each 

population of our interest.

• Null Hypothesis (H0): μ1 = μ2 = μ3

• Alternative Hypothesis (Ha): one of the μ is different from the others.
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How ANOVA Works

• Based on the sample data, the means of the three populations might 

look different because of two variation sources.

1) Variation between groups

There are non-random factors leading to the variation between groups.

2) Variation within groups

There are random errors resulting in the variation within each individual group.

• What we care about the most is the variation between groups since we 

are interested in whether the groups are statistically different from each 

other.

• Variation between groups is the signal we want to detect and variation 

within groups is the noise which corrupts the signal.
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How ANOVA Works

Grand mean of all 

observations: Y

Individual observation
ijY

Group means of each 

individual sample: jY

Total Variation = SS(Total) = 

Between Variation = SS(Between) = 

Within Variation = SS(Within) = 


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How ANOVA Works

• Variation Components

• Total Variation = Variation Between Groups + Variation Within Groups

• Total Variation = sums of squares of the vertical difference between the individual 

observation and the grand mean

• Variation Between Groups = sums of squares of the vertical difference between the 

group mean and the grand mean

• Variation Within Groups = sum of squares of the vertical difference between the 

individual observation and the group mean
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How ANOVA Works

• Degrees of Freedom (DF)

• In statistics, the degrees of freedom is the number of unrestricted values in the 

calculation of a statistic.

• Degrees of Freedom Components

• DFtotal= DFbetween + DFwithin

• DFtotal = n – 1

• DFbetween= k – 1

• DFwithin= n – k

where

n is the total number of observations

k is the number of groups.
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How ANOVA Works

• Signal-to-Noise Ratio (SNR)
• SNR denotes the ratio of a signal to the noise corrupting the signal.

• It measures how much a signal has been corrupted by the noise.

• When it is higher than 1, there is more signal than noise.

• The higher the SNR, the less the signal has been corrupted by the noise.

• F-ratio is the SNR in ANOVA

• In ANOVA, we use the F-test to compare the means of different groups. The F-ratio 
calculated as above is the test statistic Fcalc.

• The critical value (Fcri) in an F-test can be derived from the F table with 
predetermined significance level (α) and with (k –1) degrees of freedom in the 
numerator and (n – k) degrees of freedom in the denominator.
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How ANOVA Works

• Null Hypothesis (H0): 

• Alternative Hypothesis (Ha): at least one μi is different, where i is any 

value from 1 to k.

• If |Fcalc| < Fcrit, we fail to reject the null and claim that the means of all 

the populations of our interest are the same.

• If |Fcalc| > Fcrit, we reject the null and claim that there is at least one 

mean different from the others.
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Model Validation

• ANOVA is a modeling procedure. To make sure the conclusions made 

in ANOVA are reliable, we need to perform residuals analysis. 

• Good residuals:

• Have a mean of zero

• Are normally distributed

• Are independent of each other

• Have equal variance.
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Use Minitab to Run an ANOVA

• Case study: We are interested in comparing the average startup costs 

of five kinds of business.

• Data File: “One-Way ANOVA” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): μ1 = μ2 = μ3 = μ4 = μ5

• Alternative Hypothesis (Ha): at least one of the five means is different 

from others.
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Use Minitab to Run an ANOVA

• Step 1: Test whether the data for each level are normally distributed.

1) Click Stat → Basic Statistics → Graphical Summary.

2) A new window named “Graphical Summary” pops up.

3) Select the “Cost” as the variable.

4) Click in the blank box right next to “By variables (optional)” and the “Business” 

appears in the list box on the left.

5) Select the “Business” as the “By variables (optional).”

6) Click “OK.”

7) The normality results appear in the new window.
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Use Minitab to Run an ANOVA
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Use Minitab to Run an ANOVA
Business = X1 Business = X3

Business = X2 Business = X4

Business = X5
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Use Minitab to Run an ANOVA

Null Hypothesis (H0): The data are normally distributed.

Alternative Hypothesis (Ha): The data are not normally distributed.

• Since the p-values of normality tests for the five data sets are higher 

than alpha level (0.05), we fail to reject the null hypothesis and claim 

that the startup costs for any of the five businesses are normally 

distributed.

• If any of the five data sets are not normally distributed, we need to use 

other hypothesis testing methods other than one-way ANOVA.
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Use Minitab to Run an ANOVA

• Step 2: Test whether the variance of the data for each level is equal to the variance of 
other levels.

Null Hypothesis (H0):

Alternative Hypothesis (Ha): at least one of the variances is different from others.

1) Click Stat → ANOVA → Test for equal variances.

2) A new window named “Test for Equal Variances” pops up.

3) Select the “Cost” as the “Response.”

4) Select the “Business” as the “Factors.”

5) Click “Options.”

6) Select “Use test based on normal distribution” 

7) Click “OK” to close the “Options” window

8) Click “OK” to run the test

9) The results shows up in a new window.

10) Use the Bartlett’s test for testing the equal variances between five levels in this case since there are 
more than two levels in the data and the data of each level are normally distributed.
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Use Minitab to Run an ANOVA
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Use Minitab to Run an ANOVA

• The p-value of Barlett’s

test is 0.777, greater than 

the alpha level (0.05), so 

we fail to reject the null 

hypothesis and we claim 

that the variances of five 

groups are equal.

• If the variances are not all 

equal, we need to use 

other hypothesis testing 

methods other than one-

way ANOVA.
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Use Minitab to Run an ANOVA

• Step 3: Test whether the mean of the data for each level is equal to the 
means of other levels.

• Null Hypothesis (H0): μ1 = μ2 = μ3 = μ4 = μ5

• Alternative Hypothesis (Ha): at lease one of the means is different from others.

1) Click Stat → ANOVA → One-way.

2) A new window named “One-Way Analysis of Variance” pops up.

3) Select “Cost” as “Response.”

4) Select “Business” as “Factor.”

5) Click “Storage.”

6) Check the boxes next to “Fits” and “Residuals” 

7) Click “OK” to close the “Storage” window

8) Click “OK.”

9) The ANOVA results appear in the session window. The fitted response and the residuals 
are stored in the data table.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

714



www.ABTU.edu

Use Minitab to Run an ANOVA
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Use Minitab to Run an ANOVA

• Since the p-value of the F test is 

0.018, lower than the alpha level 

(0.05), the null hypothesis is 

rejected and we conclude that the 

at least one of the means of the 

five groups is different from others.
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Use Minitab to Run an ANOVA

• Step 4: Test whether the residuals are normally distributed with mean 

equal zero

1) The residuals have been stored in the data table in step 4.

2) Click Stat → Basic Statistics → Graphical Summary.

3) A new window named “Graphical Summary” appears.

4) Select “RESI” as the “Variables.”

5) Click “OK.”

6) The normality test results show up in a new window.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

717



www.ABTU.edu

Use Minitab to Run an ANOVA
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Use Minitab to Run an ANOVA

• The p-value of the normality 

test is 0.255, greater than the 

alpha level (0.05), and we 

conclude that the residuals 

are normally distributed.

• The mean of the residuals 

are 0.0000.
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Use Minitab to Run an ANOVA

• Step 5: Check whether the residuals are independent of each other.

• If the residuals are in time order, we can plot I-MR charts to check the 

independence. When no data points on the I-MR charts fail any tests, the 

residuals are independent of each other.

• If the residuals are not in time order, the I-MR charts cannot deliver reliable 

conclusion on the independence.

1) Click Stat → Control Charts → Variables Charts for Individuals → I-MR.

2) A new window named “Individuals – Moving Range Chart” pops up.

3) Select “RESI1” as the “Variables.”

4) Click “OK.”
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Use Minitab to Run an ANOVA
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Use Minitab to Run an ANOVA

• Step 6: Plot residuals versus fitted values and check whether there is 

any systematic pattern.

1) Click Graph → Scatter Plot.

2) A new window named “Scatterplots” pops up.

3) Click “OK.”

4) A new window named “Scatterplot – Simple” pops up.

5) Select the “RESI1” as the “Y variables.”

6) Select the “FITS1” as “X variables.”

7) Click “OK.”

8) The charts appears in a new window.

9) If the data points spread out evenly at any of the five levels, we claim that the 

residuals have equal variances across the five levels.
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Use Minitab to Run an ANOVA
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3.5 Hypothesis Testing: Non-Normal Data
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Black Belt Training: Analyze Phase

3.1 Patterns of Variation

3.1.1 Multi-Vari Analysis

3.1.2 Classes of Distributions

3.2 Inferential Statistics

3.2.1 Understanding Inference

3.2.2 Sampling Techniques and Uses

3.2.3 Sample Size

3.2.4 Central Limit Theorem

3.3 Hypothesis Testing

3.3.1 Goals of Hypothesis Testing

3.3.2 Statistical Significance

3.3.3 Risk; Alpha and Beta

3.3.4 Types of Hypothesis Tests

3.4 Hypothesis Testing: Normal Data

3.4.1 One and Two Sample T-Tests

3.4.2 One sample variance

3.4.3 One Way ANOVA

3.5 Hypothesis Testing: Non-Normal Data

3.5.1 Mann-Whitney

3.5.2 Kruskal-Wallis

3.5.3 Moods Median

3.5.4 Friedman

3.5.5 One Sample Sign

3.5.6 One Sample Wilcoxon

3.5.7 One and Two Sample Proportion

3.5.8 Chi-Squared (Contingency Tables)

3.5.9 Test of Equal Variances
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3.5.1 Mann-Whitney
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What is the Mann-Whitney Test?

• The Mann-Whitney test (also called Mann-Whitney U test or Wilcoxon 

rank-sum test) is a statistical hypothesis test to compare the medians 

of two populations that are not normally distributed.

• Null Hypothesis (H0): η1 = η2

• Alternative Hypothesis (Ha): η1 ≠ η2

where η1 is the median of one population and η1 is the median of the 

other population.
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Mann-Whitney Test Assumptions

• The sample data drawn from the populations of interest are unbiased 

and representative.

• The data of both populations are continuous or ordinal when the 

spacing between adjacent values is not constant.

• The two populations are independent to each other.

• The Mann-Whitney test is robust for the non-normally distributed 

population.

• The Mann-Whitney test can be used when shapes of the two 

populations’ distributions are different.
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How Mann-Whitney Test Works

• Step 1: Group the two samples from two populations (sample 1 is from 

population 1 and sample 2 is from population 2) into a single data set 

and then sort the data in ascending order ranked from 1 to n, where n 

is the total number of observations.

• Step 2: Add up the ranks for all the observations from sample 1 and 

call it R1. Add up the ranks for all the observations from sample 2 and 

call it R2.
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How Mann-Whitney Test Works

• Step 3: Calculate the test statistics

1
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where

n1 and n2 are the sample sizes.

R1 and R2 are the sum of ranks for observations from 

sample 1 and 2 respectively.
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How Mann-Whitney Test Works

• Step 4: Make a decision on whether to reject the null hypothesis.

• Null Hypothesis (H0): η1 = η2

• Alternative Hypothesis (Ha): η1 ≠ η2

• If both of the sample sizes are smaller than 10, the distribution of U 

under the null hypothesis is tabulated.

• The test statistic is U and, by using the Mann-Whitney table, we would find 

the p-value. 

• If the p-value is smaller than alpha level (0.05), we reject the null 

hypothesis.

• If the p-value is greater than alpha level (0.05), we fail to reject the null 

hypothesis.
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How Mann-Whitney Test Works

• If both sample sizes are greater than 10, the distribution of U can be 

approximated by a normal distribution. In other words, follows a 

standard normal distribution.

s

−
=

U
Zcalc

2

21nn
=

12

)1( 2121 ++
=

nnnn
s

where

s

−U

When |Zcalc| is greater than Z value at α/2 level (e.g., when α = 5%, 

the z value we compare |Zcalc| to is 1.96), we reject the null 

hypothesis.
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Use Minitab to Run a Mann-Whitney Test

• Case study: We are interested in comparing customer satisfaction 

between two types of customers using a nonparametric (i.e., 

distribution-free) hypothesis test: Mann-Whitney test.

• Data File: “Mann-Whitney” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): η1 = η2

• Alternative Hypothesis (Ha): η1 ≠ η2
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Use Minitab to Run a Mann-Whitney Test

• Steps to run a Mann-Whitney Test in Minitab:

1) Un-stack the data into two separate columns:

• “Overall Satisfaction 1” for customer type = 1

• “Overall Satisfaction 2” for customer type = 2

2) Click Stat → Nonparametrics → Mann-Whitney.

3) A new window named “Mann-Whitney” pops up.

4) Select “Overall Satisfaction 1” as the “First Sample.”

5) Select “Overall Satisfaction 2” as the “Second Sample.”

6) Click “OK.”

7) The Mann-Whitney test results appear in the session window.
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Use Minitab to Run a Mann-Whitney Test
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Use Minitab to Run a Mann-Whitney Test
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Use Minitab to Run a Mann-Whitney Test

• The p-value of the test is 

lower than alpha level (0.05); 

so we reject the null 

hypothesis and conclude that 

there is a statistically 

significant difference 

between the overall 

satisfaction medians of the 

two customer types.
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3.5.2 Kruskal-Wallis
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Kruskal-Wallis One-Way ANOVA

• The Kruskal-Wallis one-way analysis of variance is a statistical 

hypothesis test to compare the medians among more than two groups.

• Null Hypothesis (H0): η1 = η2 = … = ηk

• Alternative Hypothesis (Ha): at least one of the medians is different from 

others.

ηi is the median of population i, and k is the number of groups of our interest.

• It is an extension of Mann-Whitney test.

• If the distributions of k populations are not identically shaped or there 

are outliers in the distribution, Mood’s median test is a more robust 

than Kruskal-Wallis.
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Kruskal-Wallis One-Way ANOVA: Assumptions

• The sample data drawn from the populations of interest are unbiased 

and representative.

• The data of k populations are continuous or ordinal when the spacing 

between adjacent values is not constant.

• The k populations are independent to each other.

• The Kruskal-Wallis test is robust for the non-normally distributed 

population.
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How Kruskal-Wallis One-Way ANOVA Works

• Step 1: Group the k samples from k populations (sample i is from 

population i) into one single data set and then sort the data in 

ascending order ranked from 1 to N, where N is the total number of 

observations across k groups.

• Step 2: Add up the ranks for all the observations from sample i and call 

it ri, where i can be any integer between 1 and k.
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How Kruskal-Wallis One-Way ANOVA Works 

• Step 3: Calculate the test statistic





= =

=
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−
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n

j

ij
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
=

=
1 )1(

2

1
+= Nr

k is the number of groups.

ni is the sample size of sample i. 

N is the total number of all the observations across k groups.

rij is the rank (among all the observations) of observation j from 

group i.
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How Kruskal-Wallis One-Way ANOVA Works

• Step 4: Make a decision of whether to reject the null hypothesis.

• Null Hypothesis (H0): η1 = η2 =…= ηk

• Alternative Hypothesis (Ha): at least one of the medians is different from 

others.

• The test statistic follows chi-square distribution when the null 

hypothesis is true.

• If T is greater than        , we reject the null and claim there is at least one 

median statistically different from other medians.

• If T is smaller than       , we fail to reject the null and claim the medians of k 

groups are equal.

2

1−k

2

1−k
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Use Minitab to Run a Kruskal-Wallis One-Way ANOVA

• Case study: We are interested in comparing customer satisfaction 

among three types of customers using a nonparametric (i.e., 

distribution-free) hypothesis test: Kruskal-Wallis one-way ANOVA.

• Data File: “Kruskal-Wallis” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): η1 = η2 = η3

• Alternative Hypothesis (Ha): at least one of the customer types has different overall 

satisfaction levels from the others.
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Use Minitab to Run a Kruskal-Wallis One-Way ANOVA

• Steps to run a Kruskal-Wallis One-Way ANOVA in Minitab

1) Click Stat → Nonparametrics → Kruskal-Wallis.

2) A new window named “Kruskal-Wallis” pops up.

3) Select “Overall Satisfaction” as the “Response.”

4) Select “Customer Type” as the “Factor.”

5) Click “OK.”

6) The Kruskal-Wallis test results appear in the session window.
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Use Minitab to Run a Kruskal-Wallis One-Way ANOVA
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Use Minitab to Run a Kruskal-Wallis One-Way ANOVA

• The p-value of the test is lower than alpha level (0.05), and we reject 

the null hypothesis and conclude that at least the overall satisfaction 

median of one customer type is statistically different from the others.
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3.5.3 Mood’s Median
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What is Mood’s Median Test?

• Mood’s median test is a statistical test to compare the medians of two 
or more populations. 

• Null Hypothesis (H0): η1 = … = ηk

• Alternative Hypothesis (Ha): at least one of the medians is different from the 
others.

• k is the number of groups of our interest and is equal to or greater than 
two.

• Mood’s median is an alternative to Kruskal-Wallis.

• It is the extension of one sample sign test.

• For the data with outliers, Mood’s median test is more robust than the 
Kruskal-Wallis test.
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Mood’s Median Test Assumptions

• The sample data drawn from the populations of interest are unbiased 
and representative.

• The data of k populations are continuous or ordinal when the spacing 
between adjacent values is not constant.

• The k populations are independent to each other.

• The distributions of k populations have the same shape.

• Mood’s median test is robust for non-normally distributed populations.

• Mood’s median test is robust for data with outliers.
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How Mood’s Median Test Works

• Step 1: Group the k samples from k populations (sample i is from 

population i) into one single data set and get the median of this 

combined data set.

• Step 2: Separate the data in each sample into two groups. One 

consists of all the observations with values higher than the grand 

median and the other consists of all the observations with values lower 

than the grand median.
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How Mood’s Median Test Works

• Step 3: Run a Pearson’s chi-square test to determine whether to reject 

the null hypothesis.

• Null Hypothesis (H0): η1 = … = ηk

• Alternative Hypothesis (Ha): at least one of the medians is different from the 

others.

• If is greater than         , we reject the null hypothesis and claim that 

at least one median is different from the others.

• If is smaller than         , we fail to reject the null hypothesis and 

claim that the medians of k populations are not statistically different.

2

calc 2

crit

2

calc 2

crit
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Use Minitab to Run a Mood’s Median Test

• Case study: We are interested in comparing customer satisfaction 

among three types of customers using a nonparametric (i.e., 

distribution-free) hypothesis test: Mood’s median test.

• Data File: “Median Test” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): η1 = η2 = η3

• Alternative Hypothesis (Ha): at least one customer type has different 

overall satisfaction from the others.
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Use Minitab to Run a Mood’s Median Test

• Steps to run a Mood’s median test in Minitab

1) Click Stat → Nonparametrics → Mood’s Median Test.

2) A new window named “Mood’s Median Test” pops up.

3) Select “Overall Satisfaction” as the “Response.”

4) Select “Customer Type” as the “Factor.”

5) Click “OK.”

6) The Mood’s median test results appear in the session window.
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Use Minitab to Run a Mood’s Median Test
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Use Minitab to Run a Mood’s Median Test

• The p-value of the test is lower than alpha level (0.05), and we reject 

the null hypothesis and conclude that at least the overall satisfaction 

median of one customer type is statistically different from the others.
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3.5.4 Friedman
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What is the Friedman Test?

• The Friedman test is a hypothesis test used to detect the differences 

in the medians of various groups across multiple attempts.

• Null Hypothesis (H0): The treatments have identical effects (i.e., η1 = … = 

ηk).

• Alternative Hypothesis (Ha): At least one of the treatments has different 

effects from the others (i.e., at least one of the medians is statistically 

different from others).

• It is used as an alternative of the parametric repeated measures 

ANOVA when the assumption of normality or variance equality is not 

met. 
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Friedman Test Assumptions

• The sample data drawn from the populations of interest are unbiased 

and representative.

• The data are continuous or ordinal when the spacing between adjacent 

values is not constant.

• Results in one block are independent of the results in another.

• The Friedman test is robust for the non-normally distributed population.

• The Friedman test is robust for populations with unequal variances.
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How Friedman Test Works

• Step 1: Organize the data into a tabular view with n rows indicating the 

blocks and k columns indicating the treatments. Each observation xij is 

filled into the intersection of a specific block i and a specific treatment j.

• Step 2: Calculate the ranks of each observation within each block.

• Step 3: Replace the values in the table created in step 1 with the order 

rij (within a block) of the corresponding observation xij.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

760



www.ABTU.edu

How Friedman Test Works

• Step 4: Calculate the test statistic
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
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How Friedman Test Works

• Step 5: Make a decision of whether to reject the null hypothesis.

• When n > 15 or k > 4, the test statistic Q follows a chi-square distribution if 

the null hypothesis is true and the p-value is

• When n < 15 and k < 4, the test statistic Q does not approximate a chi-

square distribution and the p-value can be obtained from tables of Q for the 

Friedman test.

• If p-value > alpha level (0.05), we fail to reject the null.

( )QP k −

2

1
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Friedman Test Examples

• A number of n water testers judge the quality of k different water 

samples, each of which is from a distinct water source. We will apply a 

Friedman Test to determine whether the water qualities of the k 

sources are the same.

• There are n blocks and k treatments in this experiment.

• One tester’s decision would not have any influence on other testers.

• When running the experiment, each tester judges the water in a 

random sequence.
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Use Minitab to Run a Friedman Test

• Case study: We are interested in comparing the effect of a drug 

treatment on enzyme activity. Three different drug therapies were given 

to four animals and each animal belongs to a different litter.

• Data File: “Friedman.MTW,”
(Note: this is a different data source than what you have been using to this point)

• Null Hypothesis (H0): η1 = η2 = η3

• Alternative Hypothesis (Ha): at least one treatment effect is statistically 

different from the others.
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Use Minitab to Run a Friedman Test

• Steps to run a Friedman test in Minitab

1) Click Stat → Nonparametrics → Friedman.

2) A new window named “Friedman” pops up.

3) Select “EnzymeActivity” as the “Response.”

4) Select “Therapy” as the “Treatment.”

5) Select “Litter” as the “Blocks.”

6) Click “OK.”

7) The Friedman test results appear in the session window.
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Use Minitab to Run a Friedman Test
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Use Minitab to Run a Friedman Test

• The p-value of the Friedman 

test is greater than alpha level 

(0.05). We fail to reject the null 

hypothesis and conclude that 

there is not any statistically 

significant difference between 

the treatment effects.
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3.5.5 One Sample Sign
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What is the One Sample Sign Test? 

• The one sample sign test is a hypothesis test to compare the median 

of a population with a specified value.

• Null Hypothesis (H0): η = η0

• Alternative Hypothesis (Ha): η ≠ η0

• It is an alternative test of one sample t-test when the distribution of the 

data is non-normal. It is robust for the data with non-symmetric 

distribution. 
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One Sample Sign Test Assumptions

• The sample data drawn from the population of interest are unbiased 

and representative.

• The data are continuous or ordinal when the spacing between adjacent 

values is not constant.

• The one sample sign test is robust for the non-normally distributed 

population.

• The one sample sign test does not have any assumptions on the 

distribution. It is a distribution-free test.
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How the One Sample Sign Test Works

• Step 1: Separate the sample set of data into two groups: one with 

values greater than and the other with values less than the 

hypothesized median η0. Count the number of observations in each 

group.

• Step 2: Calculate the test statistic.

• If the null hypothesis is true, the number of observations in each group 

should not be significantly different from half of the total sample size. 

• The test statistic follows a binomial distribution when the null is true. When 

n is large, we use the normal distribution to approximate the binomial 

distribution.
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How the One Sample Sign Test Works

• Step 3: Make a decision on whether to reject the null hypothesis. If the 

|Zcalc| is smaller than Zcrit, we fail to reject the null hypothesis and claim 

that there is no significant difference between the population median 

and the hypothesized median.

Test Statistic:

)1( pnp

npn
Zcalc

−

−
= +

where

n+ is the number of observations with values greater than the hypothesized median.

n is the total number of observations .

p is 0.5.
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Use Minitab to Run a One Sample Sign Test

• Case study: We are interested in comparing the overall satisfaction of 

customer type 1 against a specified benchmark satisfaction (3.5) using 

a nonparametric (i.e., distribution-free) hypothesis test: one sample 

sign test.

• Data File: “One Sample Wilcoxon” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): η1 = 3.5

• Alternative Hypothesis (Ha): η1 ≠ 3.5
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Use Minitab to Run a One Sample Sign Test

• Steps to run a one sample sign test in Minitab

1) Click Stat → Nonparametrics → 1-Sample Sign.

2) A new window named “1-Sample Sign” pops up.

3) Select “Overall Satisfaction” as the “Variables.”

4) Click the box of “Test median.”

5) Enter “3.5” in the box next to “Test median.”

6) Click “OK.”

7) The one sample sign test results appear in session window.
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Use Minitab to Run a One Sample Sign Test
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Use Minitab to Run a One Sample Sign Test

• The p-value of the one 

sample sign test is 1.0000, 

higher than the alpha level 

(0.05), and we fail to reject 

the null hypothesis. There 

is not any statistically 

significant difference 

between the overall 

satisfaction of customer 

type 1 and the benchmark 

satisfaction level. 
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3.5.6 One Sample Wilcoxon
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What is the One Sample Wilcoxon Test?

• The one sample Wilcoxon test is a hypothesis test to compare the 

median of one population with a specified value.

• Null Hypothesis (H0): η = η0

• Alternative Hypothesis (Ha): η ≠ η0

• It is an alternative test of one sample t-test when the distribution of the 

data is non-normal.

• It is more powerful than one sample sign test but it assumes the 

distribution of the data is symmetric.
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One Sample Wilcoxon Test Assumptions

• The sample data drawn from the population of interest are unbiased 

and representative.

• The data are continuous or ordinal when the spacing between adjacent 

values is not constant.

• The distribution of the data is symmetric about a median.

• The one sample Wilcoxon test is robust for the non-normally distributed 

population.
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How the One Sample Wilcoxon Test Works

• Step 1: Create the following columns one by one:

• Column 1: all the raw observations (X)

• Column 2: the differences between each observation value and the 

hypothesized median (X – η0)

• Column 3: the signs (+ or –) of column 2

• Column 4: the absolute value of column 2

• Column 5: the ranks of each item in column 4 in ascending order

• Column 6: the product of column 3 and column 5
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How the One Sample Wilcoxon Test Works

• Step 2: Calculate the test statistic Wcalc , which is the sum of all the 

non-negative values in column 6.

• Step 3: Make a decision on whether to reject the null hypothesis. Use 

the table of critical values for the Wilcoxon test to get the Wcrit with 

predetermined alpha level and number of observations. 

• If the Wcalc is smaller than the Wcrit, we fail to reject the null hypothesis and 

claim that there is no significant difference between the population median 

and the hypothesized median.
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Use Minitab to Run a One Sample Wilcoxon Test

• Case study: We are interested in comparing the overall satisfaction of 

customer type 1 against a specified benchmark satisfaction (3.5) using 

a nonparametric (i.e., distribution-free) hypothesis test: one sample 

Wilcoxon test.

• Data File: “One Sample Wilcoxon” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): η1 = 3.5

• Alternative Hypothesis (Ha): η1 ≠ 3.5

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

782



www.ABTU.edu

Use Minitab to Run a One Sample Wilcoxon Test

• Steps to run a one sample Wilcoxon test in Minitab

1) Click Stat → Nonparametrics → 1-Sample Wilcoxon.

2) A new window named “1-Sample Wilcoxon” pops up. 

3) Select “Overall Satisfaction” as the “Variables.”

4) Click the radio button “Test median.”

5) Enter “3.5” in the box next to “Test median.”

6) Click “OK.”

7) The one sample Wilcoxon test results appear in the session window.
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Use Minitab to Run a One Sample Wilcoxon Test
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Use Minitab to Run a One Sample Wilcoxon Test

• The p-value of the one 

sample Wilcoxon test is 

0.557, higher than the alpha 

level (0.05), and we fail to 

reject the null hypothesis. 

There is not any statistically 

significant difference between 

the overall satisfaction of 

customer type 1 and the 

benchmark satisfaction level. 
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3.5.7 One & Two Sample Proportion
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What is the One Sample Proportion Test?

• One sample proportion test is a hypothesis test to compare the 

proportion of one certain outcome occurring in a population following 

the binomial distribution with a specified proportion.

• Null Hypothesis (H0): p = p0

• Alternative Hypothesis (Ha): p ≠ p0
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One Sample Proportion Test Assumptions

• The sample data drawn from the population of interest are unbiased 

and representative.

• There are only two possible outcomes in each trial: success/failure, 

yes/no, and defective/non-defective etc.

• The underlying distribution of the population is binomial distribution.

• When np ≥ 5 and np(1 – p) ≥ 5, the binomial distribution can be 

approximated by the normal distribution.
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How the One Sample Proportion Test Works

• When np ≥ 5 and np(1 – p) ≥ 5, we use normal distribution to 

approximate the underlying binomial distribution of the population.

Test Statistic: 

n

pp

pp
Zcalc

)1(

ˆ

00

0

−

−
=

where

p̂ is the observed probability of one certain outcome occurring.

0p is the hypothesized probability.

n is number of trials.

When |Zcalc| is smaller than Zcrit, we fail to reject the null hypothesis and claim that there is no 

statistically significant difference between the population proportion and the hypothesized proportion. 
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• Case study: We are interested in comparing the exam pass rate of a 

high school this month against a specified rate (70%) using a 

nonparametric (i.e., distribution-free) hypothesis test: one sample 

proportion test.

• Data File: “One Sample Proportion” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): p = 70%

• Alternative Hypothesis (Ha): p ≠ 70%

Use Minitab to Run a One Sample Proportion Test
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Use Minitab to Run a One Sample Proportion Test

• Steps to run a one sample proportion test in Minitab.

1) Click Stat → Basic Statistics → 1 Proportion.

2) A new window named “1 Proportion (Test and Confidence Interval)” appears.

3) Click on the drop down menu and select “Summarized data.”

4) Enter “77” in the box of “Number of events.”

5) Enter “105” in the box of “Number of trials.”

6) Check the box “Perform hypothesis test.”

7) Enter “0.70” as the “Hypothesized proportion.”

8) Click “OK.”

9) The one sample proportion test results appear in the session window.
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Use Minitab to Run a One Sample Proportion Test
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Use Minitab to Run a One Sample Proportion Test

• The p-value of the one sample 

proportion test is 0.460, greater 

than the alpha level (0.05), and 

we fail to reject the null 

hypothesis.

• We conclude that the exam pass 

rate of the high school this month 

is not statistically different from 

70%.
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What is the Two Sample Proportion Test?

• The two sample proportion test is a hypothesis test to compare the 

proportions of one certain event occurring in two populations following 

the binomial distribution.

• Null Hypothesis (H0): p1 = p2

• Alternative Hypothesis (Ha): p1 ≠ p2
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Two Sample Proportion Test Assumptions

• The sample data drawn from the populations of interest are unbiased 

and representative.

• There are only two possible outcomes in each trial for both populations: 

success/failure, yes/no, and defective/non-defective etc.

• The underlying distributions of both populations are binomial 

distribution.

• When np ≥ 5 and np(1 – p) ≥ 5, the binomial distribution can be 

approximated by the normal distribution.
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How the Two Sample Proportion Test Works

• When np ≥ 5 and np(1 – p) ≥ 5, we use normal distribution to 

approximate the underlying binomial distributions of the populations.

Test Statistic:

( ) 







+−

−
=

21

00

21

11
ˆ1ˆ

ˆˆ

nn
pp

pp
Z

where
21

21
0
ˆ

nn

xx
p

+

+
=

1p̂ and      are the observed proportions of events in the two samples.2p̂

and      are the number of trials in the two samples respectively.1n 2n

and      are the number of events in the two samples respectively.1x 2x

When |Zcalc| is smaller than Zcrit, we fail to reject the null hypothesis.
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Use Minitab to Run a Two Sample Proportion Test

• Case study: We are interested in comparing the exam pass rates of a 

high school in March and April using a nonparametric (i.e., distribution-

free) hypothesis test: two sample proportion test.

• Data File: “Two Sample Proportion” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): pMarch = pApril

• Alternative Hypothesis (Ha): pMarch ≠ pApril
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Use Minitab to Run a Two Sample Proportion Test

• Steps to run a two sample proportion test in Minitab

1) Click Stat → Basic Statistics → 2 Proportions.

2) A new window named “2 Proportions (Test and Confidence Interval)” pops up.

3) Choose “Summarized data” from the dropdown menu

4) Enter “89” in the box intersecting “First” and “Events.”

5) Enter “112” in the box intersecting “First” and “Trials.”

6) Enter “102” in the box intersecting “Second” and “Events.”

7) Enter “130” in the box intersecting “Second” and “Trials.”

8) Click “OK.”

9) The two sample proportion test results appear in the session window.
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Use Minitab to Run a Two Sample Proportion Test
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Use Minitab to Run a Two Sample Proportion Test

• The p-value of the two sample proportion 

test is 0.849, greater than the alpha level 

(0.05), and we fail to reject the null 

hypothesis.

• We conclude that the exam pass rates of 

the high school in March and April are 

not statistically different.
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3.5.8 Chi-Squared (Contingency Tables)
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What is the Chi-Square Test?

• A chi-square test is a hypothesis test in which the sampling 

distribution of the test statistic follows a chi-square distribution when 

the null hypothesis is true.

• There are multiple chi-square tests available and in this module we will 

cover the Pearson’s chi-square test used in contingency analysis.

• Null Hypothesis (H0): p1 = p2 =… = pk

• Alternative Hypothesis (Ha): at least on of the proportions is different from 

others.

• k is the number of populations of our interest. k ≥ 2.
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What is the Chi-Square Test?

• The chi-square test can also be used to test whether two factors are 

independent of each other. In other words, it can be used to test 

whether there is any statistically significant relationship between two 

discrete factors. 

• Null Hypothesis (H0): Factor 1 is independent of factor 2.

• Alternative Hypothesis (Ha): Factor 1 is not independent of factor 2.
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Chi-Square Test Assumptions

• The sample data drawn from the populations of interest are unbiased 

and representative.

• There are only two possible outcomes in each trial for an individual 

population: success/failure, yes/no, and defective/non-defective etc.

• The underlying distribution of each population is binomial distribution.

• When np ≥ 5 and np(1 – p) ≥ 5, the binomial distribution can be 

approximated by the normal distribution.
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How Chi-Square Test Works

• Test Statistic


=

−
=

n

i i

ii
calc

E

EO

1

2
2 )(



where

Oi is an observed frequency. 

Ei is an expected frequency. 

N is the number of cells in the contingency table.

If        is smaller than , we fail to reject the null hypothesis.
2

calc 2

crit
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Use Minitab to Run a Chi-Square Test

• Case study 1: We are interested in comparing the product quality exam 

pass rates of three suppliers A, B, and C using a nonparametric (i.e., 

distribution-free) hypothesis test: chi-square test.

• Data File: “Chi-Square Test1” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): pA = pB = pC

• Alternative Hypothesis (Ha): at least one of the suppliers has different 

pass rates from the others.
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Use Minitab to Run a Chi-Square Test

• Steps to run a chi-square test in Minitab

1) Click Stat → Tables → Cross Tabulation and Chi-Square.

2) A new window named “Cross Tabulation and Chi-Square” pops up.

3) Select “Results” as “For rows.”

4) Select “Supplier” as “For columns.”

5) Select “Count” as “Frequencies are in.”

6) Click the “Chi-Square” button.

7) A new window named “Cross Tabulation – Chi-Square” pops up.

8) Check the boxes of “Chi-square test”, “Expected cell counts,” and “Each cell’s 
contribution to the Chi-Square statistic.”

9) Click “OK” in the window named “Cross Tabulation – Chi-Square.”

10) Click “OK” in the window named “Cross Tabulation and Chi-Square.”

11) The Chi-square test results appear in the session window.
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Use Minitab to Run a Chi-Square Test
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Use Minitab to Run a Chi-Square Test

• Counts are based on the sample 

observation.

• Expected counts are based on the 

assumption that the null hypothesis is 

true.

• Since the p-value is smaller than 

alpha level (0.05), we reject the null 

hypothesis and claim that at least one 

supplier has different pass rate from 

others.
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Use Minitab to Run a Chi-Square Test

• Case study 2: We are trying to check whether there is a relationship 

between the suppliers and the results of the product quality exam using 

nonparametric (i.e., distribution-free) hypothesis test: chi-square test. 

• Data File: “Chi-Square Test2” tab in “Sample Data.xlsx”

• Null Hypothesis (H0): product quality exam results are independent of 

the suppliers.

• Alternative Hypothesis (Ha): product quality exam results depend on 

the suppliers.
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Use Minitab to Run a Chi-Square Test

• Steps to run a chi-square test in Minitab

1) Click Stat → Tables → Cross Tabulation and Chi-Square.

2) A new window named “Cross Tabulation and Chi-Square” pops up.

3) Select “Results” as “For rows.”

4) Select “Supplier” as “For columns.”

5) Select “Count” as “Frequencies are in.”

6) Click the “Chi-Square” button.

7) Check the boxes of “Chi-square analysis”, “Expected cell counts,” and “Each 

cell’s contribution to the Chi-Square statistic.”

8) Click “OK” in the window named “Cross Tabulation – Chi-Square.”

9) Click “OK” in the window named “Cross Tabulation and Chi-Square.”

10) The Chi-square test results appear in the session window.
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Use Minitab to Run a Chi-Square Test
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Use Minitab to Run a Chi-Square Test

• The p-value is smaller than the alpha 

level (0.05) and we reject the null 

hypothesis. 

• The product quality exam results are 

not independent of the suppliers.
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3.5.9 Tests of Equal Variance
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What are Tests of Equal Variance?

• Tests of equal variance are a family of hypothesis tests used to check 

whether there is a statistically significant difference between the 

variances of two or more populations.

• Null Hypothesis (H0): 

• Alternative Hypothesis (Ha): at least the variance of one population is 

different from others.

• k is the number of populations of interest. k ≥ 2.

• A tests of equal variance can be used alone but most of the time it is 

used with other statistical methods to verify or support the assumption 

about the variance equality.
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F-Test

• The F-test is used to compare the variances between two normally 

distributed populations.

• It is extremely sensitive to non-normality and serves as a preliminary 

step for two sample t-test.

• Test Statistic:

2

2

2

1

s

s
Fcalc = , where and s2 are the sample standard deviations

The sampling distribution of the test statistic follows F distribution when the null is true.
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Bartlett’s Test

• Bartlett’s test is used to compare the variances among two or more 

normally distributed populations.

• It is sensitive to non-normality and it serves as a preliminary step for 

ANOVA.

• Test Statistic:
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The sampling distribution of test statistic follows chi2 distribution when the null is true.
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Brown-Forsythe Test

• The Brown-Forsythe test is used to compare the variances between 

two or more populations with any distributions.

• It is not so sensitive to non-normality as Bartlett’s test.

• The Test statistic is the model F statistic from the ANOVA on the 

transformed response where      is the median response at 

ith level.
iijij yyz ~−= iy~
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Levene’s Test

• Levene’s test is used to compare the variances between two or more 

populations with any distributions.

• It is not so sensitive to non-normality as Bartlett’s test.

• The test statistic is the model F statistic from the ANOVA on the 

transformed response where     is the mean response at ith

level.
iijij yyz −= iy
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Brown-Forsythe Test vs. Levene’s Test
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where

is the total number of observations. 

k is the number of groups. 

Ni is the number of observations in the ith group.

Zi. is the group mean of the ith group.

Z.. is the grand mean of all the observations.

, where      is the group median of the ith group.
ijY

~
ijijij YYZ

~
−=In Brown-Forsythe Test

ijijij YYZ −= , where      is the group mean of the ith group.
ijYIn Levene’s Test, 
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Use Minitab to Run Tests of Equal Variance

• Case study: We are interested in comparing the variances of the retail 

price of a product in state A and state B.

• Data File: “Two-Sample T-Test” tab in “Sample Data.xlsx”

• Null Hypothesis (H0):

• Alternative Hypothesis (Ha): 

22

BA ss =
22

BA ss 
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Use Minitab to Run Tests of Equal Variance

• Step 1: Run the normality test to check whether all levels of data 

are normally distributed

1) Click Stat → Basic Statistics → Graphical Summary.

2) A new window named “Graphical Summary” pops up.

3) Select “Retail Price” as the “Variables.”

4) Click in the blank box right below “By variables” and the “State” 

appears in the list box on the left.

5) Select “State” as “By variables.”

6) Click “OK.”

7) The normality test results appear in the new windows.
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Use Minitab to Run Tests of Equal Variance
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Use Minitab to Run Tests of Equal Variance

• Null Hypothesis (H0): The data are normally distributed.

• Alternative Hypothesis (Ha): The data are not normally distributed.

• Both retail price data of state A and B are normally distributed since the p-values are both greater than 

alpha level (0.05).
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Use Minitab to Run Tests of Equal Variance

• Step 2: Run tests of equal variance in Minitab

1) Click Stat → ANOVA → Test for Equal Variances.

2) A new window named “Test for Equal Variances” pops up.

3) Select “Retail Price” as the “Response.”

4) Select “State” as “Factors.”

5) Click “Options”

6) Check “Use test based on normal distribution”

7) Click “OK” to close the Options window

8) Click “OK.”

9) The results of variances equality tests appear in the new window.
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Use Minitab to Run Tests of Equal Variance
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Use Minitab to Run Tests of Equal Variance

• If all the groups of data are 
normally distributed, use the F-test 
or Bartlett’s test in Minitab to test 
the equality of the variances.

• If at least one of the groups is 
not normally distributed, use 
Levene’s test in Minitab to test the 
equality of the variances.

• If the p-value of the variances 
equality test is greater than the alpha 
level (0.05), we fail to reject the null 
hypothesis and conclude that the 
variances of different groups are 
identical.
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Hypothesis Testing Roadmap: Putting it all together
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4.0 Improve Phase
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Black Belt Training: Improve Phase

4.1 Simple Linear Regression

4.1.1 Correlation

4.1.2 X-Y Diagram

4.1.3 Regression Equations

4.1.4 Residuals Analysis

4.2 Multiple Regression Analysis

4.2.1 Non-Linear Regression

4.2.2 Multiple Linear Regression

4.2.3 Confidence Intervals

4.2.4 Residuals Analysis

4.2.5 Data Transformation, Box Cox

4.2.6 Stepwise Regression

4.2.7 Logistic Regression

4.3 Designed Experiments

4.3.1 Experiment Objectives

4.3.2 Experimental Methods

4.3.3 DOE Design Considerations

4.4 Full Factorial Experiments

4.4.1 2k Full Factorial Designs

4.4.2 Linear and Quadratic Models

4.4.3 Balanced and Orthogonal Designs

4.4.4 Fit, Model, and Center Points

4.5 Fractional Factorial Experiments

4.5.1 Designs

4.5.2 Confounding Effects

4.5.3 Experimental Resolution
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4.1 Simple Linear Regression
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Black Belt Training: Improve Phase

4.1 Simple Linear Regression

4.1.1 Correlation

4.1.2 X-Y Diagram

4.1.3 Regression Equations

4.1.4 Residuals Analysis

4.2 Multiple Regression Analysis

4.2.1 Non-Linear Regression

4.2.2 Multiple Linear Regression

4.2.3 Confidence Intervals

4.2.4 Residuals Analysis

4.2.5 Data Transformation, Box Cox

4.2.6 Stepwise Regression

4.2.7 Logistic Regression

4.3 Designed Experiments

4.3.1 Experiment Objectives

4.3.2 Experimental Methods

4.3.3 DOE Design Considerations

4.4 Full Factorial Experiments

4.4.1 2k Full Factorial Designs

4.4.2 Linear and Quadratic Models

4.4.3 Balanced and Orthogonal Designs

4.4.4 Fit, Model, and Center Points

4.5 Fractional Factorial Experiments

4.5.1 Designs

4.5.2 Confounding Effects

4.5.3 Experimental Resolution
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4.1.1 Correlation
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What is Correlation?

• Correlation is a statistical technique that describes whether and how 

strongly two or more variables are related.

• Correlation analysis helps to understand the direction and degree of 

association between variables, and it suggests whether one variable 

can be used to predict another.

• Of the different metrics to measure correlation, Pearson’s correlation 

coefficient is the most popular. It measures the linear relationship 

between two variables.
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Pearson’s Correlation Coefficient

• Pearson’s correlation coefficient is also called:

• Pearson’s r or coefficient of correlation 

• Pearson’s product moment correlation coefficient (r)

• “r” is a statistic measuring the linear relationship between two 

variables.

• Correlation coefficients range from -1 to 1.

• If r = 0, there is no linear relationship between the variables.

• The sign of r indicates the direction of the relationship:
• If r < 0, there is a negative linear correlation.

• If r > 0, there is a positive linear correlation.

• The absolute value of r describes the strength of the relationship:
• If |r| ≤ 0.5, there is a weak linear correlation.

• If |r| > 0.5, there is a strong linear correlation.

• If |r| = 1, there is a perfect linear correlation.
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Pearson’s Correlation Coefficient

• When the correlation is strong, the data points on a scatter plot will be 

close together (tight).

• The closer “r” is to -1 or 1, the stronger the relationship.

• -1 Strong inverse relationship

• +1 Strong direct relationship

• When the correlation is weak, the data points are spread apart more 

(loose). 

• The closer the correlation is to 0 the weaker the relationship.
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Pearson’s Correlation Coefficient

• Pearson’s correlation coefficient is only sensitive to the linear

dependence between two variables. 

• It is possible that two variables have a perfect non-linear relationship 

when the correlation coefficient is low.

• Notice the scatter plots below with correlation equal to 0. There are 

clearly relationships but they are not linear and therefore can not be 

determined with Pearson’s correlation coefficient.
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Correlation and Causation

• Correlation does not imply causation.

• If variable A is highly correlated with variable B, it does not necessarily 

mean A causes B or vice versa. It is possible that an unknown third 

variable C is causing both A and B to change.

• For example, if ice cream sales at the beach are highly correlated with 

the number of shark attacks, it does not imply that increased ice cream 

sales causes increased shark attacks. They are triggered by a third 

factor: summer. 
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Correlation and Dependence

• If two variables are independent, the correlation coefficient is zero.

• WARNING! If the correlation coefficient of two variables is zero, it does 

not imply they are independent.

• The correlation coefficient only indicates the linear dependence 

between two variables. When variables are non-linearly related, they 

are not independent of each other but their correlation coefficient could 

be zero.
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Correlation Coefficient and X-Y Diagram

• The correlation coefficient indicates the direction and strength of the 

linear dependence between two variables but it does not cover all the 

existing relationship patterns.

• With the same correlation coefficient, two variables might have 

completely different dependence patterns.

• A scatter plot or X-Y diagram can help to discover and understand 

additional characteristics of the relationship between variables.

• Correlation coefficient is not a replacement for examining the scatter 

plot to study the variables’ relationship.
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Statistical Significance of the Correlation Coefficient

• The correlation coefficient could be high or low by chance 

(randomness). It may have been calculated based on two small 

samples that do not provide good inference on the correlation between 

two populations. 

• In order to test whether there is a statistically significant relationship 

between two variables, we need to run a hypothesis test to determine 

whether the correlation coefficient is statistically different from zero.

• Hypothesis Test Statements

• H0: r = 0: Null Hypothesis: There is no correlation.

• H1: r ≠ 0: Alternate Hypothesis: There is a correlation.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

841



www.ABTU.edu

Statistical Significance of the Correlation Coefficient

• Hypothesis tests will produce p-values as a result of the statistical 

significance test on r.

• When the p-value for a test is low (less than 0.05), we can reject the null 

hypothesis and conclude that “r” is significant; there is a correlation.

• When the p-value for a test is > 0.05, then we fail to reject the null 

hypothesis; there is no correlation.

• We can also use the t statistic to draw the same conclusions regarding 

our test for significance of the correlation coefficient.
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Statistical Significance of the Correlation Coefficient

• Test Statistic: 

• Critical Statistic: t-value in t-table with (n – 2) degrees of freedom

• If |t| ≤ tcritical, we fail to reject the null. There is no statistically significant 

linear relationship between X and Y.

• If |t| > tcritical, we reject the null. There is a statistically significant linear 

relationship between X and Y.
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Using Software to Calculate the Correlation Coefficient 

• We are interested in understanding whether there is linear dependence 

between a car’s MPG and its weight and if so, how they are related.

• The MPG and weight data are stored in the “Correlation Coefficient” 

tab in “Sample Data.xlsx.” We will discuss three ways to get the results. L
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Use Excel to Calculate the Correlation Coefficient

• The formula CORREL in Excel calculates the sample correlation 

coefficient of two data series.

• The correlation coefficient between the two data series is -0.83, which 

indicates a strong negative linear relationship between MPG and 

weight.
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Use Minitab to Calculate the Correlation Coefficient 

• Step 1: Stat → Basic Statistics → Correlation.

• Step 2: Select the two variables of interest in the pop-up window 

“Correlation” and click “OK.”

• The correlation coefficient result (-0.832) appears in the session 

window. The p-value (0.000) is lower than the alpha level (0.05), 

indicating the linear correlation is statistically significant.
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Use Minitab to Calculate the Correlation Coefficient 
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Interpreting Results

• How do we interpret results and make decisions based Pearson’s 
correlation coefficient (r) and p-values?

• Let us look at a few examples:

• r = -0.832, p = 0.000 (previous example). The two variables are inversely 
related and the linear relationship is strong. Also, this conclusion is significant 
as supported by p-value of 0.00.

• r = -0.832, p = 0.71. Based on r, you should conclude the linear relationship 
between the two variables is strong and inversely related. However, with a p-
value of 0.71, you should then conclude that r is not significant and that your 
sample size may be too small to accurately characterize the relationship.

• r = 0.5, p = 0.00. Moderately positive linear relationship, r is statistically 
significant.

• r = 0.92, p = 0.61. Strong positive linear relationship but r is not statistically 
significant. Get more data.

• r = 1.0, p = 0.00. The two variables have a perfect linear relationship and r is 
significant.
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Correlation Coefficient Calculation

• Population Correlation Coefficient (ρ)

• Sample Correlation Coefficient (r)

• It is only defined when the standard deviations of both X and Y are 

non-zero and finite.

• When covariance of X and Y is zero, the correlation coefficient is zero.
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4.1.2 X-Y Diagram
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What is an X-Y Diagram?

• An X-Y diagram is a scatter plot depicting the relationship between two 

variables (i.e., X and Y).

• Each point on the X-Y diagram represents a pair of X and Y values, 

with X plotted on the horizontal axis and Y plotted on the vertical axis.

• With an X-Y diagram, you can qualitatively assess both the strength 

and direction of the relationship between X and Y.

• To quantitatively measure the relationship between X and Y, you may 

need to calculate the correlation coefficient.
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Example 1: Perfect Linear Correlation

• In the chart below, there are 10 data points depicted (10 pairs of X and 

Y values), and they were created using the equation Y = 2X. 

• As a result, all the data points fall onto the straight line of Y = 2X.

• The chart demonstrates a perfect positive linear correlation between X 

and Y since the relationship between X and Y can be perfectly 

described by a linear equation in a format of Y = a × X + b where a ≠ 0.

X Y

1 2

2 4

3 6

4 8

5 10

6 12

7 14

8 16

9 18

10 20
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Example 2: Strong Linear Correlation

• In this chart, the data points scatter closely around a straight line. 

• When X increases, Y increases accordingly. 

• This chart demonstrates a strong positive linear correlation between X 

and Y. 

• The straight line is the trend line showing how Y’s trend goes with 

changes in X.

X Y

1 2

2 5

3 6

4 7

5 10

6 13

7 15

8 16

9 19

10 22
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Example 3: Weak Linear Correlation

• In this chart, the data points scatter remotely around a straight line. 

• When X increases, Y increases accordingly. 

• This chart demonstrates a weak positive linear correlation between X 

and Y since the distance between the data points and the trend line is 

relatively far on average.

X Y

1 3

2 11

3 7

4 1

5 10

6 2

7 15

8 3

9 11

10 10
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Example 4: Non-Linear Correlation

• The X-Y diagram also helps to identify any nonlinear relationship 

between X and Y.

X Y

1 2.84

2 2.91

3 2.14

4 1.24

5 1.04

6 1.72

7 2.66

8 2.99

9 2.41

10 1.46

X Y

1 35

2 26

3 19

4 14

5 11

6 10

7 11

8 14

9 19

10 26
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Example 5: Uncorrelated

• In this chart, the Y value of each data point is a constant regardless of 

what the X value is.

• Changes in X do not show any relative impact on Y. As a result, there is 

no correlation between X and Y.

X Y

1 5

2 5

3 5

4 5

5 5

6 5

7 5

8 5

9 5

10 5

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

856



www.ABTU.edu

Example 6: Outlier Identification

• Using X-Y diagram, you may identify outliers in the data. 

• In this chart, the last data point does not seem to follow the trend of 

other data points. 

• This should require further investigation on the last data point to 

determine whether it is an outlier.

X Y

1 2

2 5

3 6

4 7

5 10

6 13

7 15

8 16

9 19

10 58
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Benefits of Using an X-Y Diagram

• An X-Y diagram graphically demonstrates the relationship between two 

variables.

• It suggests whether two variables are associated and helps to identify 

the linear or nonlinear correlation between X and Y.

• It captures the strength and direction of the relationship between X and 

Y.

• It helps identify any outliers in the data. 
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Limitations of the X-Y Diagram

• Although the X-Y diagram helps to “spot” interesting features in the 

data, it does not provide any quantitative conclusions about the data 

and further statistical analysis is needed to:

• Assess whether the association between variables is statistically 

significant. 

• Measure the strength of the relationship between variables.

• Determine whether outliers exist in the data.

• Quantitatively describe the pattern of the data.
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4.1.3 Regression Equations

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

860



www.ABTU.edu

Correlation and Regression Analysis

• The correlation coefficient answers the following questions:

• Are two variables correlated?

• How strong is the relationship between two variables?

• When one variable increases, does the other variable increase or 

decrease?

• The correlation coefficient cannot address the following questions:

• How much does one variable changes when the other variable changes by 

one unit?

• How can we set the value of one variable to obtain a targeted value of the 

other variable?

• How can we use the relationship between two variables to make 

predictions?

• The simple linear regression analysis helps to answer these questions. 
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What is Simple Linear Regression?

• Simple linear regression is a statistical technique to fit a straight line 

through the data points.

• It models the quantitative relationship between two variables.

• It describes how one variable changes according to the change of 

another variable.

• Both variables need to be continuous.

• It is simple because only one predictor variable is involved.
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Simple Linear Regression Equation

• The simple linear regression analysis fits the data to a regression 

equation in the form 

Y = α × X + β + e

where:

• Y is the dependent variable (the response) and X is the single independent 

variable (the predictor). 

• α is the slope describing the steepness of the fitting line. β is the intercept 

indicating the Y value when X is equal to 0.

• e stands for error (residual). It is the difference between the actual Y and 

the fitted Y (i.e., the vertical difference between the data point and the 

fitting line).
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Ordinary Least Squares

• The ordinary least square is a statistical method used in linear 

regression analysis to find the best fitting line for the data points.

• It estimates the unknown parameters of the regression equation by 

minimizing the sum of squared residuals (i.e. the vertical difference 

between the data point and the fitting line).

• In mathematical language, we look for α and β that satisfy the following 

criteria:

),(min
,




Q
2

11

2
)(),( i

n

i

i

n

i

i xyeQ  −−== 
==

where

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

864



www.ABTU.edu

Ordinary Least Squares

• The actual value of the dependent variable:

• The fitted value of the dependant variable:

• By using calculus, it can be shown the sum of squared error is minimal 

when
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ANOVA in Simple Linear Regression

X Y

1 5

2 5

3 8

4 7

5 10

6 15

7 15

8 16

9 20

10 22

X: the independent variable that we 

use to predict;

Y: the dependent variable that we 

want to predict.

Total Variation = Total Sums of Squares = 

Explained Variation = Regression Sums of Squares = 

Unexplained Variation =  Error Sums of Squares = 
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ANOVA in Simple Linear Regression

• Linear regression is also analysis of variance (ANOVA). 

• Variation Components:

• Total Variation = Explained Variation + Unexplained Variation

i.e., Total Sums of Squares = Regression Sums of Squares + Error Sums of 

Squares

• Degrees of Freedom Components

• Total Degrees of Freedom = Regression Degrees of Freedom + Residual 

Degrees of Freedom

i.e., n – 1 = (k – 1) + (n – k), where n is the number of data points, k is the 

number of predictors
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ANOVA in Simple Linear Regression

• Whether the overall model is statistically significant can be tested by using F-
test of ANOVA.

• H0: The model is not statistically significant.

• Ha: The model is statistically significant.

• Test Statistic: 

• Critical Statistic: F value in F table with (k – 1) degrees of freedom in the 
numerator and (n – k) degrees of freedom in the denominator.

• If F  ≤  Fcritical, we fail to reject the null. There is no statistically significant 
relationship between X and Y.

• If F > Fcritical, we reject the null. There is a statistically significant relationship 
between X and Y. 
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Coefficient of Determination

• R2 (also called coefficient of determination) measures the proportion of 

variability in the data that can be explained by the model.

• R2 ranges from 0 to 1. The higher R2 is, the better the model can fit the 

actual data.

• How to calculate R2:
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Use Minitab to Run a Simple Linear Regression

• Case study:

• We want to see whether the score on exam one has any statistically 

significant relationship with the score on the final exam. If yes, how much 

impact does exam one have on the final exam?

• Data File: “Simple Linear Regression” tab in “Sample Data.xlsx”

• Step 1: Determine the dependent and independent variables. Both 

should be continuous variables.

• Y (dependent variable) is the score of final exam.

• X (independent variable) is the score of exam one.

• Both variables are continuous.
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Use Minitab to Run a Simple Linear Regression

• Step 2: Create a scatter plot to visualize whether there seems to be a 

linear relationship between X and Y.

1) Click Graph → Scatterplot.

2) A new window named “Scatterplots” pops up.

3) Click “OK.”

4) A new window named “Scatterplot - Simple” pops up.

5) Select “FINAL” as “Y variables” and “EXAM1” as “X variables.”

6) Click “OK.”

7) A scatter plot is generated in a new window.
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Use Minitab to Run a Simple Linear Regression
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Use Minitab to Run a Simple Linear Regression

• Based on the scatter plot, the relationship between exam one and final 

seems linear. The higher the score on exam one, the higher the score 

on the final.
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Use Minitab to Run a Simple Linear Regression

• Step 3: Run the simple linear regression analysis.

1) Click Stat → Regression → Regression → Fit Regression Model

2) A new window named “Regression” pops up.

3) Select “FINAL” as “Response” and “EXAM1” as “Continuous Predictors.”

4) Click the “Storage” button.

5) Check the box of “Residuals” so that the residuals can be saved automatically 

in the last column of the data table.

6) Click “OK.”

7) The regression analysis results appear in the new window.
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Use Minitab to Run a Simple Linear Regression
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Use Minitab to Run a Simple Linear Regression

• Step 4: Check whether the model is 

statistically significant. If not significant, we will 

need to re-examine the predictor or look for 

new predictors before continuing.

• R2 measures the percentage of variation in the data set 

that can be explained by the model. 89.5% of the 

variability in the data can be accounted for by this linear 

regression model.

• “Analysis of Variance” section provides a ANOVA table 

covering degrees of freedom, sum of squares, and mean 

square information for total, regression and error.

• The p-value of the F-test is lower than the α level (0.05), 

indicating that the model is statistically significant.
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Use Minitab to Run a Simple Linear Regression

• Step 5: Understand regression 

equation

• The estimates of slope and intercept are 

shown in the “Parameter Estimate” section.

• In this example, Y = 15.6 + 1.85 × X.

• One unit increase in the score of Exam1 

would increase the final score by 1.85.
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Interpreting the Results

• Rsquare Adj = 89.05%

• 89% of the variation in FINAL can be explained by EXAM1

• P-value of the F-test = 0.000

• We have a statistically significant model 

• Prediction Equation: 15.6 + 1.85 × EXAM1

• 15.6 is the Y intercept, all equations will start with 15.6

• 1.85 is the EXAM1 Coefficient: multiply it by EXAM1 score

• Let us say you are the professor and you want to use this prediction 

equation to estimate what two of your students might get on their final 

exam.
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Interpreting the Results

• Let us assume the following:

• Student “A” exam 1 results were: 79

• Student “B” exam 1 results were: 94.

• Remember our prediction equation?

• 15.6 + 1.85 × Exam1

• Now apply the equation to each student

• Student “A” Estimate: 15.6 + (1.85 × 79) = 161.8

• Student “B” Estimate: 15.6 + (1.85 × 94) = 189.5

Now you can use your “magic” as the professor and allocate your time 
appropriately to the student(s) who you predict need the most help

Nice Work!
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4.1.4 Residuals Analysis
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What are Residuals?

• Residuals are the vertical differences between actual values and the 

predicted values or the “fitted line” created by the regression model.

Vertical Distance
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Why Perform Residuals Analysis?

• Regression equations are generated on the basis of certain statistical 

assumptions.

• Residuals analysis helps to determine the validity of these assumptions.

• The assumptions are:

• The residuals are normally distributed, mean equal to zero.

• The residuals are independent.

• The residuals have a constant variance.

• The underlying population relationship is linear.

• If residuals performance does not meet the requirements, we will need to 

rebuild the model by replacing the predictor with a new one, adding new 

predictors, building non-linear models, and so on.
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Use Minitab to Perform Residuals Analysis

• The residuals of the model are saved in a column of your data table
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Use Minitab to Perform Residuals Analysis

• Step 1: Check whether residuals are normally distributed around the 

mean of zero.

1) Click Stat → Basic Statistics → Graphical Summary.

2) A new window named “Graphical Summary” pops up.

3) Select “RESI” as “Variables.”

4) Click “OK.”

5) The histogram and the normality test of the residuals are displayed in the new 

window.
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Use Minitab to Perform Residuals Analysis
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Use Minitab to Perform Residuals Analysis

• The mean of residuals is -0.0000.

• The Anderson-Darling test is used 

to test the normality. Since the p-

value (0.339) is greater than the 

alpha level (0.05), we fail to reject 

the null hypothesis; the residuals 

are normally distributed.

• H0: The residuals are normally 

distributed.

• H1: The residuals are not normally 

distributed.
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Use Minitab to Perform Residuals Analysis

• Step 2: If the data are in time order, run the I-MR chart to check 

whether residuals are independent.

1) Click Stat → Control Charts → Variable Charts for Individuals → I-MR.

2) A new window named “Individuals – Moving Range Chart” pops up.

3) Select “Residuals” as “Variables” and check the box of “Test for special 

causes.”

4) Click “OK.”

5) The control charts are shown automatically in the new window.
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Use Minitab to Perform Residuals Analysis
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Use Minitab to Perform Residuals Analysis

• If no data points are out of 
control in both the I-chart and 
MR chart, the residuals are 
independent of each other.

• If the residuals are not 
independent, it is possible 
that some important 
predictors are not included in 
the model.

• In this example, since the I-
MR chart is in control, 
residuals are independent.
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Use Minitab to Perform Residuals Analysis

• Step 3: Check whether residuals have equal variance across the predicted responses.

• Create a column of the fitted response using the regression formula returned in the session 

window.
1) Right click on the last column in the data table.

2) Select Formulas → Assign Formula to Column.

3) A new window named “Assign Formula to C4” appears.

4) Enter the regression equation “15.6+1.85*EXAM1” into the “Expression” box.

5) Click “OK.”

6) The column of the fitted values is created in the data table.

• Create a scatter plot with Y being the residuals and the X being the fitted values.
1) Click Graph → Scatterplot.

2) A new window named “Scatterplots” appears.

3) Select “RESI” as the “Y variables” and “Fitted” as the “X variables.”

4) Click “OK.”

5) The scatter plot appears in a new window.

• We are looking for the pattern in which residuals spread out evenly around zero from the top 

to the bottom.
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Use Minitab to Perform Residuals Analysis
L

e
a

n
 S

ix
 S

ig
m

a
 T

ra
in

in
g

 -
M

T
B

©
 A

m
e

ric
a

n
 B

&
T

 U
n

iv
e

rs
ity

891



www.ABTU.edu

Use Minitab to Perform Residuals Analysis
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4.2 Multiple Regression Analysis
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Black Belt Training: Improve Phase

4.1 Simple Linear Regression

4.1.1 Correlation

4.1.2 X-Y Diagram

4.1.3 Regression Equations

4.1.4 Residuals Analysis

4.2 Multiple Regression Analysis

4.2.1 Non-Linear Regression

4.2.2 Multiple Linear Regression

4.2.3 Confidence Intervals

4.2.4 Residuals Analysis

4.2.5 Data Transformation, Box Cox

4.2.6 Stepwise Regression

4.2.7 Logistic Regression

4.3 Designed Experiments

4.3.1 Experiment Objectives

4.3.2 Experimental Methods

4.3.3 DOE Design Considerations

4.4 Full Factorial Experiments

4.4.1 2k Full Factorial Designs

4.4.2 Linear and Quadratic Models

4.4.3 Balanced and Orthogonal Designs

4.4.4 Fit, Model, and Center Points

4.5 Fractional Factorial Experiments

4.5.1 Designs

4.5.2 Confounding Effects

4.5.3 Experimental Resolution
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4.2.1 Non-Linear Regression
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Linear and Non-Linear

• The word linear originally comes from Latin word linearis meaning 

“created by lines.”

• A linear function in mathematics follows the following pattern (i.e., the 

output is proportional to its input):

• A non-linear function does not follow the above pattern. There are 

usually exponents, logarithms, power, polynomial components, and 

other non-linear functions of the independent variables and 

parameters.

 ++++= nnn xxxxxxf *...**),...,,( 221121
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Non-Linear Relationships Using Linear Models

• Many non-linear relationships can be transformed into linear 

relationships, and from there we can use linear regression methods to 

model the relationship.

• Some non-linear relationships cannot be transformed to linear ones 

and we need to apply other methods to build the non-linear models.

• In this section, we will focus on building non-linear regression models 

using linear transformation (i.e., transforming the independent or 

dependent variables or parameters to generate a linear function).
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Assumptions in Using Non-Linear Regression

• The population relationship is non-linear based on a reliable underlying 

theory.

• Across the range of all the possible values of the independent 

variables, the non-linear relationship applies. It is possible that at some 

extreme values the relationship between variables changes 

dramatically.
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Non-Linear Functions: Transforming to Linear

• Examples of non-linear functions that can be transformed to linear 

functions:

• Exponential Function

• Inverse Function

• Polynomial Function

• Power Function.
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Exponential Function

• Exponential Function

• Transformation
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Inverse Function

• Inverse Function

• Transformation
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Polynomial Function

• Polynomial Function

• Transformation
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Power Function

• Power Function

• Transformation
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4.2.2 Multiple Linear Regression
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What is Multiple Linear Regression?

• Multiple linear regression is a statistical technique to model the 

relationship between one dependent variable and two or more independent 

variables by fitting the data set into a linear equation.

• The difference between simple linear regression and multiple linear 

regression:

• Simple linear regression only has one predictor.

• Multiple linear regression has two or more predictors.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

905



www.ABTU.edu

Multiple Linear Regression Equation

• Y is the dependent variable (response).

• X1, X2, … , Xp are the independent variables (predictors). There are p 

predictors in total.

• Both dependent and independent variables are continuous.

• β is the intercept indicating the Y value when all the predictors are 

zeros.

• α1, α2, … , αp are the coefficients of predictors. They reflect the 

contribution of each independent variable in predicting the dependent 

variable.

• e is the residual term indicating the difference between the actual and 

the fitted response value.

eXXXY pp +++++=  *...** 2211
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Use Minitab to Run a Multiple Linear Regression

• Case study:

• We want to see whether the scores in exam one, two, and three have any 

statistically significant relationship with the score in final exam. If so, how 

are they related to final exam score? Can we use the scores in exam one, 

two, and three to predict the score in final exam?

• Data File: “Multiple Regression Analysis” tab in “Sample Data.xlsx.”

• Step 1: Determine the dependent and independent variables. All 

should be continuous.

• Y (dependent variable) is the score of final exam.

• X1, X2, and X3 (independent variables) are the scores of exam one, two, 

and three respectively.

• All the variables are continuous.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

907



www.ABTU.edu

Use Minitab to Run a Multiple Linear Regression

• Step 2: Start building the multiple linear regression model

1) Click Stat → Regression → Regression → Fit Regression Model

2) A new window named “Regression” pops up.

3) Select “FINAL” as “Response” and “EXAM1”, “EXAM2” and “EXAM3” as 

“Continuous Predictors.”

4) Click the “Graph” button, select the radio button “Four in one” and click “OK.”

5) Click the “Storage” button, check the boxes of “Residuals” and “DFITS” and 

click “OK.”

6) Click “OK” in the window named “Regression.”

7) The regression analysis results appear in the session window and the four 

residual plots appear in another window named “Residual Plots for FINAL.”
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Use Minitab to Run a Multiple Linear Regression
L

e
a

n
 S

ix
 S

ig
m

a
 T

ra
in

in
g

 -
M

T
B

©
 A

m
e

ric
a

n
 B

&
T

 U
n

iv
e

rs
ity

909



www.ABTU.edu

Use Minitab to Run a Multiple Linear Regression

• Step 3: Check whether the whole model 
is statistically significant. If not, we need 
to re-examine the predictors or look for 
new predictors before continuing.

• H0: The model is not statistically 
significant (i.e., all the parameters of 
predictors are not significantly different 
from zeros).

• H1: The model is statistically significant 
(i.e., at least one predictor parameter is 
significantly different from zero).

• In this example, p-value is much smaller 
than alpha level (0.05), hence we reject 
the null hypothesis; the model is 
statistically significant.
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Use Minitab to Run a Multiple Linear Regression

• Step 4: Check whether 

multicollinearity exists in the model.

• The VIF information is automatically 

generated in the table Coefficients.
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Multicollinearity

• Multicollinearity is the situation when two or more independent 

variables in a multiple regression model are correlated with each other.

• Although multicollinearity does not necessarily reduce the predictability 

for the model as a whole, it may mislead the calculation for individual 

independent variables.

• To detect multicollinearity, we use VIF (Variance Inflation Factor) to 

quantify its severity in the model.
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Variance Inflation Factor

• VIF quantifies the degree of multicollinearity for each individual 

independent variable in the model.

• VIF calculation:

• Assume we are building a multiple linear regression model using p 

predictors.

• Two steps are needed to calculate VIF for X1.

• Step 1: Build a multiple linear regression model for X1 by using X2, X3, …, Xp as 

predictors.

• Step 2: Use the R2 generated by the linear model in step 1 to calculate the VIF for X1.

• Apply the same methods to obtain the VIFs for other Xs. The VIF value ranges from one 

to positive infinity.

 ++++= pp XXXY ...2211

bXaXaXaX pp ++++= ...33221

21

1

R
VIF

−
=
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Variance Inflation Factor

• Rules of thumb to analyze variance inflation factor (VIF):

• If VIF = 1, there is no multicollinearity.

• If 1 < VIF < 5, there is small multicollinearity.

• If VIF ≥ 5, there is medium multicollinearity.

• If VIF ≥ 10, there is large multicollinearity.
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How to Deal With Multicollinearity

• Increase the sample size.

• Collect samples with a broader range for some predictors.

• Remove the variable with high multicollinearity and high p-value.

• Remove variables that are included more than once.

• Combine correlated variables to create a new one.

• In this section, we will focus on removing variables with high VIF and 

high p-value.
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Use Minitab to Run a Multiple Linear Regression

• Step 5: Deal with multicollinearity:

• Step 5.1: Identify a list of independent variables with VIF higher than 5. If 

no variable has VIF higher than 5, go to Step 6 directly.

• Step 5.2: Among variables identified in Step 5.1, remove the one with the 

highest p-value. 

• Step 5.3: Run the model again, check the VIFs and repeat Step 5.1.

• Note: we only remove one independent variable at a time.
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Use Minitab to Run a Multiple Linear Regression

• Step 6: Identify the statistically insignificant predictors. Remove one 
insignificant predictor at a time and run the model again. Repeat this 
step until all the predictors in the model are statistically significant.

• Insignificant predictors are the ones with p-value higher than alpha level 
(0.05). When p > alpha level, we fail to reject the null hypothesis; the 
predictor is not significant.

• H0: The predictor is not statistically significant.

• H1: The predictor is statistically significant.

• As long as the p-value is greater than 0.05, remove the insignificant 
variables one at a time in the order of the highest p-value.

• Once one insignificant variable is eliminated from the model, we need 
to run the model again to obtain new p-values for other predictors left in 
the new model.
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Use Minitab to Run a Multiple Linear Regression

• In this example, all three predictors 

have VIF higher than 5. Among 

them, EXAM1 has the highest p-

value.

• We will remove EXAM1 from the 

equation and run the model again.
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Use Minitab to Run a Multiple Linear Regression

• Run the new multiple linear regression with only two predictors

(i.e., EXAM2 and EXAM3).

• Check the VIFs of EXAM2 AND EXAM3. They are both smaller than 5; 

hence, there is little multicollinearity existing in the model. L
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Use Minitab to Run a Multiple Linear Regression

• In this example, both predictors’ p-

values are smaller than alpha level 

(0.05).

• As a result, we do not need to 

eliminate any variables from the 

model.
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Use Minitab to Run a Multiple Linear Regression

• Step 7: Interpret the regression 

equation

• The multiple linear regression 

equation appears automatically at 

the top of the session window.

• “Coefficients” section provides the 

estimates of parameters in the linear 

regression equation.
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Interpreting the Results

• Rsquare Adj = 98.4%

• 98% of the variation in FINAL can be explained by the predictor variables 

EXAM2 & EXAM3.

• P-value of the F-test = 0.000

• We have a statistically significant model. 

• Variables p-value: 

• Both are significant (less than 0.05).

• VIF

• EXAM2 & EXAM3 are both below 5; we’re in good shape! 

• Equation: -4.34 + 0.722*EXAM2 + 1.34*EXAM3

• -4.34 is the Y intercept, all equations will start with -4.34.

• 0.722 is the EXAM2 coefficient; multiply it by EXAM2 score.

• 1.34 is the EXAM3 coefficient; multiply it by EXAM3 score.
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Interpreting the Results

• Let us say you are the professor again, and this time you want to use 

your prediction equation to estimate what one of your students might 

get on their final exam.

• Assume the following:
• Exam 2 results were: 84

• Exam 3 results were: 102.

• Use your equation: -4.34 + 0.722*EXAM2 + 1.34*EXAM3

• Predict your student’s final exam score:
• -4.34 + (0.722*84) + (1.34*102) =-4.34 + 60.648 + 136.68 = 192.988

Nice work again! Now you can use your “magic” as the smart and efficient professor 

and allocate your time to other students because this one projects to perform much 

better than the average score of 162.
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4.2.3 Confidence & Prediction Intervals
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Prediction

• The purpose of building a regression model is not only to understand 

what happened in the past but more importantly to predict the future 

based on the past.

• By plugging the values of independent variables into the regression 

equation, we obtain the estimation/prediction of the dependent 

variable.
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Uncertainty of Prediction

• We build the regression model using the sample data to describe as 

close as possible the true population relationship between dependent 

and independent variables.

• Due to noise in the data, the prediction will probably differ from the true 

response value.

• However, the true response value might fall in a range around the 

prediction with some certainty.

• To measure the uncertainty of the prediction, we need confidence 

interval and prediction interval.
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Confidence Interval

• The confidence interval of the prediction is a range in which the 
population mean of the dependent variable would fall with some 
certainty, given specified values of the independent variables.

• The width of confidence interval is related to:

• Sample size

• Confidence level

• Variation in the data.

• We build the model based on a sample set {y1, y2,…, yn}. The 
confidence interval is used to estimate the value of the population 
mean μ of the underlying population.

• The focus of the confidence interval are the unobservable population 
parameters.

• The confidence interval accounts for the uncertainty in the estimates of 
regression parameters.
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Prediction Interval

• The prediction interval is a range in which future values of the 

dependent variable would fall with some certainty, given specified 

values of the independent variables.

• We build the model based on a sample set {y1, y2,…, yn}. The 

prediction interval is used to estimate the value of future observation 

yn+1.

• The focus of the prediction interval are the future observations.

• Prediction interval is wider than confidence interval because it accounts 

for the uncertainty in the estimates of regression parameters and the 

uncertainty of the new measurement. 

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

928



www.ABTU.edu

Use Minitab to Obtain Prediction & Confidence Interval 

• Steps in Minitab to obtain prediction, confidence interval and prediction 

interval after running Regression tests. 

1. Click Stat → Regression → Predict

2. Choose “FINAL” as Response

3. Select “Enter columns of values” from second dropdown menu

4. Click on “Exam 2” for the first column and “Exam 3” for the second column

5. Click “OK” 

6. The fitted response (PFIT), the confidence interval (CLIM), and the prediction 

interval (PLIM) are automatically added to your data table.
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Use Minitab to Obtain Prediction & Confidence Interval
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4.2.4 Residuals Analysis
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Remember what Residuals Are?

• Residuals are the vertical difference between actual values and the 

predicted values or the “fitted line” created by the regression model.

Vertical Distance

Actual Point

Predicted Value
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Why Perform Residuals Analysis?

• The regression equation generated based on the sample data can 

make accurate statistical inference only if certain assumptions are met. 

Residuals analysis can help to validate these assumptions. The 

following assumptions must be met to ensure the reliability of the linear 

regression model:

• The errors are normally distributed with mean equal to zero.

• The errors are independent.

• The errors have a constant variance.

• The underlying population relationship is linear.

• If the residuals performance does not meet the requirement, we will 

need to rebuild the model by replacing the predictors with new ones, 

adding new predictors, building non-linear models, and so on.
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Use Minitab to Perform Residuals Analysis

• Step 1: Check whether residuals are normally distributed around the 

mean of zero.

1) Click Stat → Basic Statistics → Graphical Summary.

2) A new window named “Graphical Summary” pops up.

3) Select “RESI_1” as the “Variables.” We are selecting RESI_1 because we ran our regression 

two times, the first with all Exams which gave us our first set of residuals (RESI), the second model we ran 

without Exam1 and then we got residuals added to our data table and that column was automatically labeled 

RESI_1.

4) Click “OK.”

5) The histogram and analysis results are shown automatically in the new 

window.
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Use Minitab to Perform Residuals Analysis
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Use Minitab to Perform Residuals Analysis

• The mean of residuals is -
0.0000.

• The Anderson-Darling test is 
used to test the normality. Since 
the p-value (0.196) is greater 
than the alpha level (0.05), we 
fail to reject the null hypothesis; 
the residuals are normally 
distributed.

• H0: The residuals are normally 
distributed.

• H1: The residuals are not 
normally distributed.
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Use Minitab to Perform Residuals Analysis

• Step 2: If the data are in time order, run the I-MR chart to check 

whether residuals are independent.

1) Click Stat → Control Charts → Variable Charts for Individuals → I-MR.

2) A new window named “Individuals – Moving Range Chart” pops up.

3) Select “RESI1” as “Variables

4) Click “I-MR Options” 

5) Click on “Tests” tab and select “Perform all tests for special causes”

6) Click “OK.” to close “I-MR” Options

7) Click OK

8) The control charts are shown automatically in the new window.
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Use Minitab to Perform Residuals Analysis
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Use Minitab to Perform Residuals Analysis

• If no data points are out of 

control in both the I-chart and 

MR chart, the residuals are 

independent of each other.

• If the residuals are not 

independent, it is possible that 

some important predictors are 

not included in the model.

• In this example, since the IMR 

chart is in control, residuals 

are independent.
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Use Minitab to Perform Residuals Analysis

• Step 3: Check whether residuals have equal variance across the 

predicted responses.

• Create a scatterplot with Y being the residuals and the X being the fitted 

values.

1. Click Graph → Scatterplot.

2. A new window named “Scatterplots” appears.

3. Select “RESI1” as the “Y variables” and “Fitted” as the “X variables.”

4. Click “OK.”

5. The scatterplot appears in a new window.

• We are looking for the pattern in which residuals spread out evenly around 

zero from the top to the bottom.
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Use Minitab to Perform Residuals Analysis
L

e
a

n
 S

ix
 S

ig
m

a
 T

ra
in

in
g

 -
M

T
B

©
 A

m
e

ric
a

n
 B

&
T

 U
n

iv
e

rs
ity

941



www.ABTU.edu

4.2.5 Data Transformation
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What is the Box-Cox Transformation?

• When a response does not fit the model well, sometimes using a 

transformation of the response can improve the fit.

• Power transformation is a class of transformation functions that raise 

the response to some power. For example, a square root 

transformation converts X to X1/2.

• Box-Cox transformation is a popular power transformation method 

developed by George E. P. Box and David Cox.
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Box-Cox Transformation Formula

• The formula of the Box-Cox transformation is:



 1−
=

x
y where 0

xy ln= where 0=

y is the transformation result.

x is the variable under transformation.

λ is the transformation parameter. 
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Use Minitab to Perform a Box-Cox Transformation

• Minitab provides the best Box-Cox transformation with an optimal λ that 

minimizes the model SSE (sum of squared error).

• Here is an example of how we transform the non-normally distributed 

response to normal data using Box-Cox method.

• Data File: “Box-Cox” tab in “Sample Data.xlsx”
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Use Minitab to Perform a Box-Cox Transformation

• Step 1: Test the normality of the original data set.

1) Click Stat → Basic Statistics → Normality Test.

2) A new window named “Normality Test” pops up.

3) Select “Y” as “Variable.”

4) Click “OK.”

5) The normality test results are shown automatically in the new window.
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Use Minitab to Perform a Box-Cox Transformation
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Use Minitab to Perform a Box-Cox Transformation

• Normality Test:

• H0: The data are normally 
distributed.

• H1: The data are not normally 
distributed.

• If p-value > alpha level (0.05), 
we fail to reject the null 
hypothesis. Otherwise, we 
reject the null.

• In this example, p-value = 
0.029 < alpha level (0.05). The 
data are not normally 
distributed.
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Use Minitab to Perform a Box-Cox Transformation

• Step 2: Run the Box-Cox Transformation:

1) Click Stat → Control Charts → Box-Cox Transformation.

2) A new window named “Box-Cox Transformation” pops up.

3) Click into the blank list box below “All observations for a chart are in one 

column.”

4) Select “Y” as the variable.

5) Select “Run” into the box next to “Subgroup sizes (enter a number or ID 

column).”

6) Click “OK.”

7) The analysis results are shown automatically in the new window.
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Use Minitab to Perform a Box-Cox Transformation
L

e
a

n
 S

ix
 S

ig
m

a
 T

ra
in

in
g

 -
M

T
B

©
 A

m
e

ric
a

n
 B

&
T

 U
n

iv
e

rs
ity

950



www.ABTU.edu

Use Minitab to Perform a Box-Cox Transformation

• When λ is 0.12, the transformation is the optimal with minimum SSE.
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Use Minitab to Perform a Box-Cox Transformation

• The transformed Y can also be saved in another column.

1) Create a new column named “Y1” in the data table.

2) Click on the “Options” button in the “Box-Cox Transformation” window.

3) A new window named “Box-Cox Transformation – Options” appears.

4) Click in the blank box under “Store transformed data in” and all the columns 

pop up in the list box on the left.

5) Select “Y1” in “Store transformed data in.”

6) Click “OK” in the window “Box-Cox Transformation – Options.”

7) Click “OK” in the window “Box-Cox Transformation.”

8) The transformed column is stored in the column “Y1.”
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Use Minitab to Perform a Box-Cox Transformation
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Use Minitab to Perform a Box-Cox Transformation

• Run the normality test to check whether 
the transformed data are normally 
distributed.

• Use the Anderson-Darling test to test 
the normality of the transformed data

• H0: The data are normally distributed.

• H1: The data are not normally distributed.

• If p-value > alpha level (0.05), we fail to 
reject the null. Otherwise, we reject the 
null.

• In this example, p-value = 0.327 > 
alpha level (0.05). The data are 
normally distributed.
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4.2.6 Stepwise Regression
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What is Stepwise Regression?

• Stepwise regression is a statistical method to automatically select 

regression models with the best sets of predictive variables from a 

large set of potential variables.

• There are different statistical methods used in stepwise regression to 

evaluate the potential variables in the model:

• F-test

• T-test

• R-square

• AIC.
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Three Approaches to Stepwise Regression

• Forward Selection

• Bring in potential predictors one by one and keep them if they have 

significant impact on improving the model.

• Backward Selection

• Try out potential predictors one by one and eliminate them if they are 

insignificant to improve the fit.

• Mixed Selection

• Is a combination of both forward selection and backward selection. Add 

and remove variables based on pre-defined significance threshold levels.
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How to Use Minitab to Run a Stepwise Regression

• Case study: We want to build a regression model to predict the oxygen 

uptake of a person who runs 1.5 miles. The potential predictors are:

• Age

• Weight

• Runtime

• Runpulse

• RstPulse

• MaxPulse.

• Data File: “Stepwise Regression” tab in “Sample Data.xlsx”
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How to Use Minitab to Run a Stepwise Regression 

• Sample Data Glance
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How to Use Minitab to Run a Stepwise Regression 

• Steps to run stepwise regression in Minitab 

1) Click Stat → Regression → Regression → Fit Regression Model.

2) Select “Oxy” as the Response and select all the other variables into the 

“Continuous Predictors” box.

3) Click the “Stepwise” button and a new window named “Regression: Stepwise” 

pops up.

4) Select the method of stepwise regression and enter the alphas to 

enter/remove. In this example, we use the “Forward selection” method and 

the alpha to enter is 0.25.

5) Select the option to “Include details for each step”

6) Click “OK” in the window “Regression: Stepwise.”

7) Click “OK” in the window “Stepwise Regression.”

8) The results appear in the session window.
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How to Use Minitab to Run a Stepwise Regression 
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How to Use Minitab to Run a Stepwise Regression 

• Step History:

• Step-by-step records on how to 

come up with the final model. 

Each column indicates the 

model built in each step.
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How to Use Minitab to Run a Stepwise Regression 

• Model summary:

• One out of six potential factors 

is not statistically significant 

since its p-value is higher than 

the alpha to enter.

• We also have multi-collinearity 

with two factors with VIF’s 

greater than 5
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4.2.7 Logistic Regression
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What is Logistic Regression?

• Logistic regression is a statistical method to predict the probability of 

an event occurring by fitting the data to a logistic curve using logistic 

function.

• The dependent variable in a logistic regression can be binary (e.g., 1/0, 

yes/no, pass/fail), nominal (blue/yellow/green), or ordinal 

(satisfied/neutral/dissatisfied).

• The independent variables can be either continuous or discrete.
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Logistic Function

ze
zf

−+
=

1

1
)(

where z can be any value ranging from negative infinity to positive 

infinity.

The value of f(z) ranges from 0 to 1, which matches exactly the nature 

of probability (i.e., 0 ≤ P ≤ 1).
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Logistic Regression Equation

• Based on the logistic function

we define f(z) as the probability of an event occurring and z is the 

weighted sum of the significant predictive variables.
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Logistic Regression Equation

• Logistic Regression Y = F(x)

where Y is the probability of an event occurring and x’s are the 

significant predictors.

Note: 

• When building the regression model, we use the actual Y, which is 

discrete (e.g. binary, nominal, ordinal). 

• After completing building the model, the fitted Y calculated using the 

logistic regression equation is the probability ranging from 0 to 1. To 

transfer the probability back to the discrete value, we need SMEs’ 

inputs to select the probability cut point.
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Logistic Curve

• Logistic curve for binary logistic regression

with one continuous predictor:

Probability of the 

event occurring

0

1

X
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Odds

• Odds is the probability of an event occurring divided by the probability 

of the event not occurring.

• Odds range from 0 to positive infinity.

P

P
Odds

−
=

1
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Odds

• Probability can be calculated using odds.

• Since in logistic regression model

therefore

)ln()ln(
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Three Types of Logistic Regression

• Binary Logistic Regression

• Binary response variable

• Example: yes/no, pass/fail, female/male

• Nominal Logistic Regression

• Nominal response variable

• Example: set of colors, set of countries

• Ordinal Logistic Regression

• Ordinal response variable

• Example: satisfied/neutral/dissatisfied

• All three logistic regression models can use multiple continuous or 
discrete independent variables.

• All three logistic regression models can be developed in Minitab using 
the same steps.
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How to Run a Logistic Regression in Minitab

• Data File: “Logistic Regression” tab in “Sample Data.xlsx” 

• Response and potential factors

• Response (Y): Female/Male

• Potential Factors (Xs):

• Age

• Weight

• Oxy

• Runtime

• RunPulse

• RstPulse

• MaxPulse.

• We want to build a logistic regression model using the potential factors 

to predict the probability that the person measured is female or male.
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How to Run a Logistic Regression in Minitab

• Step 1:

1) Click Stat → Regression → Binary Logistic Regression → Fit Binary Logistic 

Model

2) A new window named “Binary Logistic Regression” appears.

3) Click into the blank box next to “Response” and all the variables pop up in the 

list box on the left.

4) Select “Sex” as the “Response.”

5) Select “Age”, “Weight”, “Oxy”, “Runtime”, “RunPulse”, “RstPulse”, “MaxPulse” 

into the “Continuous Predictors.”

6) Click “OK.”
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How to Run a Logistic Regression in Minitab
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How to Run a Logistic Regression in Minitab

• Step 2:

1) Step 2.1: The results of the logistic regression model appear in session 

window.

2) Step 2.2: Check the p-values of all the independent variables in the model.

3) Step 2.3: Remove the insignificant independent variable one at a time from 

the model and rerun the model.

4) Step 2.4: Repeat step 2.1 until all of the independent variables in the model 

are statistically significant.
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How to Run a Logistic Regression in Minitab

• Since the p-values of all the independent variables are higher than the 

alpha level (0.05), we need to remove the insignificant independent 

variables one at a time from the model, starting from the one with the 

highest p-value.

• Runtime has the highest

p-value (0.990), so

it would be removed

from the model first.
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How to Run a Logistic Regression in Minitab

• After removing Runtime from the model, the p-values of all the independent variables 

are still higher than the alpha level (0.05). 

• We need to continue removing the insignificant independent variables one at a time 

from the model, starting from the one with the highest p-value.

• Age has the highest p-value (0.977), it will be removed from the model next.
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How to Run a Logistic Regression in Minitab

• After removing Age from the model, the p-values of all the independent variables are 

still higher than the alpha level (0.05).

• We need to continue removing the insignificant independent variables one at a time 

from the model, starting from the one with the highest p-value.

• RstPulse has the highest p-value (0.803), it will be removed from the model next.
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How to Run a Logistic Regression in Minitab

• After removing RstPulse from the model, the p-values of all the independent variables 

are still higher than the alpha level (0.05).

• We need to continue removing the insignificant independent variables one at a time 

from the model, starting from the one with the highest p-value.

• Weight has the highest p-value (0.218), so it would be removed from the model next.
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How to Run a Logistic Regression in Minitab

• After removing Weight from the model, the p-values of all the independent variables 

are still higher than the alpha level (0.05).

• We need to continue removing the insignificant independent variables one at a time 

from the model, starting from the one with the highest p-value.

• RunPulse has the highest p-value (0.140), it will be removed from the model next.
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How to Run a Logistic Regression in Minitab

• After removing RunPulse from the model, the p-values of all the independent 

variables are still higher than the alpha level (0.05).

• We need to continue removing the insignificant independent variables one at a time 

from the model, starting from the one with the highest p-value.

• MaxPulse has the highest p-value (0.213), it will be removed from the model next.
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How to Run a Logistic Regression in Minitab

•
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How to Run a Logistic Regression in Minitab

• Step 3:

• Analyze the binary logistic 

report in the session window 

and check the performance of 

the logistic regression model.

• The p-value here is 0.031, 

smaller than alpha level (0.05). 

We conclude that at least one 

of the slope coefficients is not 

equal to zero.

• The p-value of goodness of fit 

tests are all higher than alpha 

level (0.05). We conclude that 

the model fits the data.
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How to Run a Logistic Regression in Minitab

• Step 4: get the predicted probabilities of the event (i.e., Sex = M) 

occurring using the logistic regression model.

1. Click the “Storage” button in the window named “Binary Logistic Regression” 

and a new window named “Binary Logistic Regression – Storage” pops up.

2. Check the box “Fits (event probability).”

3. Click “OK” in the window of “Binary Logistic Regression – Storage.”

4. Click “OK” in the window of “Binary Logistic Regression.”

5. A column of the predicted event probability is added to the data table with the 

heading “FITS1”.
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How to Run a Logistic Regression in Minitab
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4.3 Designed Experiments
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Black Belt Training: Improve Phase

4.1 Simple Linear Regression

4.1.1 Correlation

4.1.2 X-Y Diagram

4.1.3 Regression Equations

4.1.4 Residuals Analysis

4.2 Multiple Regression Analysis

4.2.1 Non-Linear Regression

4.2.2 Multiple Linear Regression

4.2.3 Confidence Intervals

4.2.4 Residuals Analysis

4.2.5 Data Transformation, Box Cox

4.2.6 Stepwise Regression

4.2.7 Logistic Regression

4.3 Designed Experiments

4.3.1 Experiment Objectives

4.3.2 Experimental Methods

4.3.3 DOE Design Considerations

4.4 Full Factorial Experiments

4.4.1 2k Full Factorial Designs

4.4.2 Linear and Quadratic Models

4.4.3 Balanced and Orthogonal Designs

4.4.4 Fit, Model, and Center Points

4.5 Fractional Factorial Experiments

4.5.1 Designs

4.5.2 Confounding Effects

4.5.3 Experimental Resolution
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4.3.1 Experiment Objectives
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What is an Experiment?

• An experiment is a scientific exercise to gather data to test a 

hypothesis, theory, or previous results.

• Experiments are planned studies in which data are collected actively 

and purposefully.

• A typical experiment follows this sequence:

• A problem arises.

• A hypothesis is stated.

• An experiment is designed and implemented to collect data.

• The analysis is performed to test the hypothesis.

• Conclusions are drawn based on the analysis results.
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Why Use Experiments?

• Resolve Problems

• Eliminate defects or defectives.

• Shift performance means to meet customer expectations.

• Squeeze variation, making process more predictable.

• Optimize Performance

• Use statistical methods to get desired process response.

• Minimize undesirable conditions, waste, or costs.

• Reduce variation to eliminate out-of-spec conditions.

• Intelligent Design

• Design processes around variables that have significant impact on process 

outputs.

• Design processes around variables that are easier or more cost effective to 

manage.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

991



www.ABTU.edu

Traditional Methods of Learning

• Passive Learning

• Study or observe events while they occur.

• Study or analyze events after they occur.

• OFAT Experiment (One Factor at a Time)

• An experimental style limited to controlling one factor independently 

while others remain either static or are allowed to vary.

• Design of Experiments

• Purposefully and proactively manipulate variables so their effect on 

the dependent variable can be studied.

• Encourages an informative event to occur within specific planned 

parameters.
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What is the Design of Experiment (DOE)?

• Design of experiment (DOE) is a systematic and cost 

effective approach to plan the exercises necessary to collect 

data and quantify the cause-and-effect relationship between 

the response and different factors.

• In DOE, we observe the changes occurring in the output (i.e., response, 

dependent variable) of a process by changing one or multiple inputs (i.e., 

factors, independent variables).

• Using DOE we are able to manipulate several factors with every run and 

determine their effect on the “Y” or output.
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Common DOE Terminology

• Response: Y, dependent variable, process output measurement

• Effect: The change in the average response across two levels of a 
factor or between experimental conditions.

• Factor: X’s, inputs, independent variables

• Fixed Factor: Factor that can be controlled during the study 

• Random Factor: Factor that cannot be controlled during the study 

• Level: factor settings, usually high and low, + and -, 1 and -1

• Treatment Combination: setting of all factors to obtain one response 
measurement (also referred to as a “run”)

• Replication: Running the same treatment combination more than once 
(sequence of runs is typically randomized)

• Repeat: Non-randomized replicate of all treatment combinations

• Inference Space: Operating range of factors under study
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Y = f (Xs)

Process

X1

X2

Xk

Y

• In Design of Experiments (DOEs);

• X1, X2, …, Xk are the inputs of the process. They can be either continuous or 

discrete variables. 

• Y is the output of the process. Y is a continuous variable.

• A single X or a group of Xs potentially have statistically significant impact on the 

Y with different levels of influence.

Note: DOE for discrete Y is not covered in this module.
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Objectives of Experiments

• Active Learning:

• Learn as much as possible with as little resources as possible. Efficiency is the name 
of the game.

• Identify Critical X’s: 

• Identify the critical factors that drive the output or dependent variable (“Y”).

• Quantify Relationships: 

• Generate an equation that characterizes the relationship between the X’s and the Y.

• Optimize: 

• Determine the required settings of all the X’s to achieve the optimal output or response.

• Validate: 

• Prove results through confirmation or pilot implementation before fully implementing 
solutions.
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Principle of Parsimony

• The ultimate goal of DOE is to use the minimum amount of data to 

discover the maximum amount of information.

• The experiment is designed to obtain data as parsimoniously as 

possible to draw as much information about the relationship between 

the response and factors as possible.

• DOE is often used when the resources to collect the data and build the 

model are limited.
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Tradeoffs

• The objective of a specific DOE study should be determined by the 

team.

• The more complex the objective is, the more data are required. As a 

result, more time and money are needed to collect the data.

• By prioritizing the objectives and filtering factors which obviously do not 

have any effect on the response, a considerable amount of cost of 

running the DOE would be reduced. 
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4.3.2 Experimental Methods
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Planning a DOE

1. Problem Statement: Quantifiably define the problem

2. Objective: State the objective of the experiment

3. Primary Metric: Determine the response variable or “Y”

4. Key Process Input Variables (KPIV): Select the input variable(s) or X’s 

5. Factor Levels: Determine level settings for all factors

6. Design: Select the experimental design for your DOE

7. Project Plan: Prepare a project plan for your experiment – human and capital 

resource allocation, timing, duration etc.

8. Gain Buy-in: Your experiment will need support and buy-in from several 

places, get it!

9. Run the experiment

10. Analyze, Interpret, and Share Results: 
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DOE Problem Statement

• Much like the overall problem statement discussed in the Define phase, 

a DOE problem statement should specific and have quantifiable 

elements.

• Make sure your problem statement ties to a business goal or business 

performance indicator.

• Problem statements should not include:

• Conclusions

• Solutions

• Causes.
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DOE Objectives

State the objective of the experiment

• DOE Objective Examples:

• “To determine the effects of tire pressure on gas mileage”

• “To determine which factors have the most impact on gas mileage”

• “To determine the effects of a pick-up truck’s tailgate (up vs. down) on 
the truck’s gas mileage”

• “To determine which HVAC and Lighting 
factors are contributing most to Kwh
consumption”

• DOE objective statements should:
• Clearly define what you want to learn from the experiment

• Declare study parameters or scope.
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DOE Primary Metric

• Recall our discussion of primary metrics in the Define phase?

• We said something to this effect: “the primary metric is the most important 

measure of success.” 

• This statement still holds true when discussing the primary metric for a 

DOE.

• The primary metric for a DOE is your experiment’s output or response 

under study.

• It is the “Y” in your transfer function Y = f(x).

• It is critical to understand the following things about your metric:

• Measurement accuracy, R&R, and/or bias

• Measurement frequency

• Measurement resolution.
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DOE Primary Metric

• Before embarking on a design of experiment you should have 

validated your measurement system.

• If you have not, now would be a wise time to back track and do so.

• DOEs can be costly on a firm’s time and resources.

• DOEs not planned and run properly will create waste and defective products 

because treatment combinations should “test” boundaries.

• Do not allow your entire study to be wasted because of a poor measurement 

system or one that can not respond frequently enough for your test.

• Measurement resolution is another key factor to consider for your DOE. Make 

sure your primary metric can decipher the size of the main effects and 

interactions you are looking for.
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DOE Primary Metric

• There is still even more to understand about your primary 
metric before jumping into a DOE.

• Be sure to answer these questions before proceeding:

• Is it discrete or continuous?

• Do you want to shift its mean?

• Do you want to squeeze variation?

• What is the baseline?

• Is it in control?

• Is there seasonality, trending, or any cycle?

• How much change do you want to detect?

• Is your metric normally distributed?
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DOE Input Variables – KPIVs (key process input variables)

• Factor selection is an important element in planning for a design of 

experiment.

• Factors are the “things” or metrics that your study responds to.

• Factors can be discrete or continuous.

• Factors should have largely been determined through the use of tools 

and analytics used throughout the DMAIC roadmap.

• Failure modes and effects analysis

• Cause and effect diagram (fishbone)

• X-Y matrix

• Process mapping

• Planned studies

• Passive analytics

• etc.
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• Factor settings are the range of values selected for each factor.

• Factor settings need to be predetermined before every experiment.
• Let us use this paper airplane as an example. Our factors under study for max distance 

as a response might be:
1. Number of folds

2. Paper weight

3. Paperclip (yes or no)

4. Thrust

5. Launch height

6. Launch angle etc.

• Factor settings are important because each setting selection should provide value 
to the study.
• Understanding the “margin” where that value can be found is where an experienced 

Black Belt will earn their keep.

• For example, what would we learn if we chose the test two levels for “number of folds” 
and we tested zero folds and 80 folds as our two settings for that factor? Right, nothing!

DOE Factor Settings
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DOE – Design Considerations

• Design selection is an aspect of properly planned design of experiments.

• High-level overview of design types (you will learn more about these in later 
modules)

• Screening Designs:

• Fractional factorials

• Intended to narrow down the many factors to the vital few

• Screening designs enable many factors to be evaluated at a lower cost because of 
the nature of the design (main effects)

• Characterization Designs:

• Higher resolution fractional factorials

• Full factorials with fewer variables

• Main effect and interactions

• Optimization Designs:

• Full factorials

• Response surface designs. 
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DOE Project Plan

• DOEs can require a fair amount of coordination between human and capital 
resources.

• Preparing a DOE project plan is a wise step.

• Make sure you identify critical dependencies like interfering with production or 
operating hours etc.

• Use project management software or, at a minimum, a Gantt chart to help you 
identify critical path items.
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DOE – Getting Support

• By running a DOE you are about to “discover” something new and 

better or validate an existing belief or assumption. 
(If you do not believe this you should not be running your DOE)

• You are also about to cost your firm money or disrupt someone’ s 

routine…Get everyone on the same page before moving forward!

• Hopefully, you have already established the framework for the following 

items. If not, follow these steps:

1. Business Case and Justification

2. Stakeholder Analysis – figure out who is with you and your project and 

who is not

3. Communication Plan – build and execute your communication plan 

based on the first two items.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1010



www.ABTU.edu

Run Your Experiment
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Analyze, Interpret, and Share Your DOE Results
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DOE Iterations

• One single DOE might not be enough to completely answer the questions 

due to the following reasons:

• None of the potential factors identified are statistically significant to the 

response.

• More factors need to be included in the model.

• Residuals of the model are not performing well.

• The objectives of DOE changes due to business reasons.
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4.3.3 Experiment Design Considerations
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Considerations of Experiments

• Objectives of the experiments

• Resource availability to run the experiments

• Potential costs to implement the experiments

• Stakeholders’ support for successful experiments

• Accuracy and precision of the measurement system

• Statistical stability of the process

• Unexpected plans or changes

• Sequence of running the experiments

• Simplicity of the model

• Inclusion of potential significant factors

• Settings of factors

• Well-behaved residuals
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4.4 Full Factorial Experiments
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Black Belt Training: Improve Phase

4.1 Simple Linear Regression

4.1.1 Correlation

4.1.2 X-Y Diagram

4.1.3 Regression Equations

4.1.4 Residuals Analysis

4.2 Multiple Regression Analysis

4.2.1 Non-Linear Regression

4.2.2 Multiple Linear Regression

4.2.3 Confidence Intervals

4.2.4 Residuals Analysis

4.2.5 Data Transformation, Box Cox

4.2.6 Stepwise Regression

4.2.7 Logistic Regression

4.3 Designed Experiments

4.3.1 Experiment Objectives

4.3.2 Experimental Methods

4.3.3 DOE Design Considerations

4.4 Full Factorial Experiments

4.4.1 2k Full Factorial Designs

4.4.2 Linear and Quadratic Models

4.4.3 Balanced and Orthogonal Designs

4.4.4 Fit, Model, and Center Points

4.5 Fractional Factorial Experiments

4.5.1 Designs

4.5.2 Confounding Effects

4.5.3 Experimental Resolution
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4.4.1 2k Full Factorial Designs
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DOE Key Terms

• Response: Y, dependent variable, process output measurement

• Effect: The change in the average response across two levels of a factor or 
between experimental conditions 

• Factor: X’s, inputs, independent variables

• Fixed Factor: Factor that can be controlled during the study 

• Random Factor: Factor that cannot be controlled during the study 

• Factor Levels: Factor settings, usually high and low, + and -, 1 and -1

• Treatment Combination: setting of all factors to obtain one response 
measurement (also referred to as a “run”)

• Replication: Running the same treatment combination more than once 
(sequence of runs is typically randomized)

• Repeat: Non-randomized replicate of all treatment combinations

• Inference Space: Operating range of factors under study

• Main Effect: The average change from one level setting to another for a single 
factor

• Interaction: The combined effect of two factors independent of the main effect 
of each factor
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More About Factors

• Factors in DOE are the potential causes that might have significant 

impact on the outcome of a process or a product.

• Factors are the inputs of a process or system and the response is the 

output of it.

• Factors can be continuous or discrete variables.

• Most experiments use two or more factors. Ask subject matter experts’ 

opinions for main factors selection. The more factors in DOE, the more 

costs triggered.
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More About Factors

• The goal of a DOE is to measure the effects of factors and interactions 

of factors on the outcome.

• In DOE: 

• First, we create a set of different combinations of factors each at different 

levels.

• Second, we run the experiment and collect the response values in different 

scenarios.

• Third, we analyze the results and test how the response changes 

accordingly when factors change.
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Factor Levels

• Factor levels are the selected settings of a factor we are testing in the 

experiment.

• The more levels a factor has, the more scenarios we have to create 

and test. As a result, more resources are required to collect samples 

and the model is more complicated.

• The most popular DOE is two-level design, meaning only two levels for 

each factor.
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Factor Levels

• Code of factor levels

• High vs. Low

• (+1) vs. (-1)

• (+) vs. (-)

• Example of factor levels

• A study on how two factors affect the taste of cakes.

Two Factors

Two Levels
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Treatment Combination

• A treatment is a combination of different factors at different levels.

• It is a unique scenario setting in an experiment.

• Coding treatments:

• If there are two factors in an experiment, we name one factor A and the 

other factor B.

• A single treatment in an experiment is named for each factor:

• --, +-, -+ and ++

• l, a, b and ab
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Treatment Combination

• Example of treatment

• A study on how two factors affect the taste of cakes.

Four treatments
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Response

• A response is the output of a process, a system, or a product.

• It is the outcome we are interested to improve by optimizing the 

settings of factors.

• In an experiment, we observe, record, and analyze the corresponding 

changes occurring in the response after changing the settings of 

different factors.
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Response

• Example of treatment

• A study on how two factors affect the taste of cakes. We use a predefined 

metric to measure the cake’s tastiness.

• After running each treatment, we obtain and record the resulting response 

value.

One response
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Main Effect

• Main effect is the average change in the response resulting from the 

change in the levels of a factor.

• It captures the effect of a factor alone on the response without taking 

into consideration other factors.

• In the baking cake example, the main effects of temperature and time 

length are

6
2

2220

2

1218
−=

+
−

+
=AMainEffect

2
2

1820

2

1222
−=

+
−

+
=BMainEffect
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Main Effect

• Interpretation of main effect in the example:

• By changing the temperature level of the oven from high to low, the 

response (i.e., tastiness of the cake) increases by 6 measurement units.

• By changing the time length of baking from high to low, the response (i.e., 

tastiness of the cake) increases by 2 measurement units.
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Interaction Effect

• Interaction effect is the average change in the response resulting from 

the change in the interaction of multiple factors.

• It occurs when the change in the response triggered by one factor 

depends on the change in other factor(s). L
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Interaction Effect

• Example of interaction effect

• By changing the interaction from high to low, the response (i.e., 

tastiness of the cake) increases by 4 measurement units.

One interaction

4
2

1822

2

1220
−=

+
−

+
=nEffectInteractio
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2k Full Factorial DOE

• In a full factorial experiment, all of the possible combinations of factors 

and levels are created and tested.

• For example, for two-level design (i.e., each factor has two levels) with 

k factors, there are 2k possible scenarios or treatments.

• 2 factors, each with 2 levels, we have 22 = 4 treatments

• 3 factors, each with 2 levels, we have 23 = 8 treatments

• k factors, each with 2 levels, we have 2k treatments
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2k Full Factorial DOE

• Full factorial DOE is used to discover the cause-and-effect relationship 

between the response and both individual factors and the interaction of 

factors.

• Generate an equation to describe the relationship between Y and the 

important Xs:

 +++++= kp XXXXXY 2122110

where

Y is the response and X1, X2, …, Xk are the factors.

α0 is the intercept and α1, α2, …, αp are the coefficients of the factors and 

interactions.

ε is the error of the model.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1033



www.ABTU.edu

Two-Level Two-Factor Full Factorial

• Below is a design pattern of a two-level two-factor full factorial 

experiment:
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Two-Level Three-Factor Full Factorial

• Below is a design pattern of a two-level three-factor full factorial 

experiment
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Two-Level Four-Factor Full Factorial

• Below is a design pattern of a two-level four-factor full factorial 

experiment
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Two-Level Five-Factor Full Factorial

• At right is a design pattern of a 

two-level five-factor full factorial 

experiment
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Order to Run Experiments

• The four design patterns shown earlier are listed in the standard order.

• Standard order  is used to design the combinations/treatments before 

experiments start.

• When actually running the experiments, randomizing  the standard 

order is recommended to minimize the noise.
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Replication in Experiments

• Each treatment can be tested multiple times in an experiment in order 

to increase the degrees of freedom and improve the capability of 

analysis. We call this method replication.

• Replicates are the number of repetitions of running an individual 

treatment.

• The order to run the treatments in an experiment should be 

randomized to minimize the noise.
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22 Full Factorial DOE

• Case study: we are running a 22 full factorial DOE to discover the 

cause-and-effect relationship between the cake tastiness and two 

factors: temperature of the oven and time length of baking.

• Each factor has two levels and there are four treatments in total.

• We decide to run each treatment twice so that we have enough degrees of 

freedom to measure the impact of two factors and the interaction between 

two factors. Therefore, there are eight observations in response eventually.
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22 Full Factorial DOE

• After running the four treatments twice in a random order, we obtain the 

following results
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22 Full Factorial DOE

• The experiment results are consolidated into the following table

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1042



www.ABTU.edu

22 Full Factorial DOE

• Main effect of factor A (temperature of the oven):

F
a
c
to

r 
B

Factor Alow high

lo
w

h
ig

h

l

b ab

a

r

lbaba
MainEffect

kA 12

)()(
−

+−+
=

25.6

22

)4144()2535(
12

−=



+−+
=

−

where

k is the number of factors,

r is the number of times individual 

treatments are being run.
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22 Full Factorial DOE

• Main effect of factor B (time length of baking):

F
a
c
to

r 
B

Factor Alow high

lo
w

h
ig

h

l

b ab

a

r

laabb
MainEffect

kB 12

)()(
−

+−+
=

75.1

22

)4135()2544(
12

−=



+−+
=

−

where

k is the number of factors,

r is the number of times individual 

treatments are being run.
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22 Full Factorial DOE

• Interaction (i.e., A*B) effect

F
a
c
to

r 
B

Factor Alow high

lo
w

h
ig

h

l

b ab

a

r

baabl
nEffectInteractio

k 12

)()(
−

+−+
=

25.3

22

)4435()2541(
12

−=



+−+
=

−

where

k is the number of factors,

r is the number of times individual 

treatments are being run.
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22 Full Factorial DOE

• Sum of squares of factors and interaction

125.78
22

)41442535(

2

)(
2

22

=


−−+
=

−−+
=

r

lbaba
SS

kA

125.6
22

)41352544(

2

)(
2

22

=


−−+
=

−−+
=

r

laabb
SS

kB

125.21
22

)44352541(

2

)(
2

22

=


−−+
=

−−+
=

r

baabl
SS

knInteractio

where

k is the number of factors,

r is the number of times individual treatments are being run.
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22 Full Factorial DOE

• Degrees of freedom of factors and interaction

• Four degrees of freedom are required in the model because there are 

three independent variables (a, b, ab interaction) in the equation and 

one degree of freedom is required for the error:

• Y = α0 + α1 * A + α2 * B + α3 * A * B + Error

1=Adf

1=Bdf

1=nInteractiodf

1=errordf
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22 Full Factorial DOE

• Mean squares of factors and interaction

125.78
1

125.78
===

A

A
A

df

SS
MS

125.6
1

125.6
===

B

B
B

df

SS
MS

125.21
1

125.21
===

nInteractio

nInteractio
nInteractio

df

SS
MS
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Use Minitab to Run a 2k Full Factorial DOE

• Step 1: Initiate the experiment design

• Click Stat → DOE → Factorial → Create Factorial Design to open the dialog box  “Create Factorial Design”.

• Select the button of “General full factorial design.”

• Select “2” as the “Number of factors.”

• Click the “Designs” button and a new window named “Create Factorial Design – Designs” pops up.

• Enter the factor name “Temperature” for factor A and 2 for number of levels.

• Enter the factor name “Time Length” for factor B and 2 for number of levels.

• Enter “2” as the “Number of replicates.

• Click “OK” button in the window “Create Factorial Design – Designs.”

• Click on the “Factors” button in the window “Create Factorial Design” and a new window named “Create Factorial 
Design – Factors” pops up.

• Select “Text” as the “Type” of both factor A and B.

• Enter “Low” and “High” as the two levels for both factor A and B.

• Click “OK” in the window “Create Factorial Design – Factors.”

• Click “OK” in the window “Create Factorial Design.”

• The design table is created in the data table.
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Use Minitab to Run a 2k Full Factorial DOE
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Use Minitab to Run a 2k Full Factorial DOE

• Step 2: Run the experiment in Run Order and record the response in a 

new column labeled “Tastiness” in the table created by Minitab.

• We have run the experiment for you. Open data file “DOE Full.mtw”. 

The results of the experiment have been recorded in this file. 
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Use Minitab to Run a 2k Full Factorial DOE

• Step 4: Analyze the experiment results

• Click Stat → DOE → Factorial → Analyze Factorial Design.

• A new window named “Analyze Factorial Design” appears.

• Select “Tastiness” in the list box of “Responses.”

• Click on the “Storage” button and a new window named “Analyze Factorial 

Design – Storage” pops up.

• Check the boxes “Fits” and “Residuals” in the window “Analyze Factorial Design 

– Storage.”

• Click “OK” in the window “Analyze Factorial Design – Storage.”

• Click “OK” in the window “Analyze Factorial Design.”

• The DOE analysis results appear in the session window.
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Use Minitab to Run a 2k Full Factorial DOE
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Use Minitab to Run a 2k Full Factorial DOE

• Since the p values of all the 

independent variables in the 

model are smaller than the alpha 

level (0.05), both factors and 

their interactions have 

statistically significant impact on 

the response.

• The p-value for the overall model 

indicate that the model is 

significant and at least one of the 

factors is statistically significant.

• A high R2 value shows around 

98% of the variation in the 

response can be explained by 

the model.
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Use Minitab to Run a 2k Full Factorial DOE

• The fitted response and the residuals of the DOE model are stored in 

the last two columns of the data table.
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4.4.2 Linear & Quadratic Models
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Linear DOE

• If we assume the relationship between the response and the factors is 

linear, we use a two-level design experiment in which there are two 

settings for individual factors.

• The linear model of a two-level design with three factors:





+++

+++++=

3211233223

311321123322110

XXXXX

XXXXXXXY

where

Y is the response.

X1, X2, X3 are the three two factors.

α0 is the intercept.

α1, α2, …, α123 are the coefficients of the factors and interactions.

ε is the error of the model.
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Quadratic DOE

• It is possible that the relationship between the response and the factors 

is non-linear.

• To test the non-linear relationship between the response and the 

factors, we need at least a three-level design, i.e., quadratic design of 

experiment.

• The quadratic DOE adds the       ,       ,…,        and corresponding 

interactions into the model as potential significant factor of the 

response.

2

1X 2

2X 2

kX

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1058



www.ABTU.edu

4.4.3 Balanced & Orthogonal Designs
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Balanced Design

• In DOE, an experiment design is balanced if individual treatments have 

the same number of observations.

• In other words, if an experiment is balanced, each level of each factor 

is run the same number of times.

• The following design is balanced since the two factors are both run 

twice at each level. 
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Orthogonal Design

• In DOE, an experiment design is orthogonal if the main effect of one 

factor can be evaluated independently of other factors.

• In other words, for each level (high setting or low setting) of a factor, 

the number of high setting and low setting in any other factors must be 

the same.
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Orthogonal Design

• In the following design, for the higher level (+1) of factor A, the number 

of “+1” in factor B is 2 but the number of “-1” in factor B is 0. Therefore, 

this is not an orthogonal design.
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Orthogonal Design

• In the following design, for the higher level (+1) of factor A, the number 

of “+1” in factor B is 1 and the number of “-1” in factor B is 1 as well. 

Therefore, this is an orthogonal design.
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Checking for an Orthogonal Design

• We can check to see if our design is orthogonal with some very simple 

math.

• In an orthogonal design, the sum of products for each run should equal 

zero.

• Let us check the earlier design that we said was orthogonal:

• Run 1: -1 * -1 = 1

• Run 2: +1 * -1 = -1

• Run 3: -1 * +1 = -1

• Run 4: +1 * +1 = 1

• Sum = 0

• Design is orthogonal
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Checking for an Orthogonal Design

• Now let us check the earlier design that we said was not orthogonal:

• Run 1: -1 * -1 = 1

• Run 2: -1 * -1 = 1

• Run 3: +1 * +1 = 1

• Run 4: +1 * +1 = 1

• Sum = 4

• Design is not orthogonal

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1065



www.ABTU.edu

4.4.4 Fit, Diagnosis and Center Points
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Use Minitab to Fit the Model of DOE

• If one of the factors or interactions has a p-value larger than alpha level 

(0.05), it indicates that the particular factor or interaction does not have 

statistically significant impact on the response.

• To fit the model better, we need to remove the insignificant independent 

variables one at a time and run the model again until all the 

independent variables in the model are statistically significant (i.e. p-

value smaller than alpha level).
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Use Minitab to Diagnose the Model

• To ensure that the quality of the model is acceptable, we need to 

conduct the residuals analysis.

• Residual is the difference between the actual response value and the fitted 

response value.

• Well-performing residuals:

• Are normally distributed

• Have a mean equal to zero

• Are independent

• Have equal variance across the fitted values.
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Use Minitab to Diagnose the Model

• Step 1: Check whether the mean of residuals is zero and residuals are 

normally distributed.

1) Click Stat → Basic Statistics → Graphical Summary.

2) A new window named “Graphical Summary” appears.

3) Select “RESI1” as the “Variables.”

4) Click “OK.”

5) The histogram and normality test results appear in the new window.
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Use Minitab to Diagnose the Model
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Use Minitab to Diagnose the Model

• Since the p-value of the 

normality test is not less 

the alpha level, we fail 

to reject the null and 

conclude that the 

residuals are normally 

distributed

• The mean of the 

residuals is 

approximately zero.
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Use Minitab to Diagnose the Model

• Step 2: Check whether the residuals are independent.

1) Click Stat → Control Charts → Variable Charts for Individuals → I-MR.

2) A new window named “Individuals-Moving Range Chart” appears.

3) Select “RESI1” as the “Variables.”

4) Click “OK.”

5) The I-MR charts appear in the new window.

6) If no data points on the control charts fail any tests, the residuals are in 

control and independent of each other.

Note: The prerequisite of plotting IMR chart for residuals is that the residuals 

are in time order.
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Use Minitab to Diagnose the Model
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Use Minitab to Diagnose the Model

• If no data points on the control charts fail any tests, the residuals are in 

control and independent of each other.
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Use Minitab to Diagnose the Model

• Step 3: Check whether the residuals have equal variance across the 

predicted response values.

1) Click Graph → Scatterplot.

2) A new window named “Scatterplots” appears.

3) Click “OK” in the window “Scatterplots” and a new window named “Scatterplot 

– Simple” appears.

4) Select “RESI1” as the “Y variables” and “FITS1” as the “X variables.”

5) Click “OK.”

6) The scatter plot between the residuals and the fitted response appears in the 

new window.
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Use Minitab to Diagnose the Model
L

e
a

n
 S

ix
 S

ig
m

a
 T

ra
in

in
g

 -
M

T
B

©
 A

m
e

ric
a

n
 B

&
T

 U
n

iv
e

rs
ity

1076



www.ABTU.edu

Use Minitab to Diagnose the Model

• We look for patterns in which the residuals tend to have even variation 

across the entire range of the fitted response values.
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Center Points in DOE

• The two-level design of experiment assumes that the relationship 

between the response and the factors is linear.

• We can use center points to check whether the assumption is true by 

adding center point runs to the experiment. 

• In each center point run, the factors are all set to be in the center 

setting (zero) between high (+1) and low (-1) settings.

• Center points do not change the model to quadratic.

• They allow a check for adequacy of linear model.

• If a line connecting factor settings passes through the center of the design, 

the model is adequate to predict within the inference space.
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4.5 Fractional Factorial Experiments
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Black Belt Training: Improve Phase

4.1 Simple Linear Regression

4.1.1 Correlation

4.1.2 X-Y Diagram

4.1.3 Regression Equations

4.1.4 Residuals Analysis

4.2 Multiple Regression Analysis

4.2.1 Non-Linear Regression

4.2.2 Multiple Linear Regression

4.2.3 Confidence Intervals

4.2.4 Residuals Analysis

4.2.5 Data Transformation, Box Cox

4.2.6 Stepwise Regression

4.2.7 Logistic Regression

4.3 Designed Experiments

4.3.1 Experiment Objectives

4.3.2 Experimental Methods

4.3.3 DOE Design Considerations

4.4 Full Factorial Experiments

4.4.1 2k Full Factorial Designs

4.4.2 Linear and Quadratic Models

4.4.3 Balanced and Orthogonal Designs

4.4.4 Fit, Model, and Center Points

4.5 Fractional Factorial Experiments

4.5.1 Designs

4.5.2 Confounding Effects

4.5.3 Experimental Resolution
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4.5.1 Fractional Designs
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What Are Fractional Factorial Experiments?

• simple terms, a fractional factorial experiment is a subset 

of a full factorial experiment.

• Fractional factorials use fewer treatment combinations and 

runs.

• Fractional factorials are less able to determine effects because of fewer 

degrees of freedom available to evaluate higher order interactions.

• Fractional factorials can be used to screen a larger number of factors.

• Fractional factorials can also be used for optimization.
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Why Fractional Factorial Experiments?

• To run a full factorial experiment for k factors, we need 2k unique 

treatments. In other words, we need resources that can afford at least 

2k runs.

• With k increasing, the number of runs required in full factorial 

experiments rises dramatically even without any replications, and the 

percentage of degrees of freedom spent on the main effects 

decreases.

• The main effects and two-way interaction are the key effects we need 

to evaluate. The higher order the interaction is, the more we can ignore 

it.
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Why Fractional Factorial Experiments?
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How Does a Fractional Factorial Work?

• We are trying to find the cause-and-effect relationship between a 

response (Y) and three factors (factor A, B, and C) and their 

interactions (AB, BC, AC, and ABC).

• As follows is the 23 full factorial design (2 level 3 factor).

• There are eight treatment combinations (2 * 2 * 2).
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How Does a Fractional Factorial Work?

• To perform a 23 full factorial experiment, we need to run at least eight 

unique treatments (2 * 2 * 2).

• What if we only have enough resources to run four treatments? 

• As a result, we need to carefully select a subset from the eight 

treatments so that all of our main effects can be evaluated and the 

design can be kept balanced and orthogonal.
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How Does a Fractional Factorial Work?

• Example of an invalid design

• Remember orthogonality? 

This design is invalid because only 

the low setting of factor C is tested. 

We cannot evaluate the main effect 

of factor C using this design. 
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How Does a Fractional Factorial Work?

• Example of an invalid design

• Checking orthogonality: the sum of AC interaction signs should equal 
zero (0).
• Run 1 (-)

• Run 2 (-)

• Run 3 (-)

• Run 4 (+)

• Sum (-1) 

This design is also invalid because 

it is neither balanced nor 

orthogonal. L
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How Does Fractional Factorial Work?

• To select the four treatments run in the 23-1 fractional factorial 

experiment, we start from the 22 full factorial design of experiment.

• If we replace the two-way interaction (AB) column with the factor C 

column, the design will be valid.
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How Does a Fractional Factorial Work?

• 23-1 Fractional Factorial Design Pattern

• Three factors and four treatments

• Note: We also call this kind of design a half-factorial design since we 

only have half of the treatments that we would have in a full factorial 

design.

• In 23-1 fractional factorial design of experiment, the effect of three-way 

interaction (ABC) is not measurable since it only has “+1”.
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How Does a Fractional Factorial Work?

• In the 23-1 fractional factorial design, we notice that the column of each 

main effect has identical “+1” and “-1” values with one two-way 

interaction column.

• A and BC

• B and AC

• C and AB

• In this situation, we say that A is aliased with BC or A is the alias of BC.
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How Does a Fractional Factorial Work?

• By multiplying any column with itself, we obtain the identity (I).

• A * A = I

• The product of any column and the identity is the column itself.

• A * I = A

• Column ABC is called the generator.

• By multiplying any column with the generator, we obtain its alias.

• A * ABC = (A*A) * BC = I * BC = BC
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Use Minitab to Run a Fractional Factorial Experiment 

• Step 1: Initiate the experiment design

1) Click Stat → DOE → Factorial → Create Factorial Design.

2) A new window named “Create Factorial Design” pops up.

3) Select the radio button “2-level factorial (default generators).”

4) Enter “3” as the “Number of factors.”

5) Click on the “Design” button in the window “Create Factorial Design” and another 

new window named “Create Factorial Design – Designs” pops up.

6) Highlight the “1/2 fraction” design in the box.

7) Select “2” as the “Number of replicates for corner points.”

8) Click “OK” in the window “Create Factorial Design – Designs.”

9) Click “OK” in the window “Create Factorial Design.”

10) The design table is created in the data table.
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Use Minitab to Run a Fractional Factorial Experiment 
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Use Minitab to Run a Fractional Factorial Experiment 

• Step 1.2 (optional): Define the names and the levels for individual factors

1) Click on the “Factors” button in the window “Create Factorial Design” and a new 

window named “Create Factorial Design – Factors” appears.

2) Enter the names and the levels for individual factors. In this example, we keep 

the default names and levels for factors A, B, and C.
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Use Minitab to Run a Fractional Factorial Experiment 

• Step 2: Run the experiment in Run Order and record the response in a 

new column labeled “Y” in the table created by Minitab.

• We have run the experiment for you. Open data file “DOE 

Fractional.mtw”. The results of the experiment have been recorded in 

this file. 
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Use Minitab to Run a Fractional Factorial Experiment 

• Step 3: Fit the model using the experiment results

• Click Stat → DOE → Factorial → Analyze Factorial Design.

• A new window named “Analyze Factorial Design” appears.

• Select “Y” as the “Responses.”

• Click on the “Storage” button and another new window named “Analyze 

Factorial Design – Storage” pops up.

• Check the box “Fits” and “Residuals” so that both fitted responses and the 

residuals would be saved in the data table.

• Click “OK” in the window “Analyze Factorial Design – Storage.”

• Click “OK” in the window “Analyze Factorial Design.”

• The DOE analysis results appear in the session window.
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Use Minitab to Run a Fractional Factorial Experiment 
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Use Minitab to Run a Fractional Factorial Experiment 

• Step 4: Analyze the model results

1) Check whether the model is statistically significant.

2) Check which factors are insignificant.

3) If any independent variables are not significant, remove them one at a time 

and rerun the model until all the independent variables in the model are 

significant.
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Use Minitab to Run a Fractional Factorial Experiment 

• The p-value of factor B is greater 

than the alpha level (0.05), so it is 

not statistically significant.

• Next, we need to remove factor B 

and rerun the model.
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Use Minitab to Run a Fractional Factorial Experiment 

• In this example, since factor B is not statistically significant, it needs to 

be removed from the model.

• Click Stat → DOE → Factorial → Analyze Factorial Design.

• A new window named “Analyze Factorial Design” appears.

• Select “Y” as the “Responses.”

• Click on the “Terms” button and another new window named “Analyze Factorial 

Design – Terms” pops up.

• Deselect the factor “B:B” from the box “Selected Terms.”

• Click “OK” in the window “Analyze Factorial Design – Terms.”

• Click “OK” in the window “Analyze Factorial Design.”

• The DOE analysis results appear in the session window.
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Use Minitab to Run a Fractional Factorial Experiment 
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Use Minitab to Run a Fractional Factorial Experiment 

• The p-values of all the 

independent variables are 

smaller than 0.05. There is no 

need to remove any 

independent variables from 

the model. 
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Use Minitab to Run a Fractional Factorial Experiment 

• Step 5: Conduct residuals analysis to ensure that the residuals of the 

model satisfy the following criteria.

• Their mean is equal to zero.

• They are normally distributed.

• They are independent.

• There is equal variance across the fitted response values.
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Use Minitab to Run a Fractional Factorial Experiment 

• Step 5.1: Check whether residuals are normally distributed with mean 

equal to zero.

• Click Stat → Basic Statistics → Graphical Summary.

• A new window named “Graphical Summary” appears.

• Select “RESI2” as the “Variables.”

• Click “OK.”

• The histogram and the normality test of the residuals appear in the newly-

generated window.

• If the p-value of the normality test is greater than the alpha level (0.05), the 

residuals are normally distributed.
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Use Minitab to Run a Fractional Factorial Experiment 
L

e
a

n
 S

ix
 S

ig
m

a
 T

ra
in

in
g

 -
M

T
B

©
 A

m
e

ric
a

n
 B

&
T

 U
n

iv
e

rs
ity

1106



www.ABTU.edu

Use Minitab to Run a Fractional Factorial Experiment 

• The p-value of the 

normality test is larger 

than alpha level (0.05). 

The residuals are 

normally distributed.

• Residuals’ mean is zero.
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Use Minitab to Run a Fractional Factorial Experiment 

• Step 5.2: Check whether the residuals are independent.

• Click Stat → Control Charts → Variables Charts for Individuals → I-MR.

• A new window named “Individuals – Moving Range Chart” appears.

• Select the “RESI2” as the “Variables.”

• Click “OK.”

• The control charts appear in the newly-generated window.

• If no data points on the control charts fail any tests, the residuals are in control 

and independent of each other.

Note: The prerequisite of plotting I-MR chart for residuals: the residuals are in the 

time order.
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Use Minitab to Run a Fractional Factorial Experiment 
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Use Minitab to Run a Fractional Factorial Experiment 
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Use Minitab to Run a Fractional Factorial Experiment 

• Step 5.3: Check whether the residuals have equal variance across the 

predicted response values.

• Click Graph → Scatterplot.

• A new window named “Scatterplots” pops up.

• Click “OK” in the window “Scatterplots.”

• Another window named “Scatterplot – Simple” pops up.

• Select “RESI2” as “Y variables” and “FITS2” as “X variables.”

• Click “OK” in the window “Scatterplot – Simple.”

• The scatterplot between the fitted responses and the residuals appears in a 

new window.

• We look for patterns in which the residuals tend to have even variation across 

the entire range of the fitted response values.
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Use Minitab to Run a Fractional Factorial Experiment 
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4.5.2 Confounding Effects
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Confounding Effects

• In full factorial experiments the effects of every factor and their 
interactions can be calculated because there is a degree of freedom for 
every treatment combination as well as the error term.

• Fractional factorial experiments, however, are designed with fewer runs 
or treatment combinations but will have the same number of input 
factors.

• As a result, the experimenter must understand the impact of these 
consequences.

• Confounding (or aliased factors) is that consequence.

• Resolution is a quantification or degree of confounding.
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Confounding Effects

• When two input factors are aliases of each other, the effects 

they each have on the response cannot be separated.

• In the 23-1 fractional factorial design, A and BC are aliases. 

• The main effect that A has on the response would be exactly the same 

as the interaction effect of BC. We cannot tell which one is truly 

significant.

• The effects of aliased factors are what is referred to as confounded.

• Due to the confounding nature of aliased factors, the effect we observe 

is the mixed effect of aliased factors.

• A + BC

• B + AC

• C + AB

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1115



www.ABTU.edu

Resolution

• Resolution is the measure or degree of confounding.

• Higher resolution means less confounding or merely confounding main 

effects with higher order interactions.

• The resolution of a fractional factorial experiment will always be one 

number higher than the order of interactions that are confounded with 

main effects.

• Resolution III: Main effects are confounded with two-way interactions. 

If you are only interested in main effects, then resolution III is 

acceptable. Otherwise, resolution III is typically undesirable.

• Resolution IV: Main effect are confounded with three-way interactions.

• Resolution V: Main effects are confounded with four-way interactions.
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Consequences of Fractional Factorials

• Benefits:

• The primary benefits of properly designed fractional factorial experiments are 

achieved because of fewer runs.

• You may have limited time, resources, or capital and cannot run a full factorial.

• Disadvantages:

• Confounding (a.k.a. aliasing)

• Mitigation Option

• Replications: by adding replicates you can introduce more study runs and 

increase the resolution of your experiment.

• Replications, however, will also increase the number of trials or runs sometimes, 

defeating the purpose of running a fractional factorial experiment.
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4.5.3 Experimental Resolution
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Alias in 23-1 Fractional Factorial Experiment

• In the 23-1 fractional factorial design of experiment, the main factor is 

aliased or confounded with two-way interactions.

• A is the alias of BC.

• B is the alias of AC.

• C is the alias of AB.
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Alias in 24-1 Fractional Factorial Experiment 

• In the 24-1 fractional factorial design of experiment, the main factor is 

aliased with three-way interaction and two-way interaction is aliased 

with two-way interaction.

• A is the alias of BCD.

• B is the alias of ACD.

• C is the alias of ABD.

• D is the alias of ABC.

• AB is the alias of CD.

• AC is the alias of BD.

• AD is the alias of BC.
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Design Resolution

• Design resolution (i.e., experimental resolution) refers to the 

confounding patterns indicating how the effects are confounded with 

others.

• If two factors are aliases, they have confounded effect on the 

response. There is no need to consider both factors in the model due 

to the redundancy. Only one factor needs to be included in the model 

for simplicity.

• Most popular resolutions are resolution III, IV, and V.

• Resolution III: Main effects are aliased with two-way interactions.

• Resolution IV: Main effects are aliased with three-way interactions. Two-

way interactions are aliased with other two-way interactions.

• Resolution V: Main effects are aliased with four-way interactions. Two-way 

interactions are aliased with three-way interactions.
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Determine Aliases

• To find the alias of a particular factor, we only need to multiply the 

factor of interest with the identity (I) of the design.

• In 23-1 fractional factorial design, ABC is the identity. To find the alias of 

factor A, we use A * ABC = BC.

• In 24-1 fractional factorial design, ABCD is the identity. To find the alias of 

factor A, we use A * ABCD = BCD.

• In 25-1 fractional factorial design, ABCDE is the identity. To find the alias of 

factor A, we use A * ABCDE = BCDE.
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5.0 Control Phase

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1123



www.ABTU.edu

Black Belt Training: Control Phase

5.1 Lean Controls

5.1.1 Control Methods for 5S

5.1.2 Kanban

5.1.3 Poka-Yoke (Mistake Proofing)

5.2 Statistical Process Control (SPC)

5.2.1 Data Collection for SPC

5.2.2 I-MR Chart

5.2.3 Xbar-R Chart

5.2.4 U Chart

5.2.5 P Chart

5.2.6 NP Chart

5.2.7 X-S chart

5.2.8 CumSum Chart

5.2.9 EWMA Chart

5.2.10 Control Methods

5.2.11 Control Chart Anatomy

5.2.12 Subgroups, Variation, Sampling

5.3 Six Sigma Control Plans

5.3.1 Cost Benefit Analysis

5.3.2 Elements of the Control Plan

5.3.3 Elements of the Response Plan
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5.1 Lean Controls
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Black Belt Training: Control Phase

5.1 Lean Controls

5.1.1 Control Methods for 5S

5.1.2 Kanban

5.1.3 Poka-Yoke (Mistake Proofing)

5.2 Statistical Process Control (SPC)

5.2.1 Data Collection for SPC

5.2.2 I-MR Chart

5.2.3 Xbar-R Chart

5.2.4 U Chart

5.2.5 P Chart

5.2.6 NP Chart

5.2.7 X-S chart

5.2.8 CumSum Chart

5.2.9 EWMA Chart

5.2.10 Control Methods

5.2.11 Control Chart Anatomy

5.2.12 Subgroups, Variation, Sampling

5.3 Six Sigma Control Plans

5.3.1 Cost Benefit Analysis

5.3.2 Elements of the Control Plan

5.3.3 Elements of the Response Plan
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5.1.1 Control Methods for 5S
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What is 5S?

• 5S is a systematic method to organize, order, clean, and standardize a 

workplace…and keep it that way!

• 5S is a methodology of organizing and improving the work environment.

• 5S is summarized in five Japanese words, all starting with the letter S:

• Seiri (sorting)

• Seiton (straightening)

• Seiso (shining)

• Seiketsu (standardizing)

• Shisuke (sustaining).

• 5S was originally developed in Japan, and is widely used to optimize 

the workplace to increase productivity and efficiency.
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5S Goals

• Reduced waste

• Reduced cost

• Establish a work environment that is: 
• self-explaining

• self-ordering

• self-regulating

• self improving.

• Where there is/are no more:

• Wandering and/or searching

• Waiting or delays

• Secrets hiding spots for tools

• Obstacles or detours

• Extra pieces, parts, materials, etc.

• Injuries

• Waste.
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5S Benefits

• Reduced changeovers 

• Reduced defects

• Reduced waste

• Reduced delays 

• Reduced injuries 

• Reduced breakdowns 

• Reduced complaints

• Reduced red ink

• Higher quality

• Lower costs

• Safer work environment

• Greater associate and equipment capacity
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5S Systems Reported Results 

• Cut in floor space: 60%

• Cut in flow distance: 80%

• Cut in accidents: 70%

• Cut in rack storage: 68%

• Cut in number of forklifts: 45%

• Cut in machine changeover time: 62%

• Cut in annual physical inventory time: 50%

• Cut in classroom training requirements: 55%

• Cut in nonconformance in assembly: 96%

• Increase in test yields: 50%

• Late deliveries: 0%

• Increase in throughput:   15%
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Sorting (Seiri)

• Go through all tools, parts, equipment, supply, and 

materials in the workplace.

• Categorize into two major groups: needed and 

unneeded.

• Eliminate unneeded items from the workplace. 

Dispose of or recycle those items.

• Keep need items and sort in order of priority. When in 

doubt…throw it out!
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Straightening (Seiton)

• Straightening in 5S is also called setting in 

order.

• Label each needed item.

• Store items at their best locations so that the 

workers can find them easily whenever they 

needed any item.

• Reduce the motion and time required to locate 

and obtain any item whenever it is needed. 

• Promote an efficient work flow path.

• Use visual aids like the tool board image on this 

page.
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Shining (Seiso)

• Shining in 5S is also called sweeping.

• Clean the workplace thoroughly.

• Maintain the tidiness of the workplace.

• Make sure every item is located at the specific location 

where it should be.

• Create the ownership in the team to keep the work area 

clean and organized.
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Standardizing (Seiketsu )

• Standardize the workstation and the layout of tools, equipment, and 

parts.

• Create identical workstations with a consistent way of storing the items 

at their specific locations so that workers can be moved around to any 

workstation any time and perform the same task.
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Sustaining (Shisuke)

• Sustaining in 5S is also called self-discipline.

• Create the culture in the team to follow the first four S’s consistently.

• Avoid falling back to the old ways of cluttered and unorganized work 

environment.

• Keep the momentum of optimizing the workplace.

• Promote innovations of workplace improvement.

• Sustain the first fours S’s using:

• 5S Maps

• 5S Schedules

• 5S Job cycle charts

• Integration of regular work duties

• 5S Blitz schedules

• Daily workplace scans.
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Simplified Summary of 5S

• Sort – “when in doubt, move it out.”

• Set in Order – Organize all necessary tools, parts, and components of 

production. Use visual ordering techniques wherever possible.

• Shine – Clean machines and/or work areas. Set regular cleaning 

schedules and responsibilities.

• Standardize – Solidify previous three steps, make 5S a regular part of 

the work environment and everyday life.

• Sustain – Audit, manage, and comply with established five-s 

guidelines for your business or facility
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5.1.2 Kanban
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What is Kanban?

• The Japanese word “Kanban” means “signboard.”

• Kanban system is a “pull” production scheduling system to determine 

when to produce, what to produce, and how much to produce based on 

the demand.

• It was originally developed by Taiichi Ohno in order to reduce the waste 

in inventory and increase the speed of responding to the immediate 

demand.
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Kanban System

• Kanban system is a demand-driven system.

• The customer demand is the signal to trigger or pull the production. 

• Products are made only to meet the immediate demand. When there is 

no demand, there is no production.

• It is designed to minimize the in-process inventory and to have the right 

material with the right amount at the right location at the right time.
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Kanban System

• Principles of the Kanban System:

• Only produce products with exactly the same amount that customers 

consume.

• Only produce products when customers consume.

• The production is driven by the actual demand from the customer side 

instead of the forecasted demand planned by the staff.
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Kanban Card

• The Kanban card is the ticket or signal to authorize the production or 

movement of materials. It is the message of asking for more.

• It is sent from the end customer up to the chain of production.

• Upon receiving of a Kanban card, the production station would start to 

produce goods.

• The Kanban card can be a physical card or an electronic signal.
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Kanban System Example

• The simplest example of a Kanban system is the supermarket 
operation.

• Customers visit the supermarkets and buy what they need.

• The checkout scanners send electronic Kanban cards to the local 
warehouse asking for more when the items are sold to customers.

• When the warehouse receives the Kanban cards, it starts to replenish 
the exact goods being sold.

• It the warehouse prepares more than what Kanban cards require, the 
goods would become obsolete. If it prepares less, the supermarket 
would not have the goods available when customers need them.
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Kanban System Benefits

• Minimize in-process inventory

• Free up space occupied by unnecessary inventory

• Prevent overproduction

• Improve responsiveness to dynamic demand

• Avoid the risk of inaccurate demand forecast

• Streamline the production flow

• Visualize the work flow.
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5.1.3 Poka-Yoke
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What is Poka-Yoke?

• The Japanese term “poka-yoke” means “mistake-proofing.”

• It is a mechanism to eliminate defects as early as possible in the 

process.

• It was originally developed by Shigeo Shingo and was initially called 

“baka-yoke” (fool-proofing).
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Two Types of Poka-Yoke

• Prevention

• Preventing defects from occurring

• Removing the possibility that an error could occur

• Making the occurrence of an error impossible.

• Detection

• Detecting defects once they occur

• Highlighting defects to draw workers’ attention immediately 

• Correcting defects so that they would not reach the next stage. 
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Three Methods of Poka-Yoke

• Contact Method

• Use of shape, color, size, or any other physical attributes of the items.

• Constant Number Method

• Use of a fixed number to make sure a certain number of motions are 

completed.

• Sequence Method

• Use of a checklist to make sure all the prescribed process steps are 

followed in the right order.
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Poka-Yoke Devices

• We are surrounded by poka-yoke devices daily.

• Prevention Devices

• Example: the dishwasher does not start to run when the door is open.

• Detection Devices

• Example: the car starts to beep when the passengers do not buckle their 

seatbelts.

• Poka-yoke devices can be in any format that can quickly and effectively 

prevent or detect mistakes.

• Visual, electrical, mechanical, procedural, human etc.
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Steps to Apply Poka-Yoke

• Step 1: Identify the process steps in need of mistake proofing.

• Step 2: Use the 5-why’s method to analyze the possible mistakes or failures 

for the process step.

• Step 3: Determine the type of poka-yoke: prevention or detection.

• Step 4: Determine the method of poka-yoke: contact, constant number, or 

sequence.

• Step 5: Pilot the poka-yoke approach and make any adjustments if needed.

• Step 6: Implement poka-yoke in the operating process and maintain the 

performance.
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5.2 Statistical Process Control
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Black Belt Training: Control Phase

5.1 Lean Controls

5.1.1 Control Methods for 5S

5.1.2 Kanban

5.1.3 Poka-Yoke (Mistake Proofing)

5.2 Statistical Process Control (SPC)

5.2.1 Data Collection for SPC

5.2.2 I-MR Chart

5.2.3 Xbar-R Chart

5.2.4 U Chart

5.2.5 P Chart

5.2.6 NP Chart

5.2.7 X-S chart

5.2.8 CumSum Chart

5.2.9 EWMA Chart

5.2.10 Control Methods

5.2.11 Control Chart Anatomy

5.2.12 Subgroups, Variation, Sampling

5.3 Six Sigma Control Plans

5.3.1 Cost Benefit Analysis

5.3.2 Elements of the Control Plan

5.3.3 Elements of the Response Plan
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5.2.1 Data Collection for SPC
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What is SPC?

• Statistical process control (SPC) is a statistical method to monitor the 

performance of a process using control charts in order to keep the 

process in statistical control.

• Statistical process control can be used to distinguish between special 

cause variation and common cause variation in the process.

• It presents the voice of the process.
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Common Cause Variation

• Common cause variation (also called chance variation) is the inherent 

natural variation in any processes.

• It is the random background noise, which cannot be controlled or 

eliminated from the process.

• Its presence in the process is expected and acceptable due to its 

relatively small influence on the process.
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Special Cause Variation

• Special cause variation (also called assignable cause variation) is the 

unnatural variation in the process.

• It is the cause of process instability and leads to defects of the products 

or services.

• It is the signal of unanticipated change (either positive or negative) in 

the process. 

• It is possible to eliminate the special cause variation from the process.
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Process Stability

• A process is stable when: 

• There is not any special cause variation involved in the process

• The process is in statistical control

• The future performance of the process is predictable within certain limits

• The changes happening in the process are all due to random inherent 

variation

• There are not any trends, unnatural patterns, and outliers in the control 

chart of the process.
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SPC Benefits

• Statistical process control can be used in different phases of Six Sigma 

projects to:

• Understand the stability of a process

• Detect the special cause variation in the process

• Identify the statistical difference between two phases

• Eliminate or apply the unnatural change in the process

• Improve the quality and productivity.
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Control Charts

• Control charts are graphical tools to present and analyze the process 

performance in statistical process control.

• Control charts are used to detect special cause variation and determine 

whether the process is in statistical control (stable).

• Variation solutions:

• Minimize the common cause variation

• Eliminate the special cause variation when it leads to unanticipated 

negative changes in the outcome

• Implement the special cause variation when it leads to unanticipated 

positive changes in the outcome.
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Control Charts Elements

Lower Line: lower control limit (LCL)

Upper Line: upper control limit (UCL)Data Points: individual observations 

or their calculation results

Horizontal axis: Time
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Center Line: the process mean
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Control Charts Elements

• Control charts can work for both continuous data and discrete or count 

data.

• Control limits are approximately three sigma away from the process 

mean.

• A process is in statistical control when all the data points on the control 

charts fall within the control limits and have random patterns only. 

• Otherwise, the process is out of control and we need to investigate the 

special cause variation in the process.
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Possible Errors in SPC

• There are two types of possible errors in interpreting controls charts.
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Possible Errors in SPC

• It is similar to the way of defining the type I and type II errors in 

hypothesis testing.

• Control charts can be interpreted as a way of testing the hypothesis 

about the process stability.

• Null Hypothesis (H0): The process is stable (i.e., in statistical control).

• Alternative Hypothesis (HA): The process is unstable (i.e., out of statistical 

control).

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1163



www.ABTU.edu

Possible Errors in SPC

• Type I Error

• False positive 

• False alarm

• Considering true common cause variation as special cause variation

• Type I errors waste resources spent on investigation.

• Type II Error

• False negative

• Miss

• Considering true special cause variation as common cause variation

• Type II errors neglect the need to investigate critical changes in the 

process.
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Data Collection Considerations

• To collect data for plotting control charts, we need to consider:

• What is the measurement of interest?

• Are the data discrete or continuous?

• How many samples do we need?

• How often do we sample?

• Where do we sample?

• What is the sampling strategy?

• Do we use the raw data collected or transfer them to percentages, 

proportions, rates, etc.? 
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Subgroups and Rational Subgrouping

• When sampling, we randomly select a group of items (i.e., a subgroup) from 
the population of interest.

• The subgroup size is the count of samples in a subgroup. It can be constant 
or variable.

• Depending on the subgroup sizes, we select different control charts 
accordingly.

• Rational subgrouping is the basic sampling scheme in SPC.

• The goal of rational subgrouping is to maximize the likelihood of detecting 
special cause variation. In other words, the control limits should only reflect 
the variation between subgroups.

• The number of subgroups, subgroup size, and frequency of sampling have 
great impact on the quality of control charts.
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Impact of Variation

• The rational subgrouping strategy is designed to minimize the 

opportunity of having special cause variation within subgroups.

• If there is only random variation (background noise) within subgroups, 

all the special cause variation would be reflected between subgroups. It 

is easier to detect an out-of-control situation.

• Random variation is inherent and indelible in the process. We are more 

interested in identifying and taking actions on special cause variation.
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Frequency of Sampling

• The frequency of sampling in SPC depends on whether we have 

sufficient data to signal the changes in a process with reasonable time 

and costs.

• The more frequently we sample, the higher costs it may trigger.

• We need the subject matter experts’ knowledge on the nature and 

characteristics of the process to make good decisions on sampling 

frequency.
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5.2.2 I-MR Chart
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I-MR Chart

• The I-MR chart (also called individual-moving range chart or I-MR chart) is a 

popular control chart for continuous data with subgroup size equal to one.

• The I chart plots an individual observation as a data point.

• The MR chart plots the absolute value of the difference between two 

consecutive observations in individual charts as a data point.

• If there are n data points in the I chart, there are n –1 data points in and MR 

chart with a moving range of 2.

• The I chart is valid only if the MR chart is in control.

• The underlying distribution of the I-MR chart is normal distribution.
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I Chart Equations

• I Chart (Individuals Chart)

• Data Point: 

• Center Line:

• Control Limits: 

n

x
n

i

i
=1

MR
n

x
n

i

i



= 66.21

ix

where n is the number of observations

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1171



www.ABTU.edu

MR-Chart Equations

• MR Chart (Moving Range Chart)

• Data Point: 

• Center Line: 

• Upper Control Limit:

• Lower Control Limit: 0 

ii xx −+1

where n is the number of observations

1

|| 1

−

− +

n

xx ii
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||
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Use Minitab to Plot I-MR Charts

• Data File: “IR” tab in “Sample Data.xlsx”

• Steps to plot I-MR charts in Minitab

1) Click Stat → Control Charts → Variable Charts for Individuals → I-MR.

2) A new window named “Individuals – Moving Range Chart” appears.

3) Select “Measurement” as the “Variables.”

4) Click “I-MR Options” button and a new window “Individual – Moving Range 

Chart – Options” appears.

5) Click on the tab “Tests.”

6) Select the item “Perform all tests for special causes” in the dropdown box.

7) Click “OK” in the window “Individuals – Moving Range Chart Options.”

8) Click “OK.”

9) The I-MR charts appear in the newly-generated window.
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Use Minitab to Plot I-MR Charts
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I-MR Charts Diagnosis

• I Chart (Individuals’ Chart):

• Since the MR chart is out of 
control, the I chart is invalid. 

• MR Chart (Moving Range Chart):

• Two data points fall beyond the 
upper control limit. This indicates 
the MR chart is out of control (i.e., 
the variations between every two 
contiguous individual samples are 
not stable over time).

• We need to further investigate the 
process, identify the root causes 
that trigger the outliers, and 
correct them to bring the process 
back in control.
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5.2.3 Xbar-R Chart
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Xbar-R Chart

• The Xbar-R chart is a control chart for continuous data with a constant 
subgroup size between two and ten.

• The Xbar chart plots the average of a subgroup as a data point.

• The R chart plots the difference between the highest and lowest values 
within a subgroup as a data point. 

• The Xbar chart monitors the process mean and the R chart monitors 
the variation within subgroups.

• The Xbar is valid only if the R chart is in control.

• The underlying distribution of the Xbar-R chart is normal distribution.
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Xbar Chart Equations

• Xbar chart

• Data Point:

• Center Line:

• Control Limits:

m

x

X

m

j

ij

i


=

=
1

k

X

X

k

i

i
== 1

RAX 2

where m is the subgroup size and k is the number of 

subgroups. A2 is a constant depending on the subgroup size.
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R Chart Equations

• R chart (Rage Chart)

• Data Point:

• Center Line:

• Upper Control Limit:

• Lower Control Limit:

   
)()(

,1,1
ij

mj
ij

mj
i xMinxMaxR


−=

k

R

R

k

i

i
== 1

where m is the subgroup size and k is the number of 

subgroups. D3 and D4 are constants depending on the 

subgroup size.

RD 4

RD 3
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Use Minitab to Plot Xbar-R Charts

• Data File: “Xbar-R” tab in “Sample Data.xlsx”

• Steps to plot Xbar-R charts in Minitab 

• Click Stat → Control Charts → Variable Charts for Subgroups → Xbar-R.

• A new window named “Xbar-R Chart” appears.

• Click in the blank box right below “All observations for a chart are in one column” and the 
variables appear in the list box on the left.

• Select the “Measurement” into the box below “All observations for a chart are in one column.”

• Select the “Subgroup ID” as the “Subgroup size (enter a number or ID column).

• Click “Xbar-R Options” button and a new window “Xbar-R Chart – Options” appears.

• Click on the tab “Tests.”

• Select the item “Perform all tests for special causes” in the dropdown menu.

• Click “OK” in the window “Xbar-R Chart – Options.”

• Click “OK.”

• The Xbar-R charts appear in the newly-generated window.
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Use Minitab to Plot Xbar-R Charts
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Xbar-R Charts Diagnosis

• Xbar-R Chart Interpretation:

• Since the R chart is in control, 

the Xbar chart is valid. 

• In both charts, there are not 

any data points failing any 

tests for special causes (i.e., 

all the data points fall between 

the control limits and spread 

around the center line with a 

random pattern). 

• We conclude that the process 

is in control.
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5.2.4 U Chart
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Defect vs. Defective

• A defect of a unit is the unit’s characteristic that does not meet the 

customers’ requirements.

• A defective is a unit that is not acceptable to the customers.

• One defective might have multiple defects.

• One unit might have multiple defects but be still usable to the 

customers.
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U Chart

• The U chart is a control chart monitoring the average defects per unit.

• The U chart plots the count of defects per unit of a subgroup as a data 

point.

• It considers the situation when the subgroup size of inspected units for 

which the defects would be counted is not constant.

• The underlying distribution of the U chart is Poisson distribution.
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U Chart Equations

• U chart

• Data Point:

• Center Line:

• Control Limits:
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where ni is the subgroup size for the ith subgroup;

k is the number of subgroups;

xi is the number of defects in the ith subgroup.
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Use Minitab to Plot a U Chart

• Data File: “U” tab in “Sample Data.xlsx”

• Steps to plot a U chart in Minitab 

1) Click Stat → Control Charts → Attributes Charts → U.

2) A new window named “U Chart” appears.

3) Select “Count of Defects” as the “Variables.”

4) Select “Count of Units Inspected” as the “Subgroup Sizes.”

5) Click the button “U Chart Options” and another window named “U Chart 
Options” pops up.

6) Click the tab “Tests.”

7) Select the item “Perform all tests for special causes” in the dropdown menu.

8) Click “OK” in the window “U Chart Options.”

9) Click “OK” in the window “U Chart.”

10) The U chart appears in the newly-generated window.
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Use Minitab to Plot a U Chart
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Use Minitab to Plot a U Chart

• U Chart Interpretation:

• Since the sample sizes are 
not constant over time, the 
control limits are adjusted to 
different values accordingly.

• The data point circled in red 
falls beyond the upper control 
limit. We conclude that the 
process is out of control. 

• Further investigation is 
needed to determine the 
special causes that triggered 
the unnatural pattern of the 
process. 
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5.2.5 P Chart
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P Chart

• The P chart is a control chart monitoring the percentages of defectives.

• The P chart plots the percentage of defectives in one subgroup as a 

data point.

• It considers the situation when the subgroup size of inspected units is 

not constant.

• The underlying distribution of the P chart is binomial distribution.
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P Chart Equations

• P chart

• Data Point:

• Center Line:

• Control Limits:
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where ni is the subgroup size for the ith subgroup;

k is the number of subgroups;

xi is the number of defectives in the ith subgroup.
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Use Minitab to Plot a P Chart

• Data File: “P” tab in “Sample Data.xlsx”

• Steps to plot a P chart in Minitab 

1) Click Stat → Control Charts → Attributes Charts → P.

2) A new window named “P Chart” appears.

3) Select “Fail” as the “Variables.”

4) Select “N” as the “Subgroup Sizes.”

5) Click the button “P Chart Options” and another window named “P Chart 
Options” pops up.

6) Click the tab “Tests.”

7) Select the item “Perform all tests for special causes” in the dropdown menu.

8) Click “OK” in the window “P Chart Options.”

9) Click “OK.”

10) The P chart appears in the newly-generated window.
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Use Minitab to Plot a P Chart
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P Chart Diagnosis

• P Chart Interpretation:

• Since the sample sizes are 

not constant over time, the 

control limits are adjusted to 

different values accordingly. 

• All the data points fall within 

the control limits and spread 

randomly around the mean. 

We conclude that the 

process is in control.
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5.2.6 NP Chart
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NP Chart

• The NP chart is a control chart monitoring the count of defectives.

• The NP chart plots the number of defectives in one subgroup as a data 

point.

• The subgroup size of the NP chart is constant.

• The underlying distribution of the NP chart is binomial distribution.
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NP Chart Equations

• NP chart

• Data Point:

• Center Line: 

• Control Limits:

ix

where n is the constant subgroup size;

k is the number of subgroups;

xi is the number of defectives in the ith subgroup.

k

x

pn

k

i

i
== 1

)1(3 ppnpn −
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Use Minitab to Plot an NP Chart

• Data File: “NP” tab in “Sample Data.xlsx”

• Steps to plot a NP chart in Minitab

1. Click Stat → Control Charts → Attributes Charts → NP.

2. A new window named “NP Chart” appears.

3. Select “Fail” as the “Variables.”

4. Enter “50” as the “Subgroup Sizes.”

5. Click the button “NP Chart Options” and another window named “NP Chart 
Options” pops up.

6. Click the tab “Tests.”

7. Select the item “Perform all tests for special causes” in the dropdown menu.

8. Click “OK” in the window “NP Chart Options.”

9. Click “OK.”

10. The NP chart appears in the newly-generated window.
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Use Minitab to Plot an NP Chart
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NP Chart Diagnosis

• NP Chart Interpretation:

• Four data points, circled in 

red, fall beyond the upper 

control limit. 

• We conclude that the NP 

chart is out of control. 

• Further investigation is 

needed to determine the 

special causes that triggered 

the unnatural pattern of the 

process. 
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5.2.7 X-S Chart
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X-S Chart

• The X-S chart (also called Xbar-S chart) is a control chart for 
continuous data with a constant subgroup size greater than ten.

• The Xbar chart plots the average of a subgroup as a data point.

• The S chart plots the standard deviation within a subgroup as a data 
point. 

• The Xbar chart monitors the process mean and the S chart monitors 
the variability within subgroups.

• The Xbar is valid only if the S chart is in control.

• The underlying distribution of the Xbar-S chart is normal distribution.
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Xbar Chart Equations

• Xbar Chart

• Data Point:

• Center Line:

• Control Limits:

m

x

X

m

j

ij
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=
1

k

X

X

k

i
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== 1

sAX 3

where m is the subgroup size and k is the number of 

subgroups. A3 is a constant depending on the subgroup size.
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S Chart Equations

• S chart

• Data Point:

• Center Line:

• Upper Control Limit:

• Lower Control Limit:

1

)(
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where m is the subgroup size and k is the number of subgroups. 

B3 and B4 are constants depending on the subgroup size.

sB 4

sB 3
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Use Minitab to Plot Xbar-S Charts

• Data File: “Xbar-S” tab in “Sample Data.xlsx”

• Steps to plot Xbar-S charts in Minitab 

1) Click Stat → Control Charts → Variables Charts for Subgroups → Xbar-S.

2) A new window named “Xbar-S Chart” appears.

3) Select “Measurement” by ticking the box below “All observations for a chart are in 
one column.”

4) Select “Subgroup ID” as the “Subgroup Sizes.”

5) Click the button “Xbar-S Options” and another window named “Xbar-S Chart 
Options” pops up.

6) Click the tab “Tests.”

7) Select the item “Perform all tests for special causes” in the dropdown menu.

8) Click “OK” in the window “Xbar-S Chart Options.”

9) Click “OK.”

10) The Xbar-S charts appear in the newly-generated window.
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Use Minitab to Plot Xbar-S Charts
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Use Minitab to Plot Xbar-S Charts
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Xbar-S Charts Diagnosis

• Xbar-S Chart Interpretation:

• Since the S chart is in control, 

the Xbar chart is valid. 

• In both charts, there are not any 

data points failing any tests for 

special cause (i.e., all the data 

points fall between the control 

limits and spread around the 

center line with a random 

pattern). 

• We conclude that the process is 

in control.
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5.2.8 CumSum Chart
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CumSum Chart

• The CumSum chart (also called cumulative sum control chart or 

CUSUM chart) is a control chart of monitoring the cumulative sum of 

the subgroup mean deviations from the process target.

• It detects the shift of the process mean from the process target over 

time.

• The underlying distribution of the CumSum chart is normal distribution.

• There are two types of CumSum charts:

• One two-sided CumSum charts

• Two one-sided CumSum charts.
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Two-Sided CumSum

• In two-sided CumSum charts, we use a V-mask to identify out-of-

control data points.

• The V-mask is a transparent overlay shape of a horizontal “V” applied 

on the top of the CumSum chart. Its origin point is placed on the last 

data point of the CumSum chart and its center line is horizontal.

• If all of the data points stay inside the V-mask, we consider the process 

is in statistical control.
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V-Mask

Origin point on the V-mask, which is 

applied right on the last data point 

of the CumSum chart.

The center line of the V-mask, 

which should be parallel to the x 

axis (time).

Upper boundary of V-mask

Lower boundary of V-Mask

If any data points in the CumSum chart to the left of the origin point are 

outside the V-mask, the process is considered out of statistical control.
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Two-Sided CumSum Equations

• Two-Sided CumSum

• Data Point:

• V-Mask Slope:

• V-Mask Width at the Origin Point:

where is the mean of the ith subgroup;

T is the process target;

σ is the estimation of process standard deviation;

m is the subgroup size. 
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One-Sided CumSum

• We can also use two one-sided CumSum charts to detect the shift of 

the process mean from the process target.

• The upper one-sided CumSum detects the upward shifts of the process 

mean.

• The lower one-sided CumSum detects the downward shifts of the 

process mean.
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One-Sided CumSum Equations

• One-Sided CumSum

• Data Point:

• Center Line: 

• Upper Control Limit:

• Lower Control Limit: 

where is the mean of the ith subgroup;

T is the process target;

k is the slope of the lower boundary of the V-mask.
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Use Minitab to Plot a CumSum Chart

• Data File: “CumSum” tab in “Sample Data.xlsx”

• Steps in Minitab to plot CumSum charts

1. Click Stat → Control Charts → Time Weighted Charts → CUSUM.

2. A new window named “CUSUM Chart” appears.

3. Select “weight” in the box below “All observations for a chart are in one column.”

4. Select “hour” as the “Subgroup sizes.”

5. Enter “8.1” as “Target.”

6. Click the button “CUSUM Options” and another window named “CUSUM Chart –
Options” pops up.

7. Click the tab “Plan/Type.”

8. Select the radio button “V-mask.”

9. Click “OK” in the window “CUSUM Chart Options.”

10. Click “OK.”

11. The CUSUM chart appears in the newly-generated window.
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Use Minitab to Plot a CumSum Chart
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Use Minitab to Plot a CumSum Chart

• CumSum Chart 

Interpretation:

• The process is in control 

since all of the data points 

fall between the two arms of 

the V-mask.
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5.2.9 EWMA Chart

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1220



www.ABTU.edu

EWMA Chart

• The EWMA chart (Exponentially-Weighted Moving Average Chart) is a 

control chart monitoring the exponentially-weighted average of 

previous and present subgroup means.

• The more recent data get more weight than more historical data.

• It detects the shift of the process mean from the process target over 

time.

• The underlying distribution of the EWMA chart is normal distribution.
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EWMA Chart Equations

• EWMA Chart

• Data Point: 

• Center Line:

• Control Limits:
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where is the mean of the ith subgroup;

λ and k are user-defined parameters to calculate the EWMA 

data points and the control limits.
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Use Minitab to Plot an EWMA Chart

• Data File: “EWMA” tab in “Sample Data.xlsx”

• Steps in Minitab to plot EWMA charts

1. Click Stat → Control Charts → Time Weighted Charts → EWMA.

2. A new window named “EWMA Chart” appears.

3. Select “Gap” in the box below “All observations for a chart are in one column.”

4. Select “Sample” as the “Subgroup sizes.”

5. Enter “0.5” as “Weight of EWMA.”

6. Click “OK.”

7. The EWMA chart appears in the newly-generated window.
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Use Minitab to Plot an EWMA Chart
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Use Minitab to Plot an EWMA Chart

• EWMA Chart Interpretation:

• One data point falls beyond 

the upper control limit and we 

conclude that the process is 

out of control.

• Further investigation is 

needed to discover the root 

cause for the outlier.
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5.2.10 Control Methods
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Control Methods

• There are many control methods available to keep the process stable 

and minimize the variation.

• Most common control methods:

• SPC (statistical process control)

• 5S method

• Kanban

• Poka-Yoke (mistake proofing).
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SPC

• SPC (Statistical Process Control) is a quantitative control method to 

monitor the stability of the process performance by identifying the 

special cause variation in the process.

• It uses control charts to detect the unanticipated changes in the 

process. 

• Which control chart to use depends on:

• Whether the data are continuous or discrete

• How large the subgroup size is

• Whether the subgroup size is constant

• Whether we are interested in measuring defects or defectives

• Whether we are interested in detecting the shifts in the process mean.
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5S

• 5S is a systematic approach of cleaning and organizing the workplace.

• Seiri (sorting)

• Seiton (straightening)

• Seiso (shining)

• Seiketsu (standardizing)

• Shisuke (sustaining)
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Kanban

• A Kanban system is a demand-driven system.

• The customer demand is the signal to trigger or pull the production. 

• Products are made only to meet the immediate demand. When there is 

no demand, there is no production.

• It was designed to reduce the waste in inventory and increase the 

speed of responding to immediate demand.
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Poka-Yoke

• Poka-yoke is a mechanism to eliminate the defects as early as 

possible in the process.

• Contact Method

• Use of the shape, color, size, or any other physical attributes of the items

• Constant Number Method

• Use of a fixed number to make sure a certain number of motions are 

completed

• Sequence Method

• Use of a checklist to make sure all the prescribed process steps are 

followed in the right order.
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5.2.11 Control Chart Anatomy
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Control Chart Calculations Summary
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Control Chart Constants
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Unnatural Patterns

• If there are unnatural patterns in the control chart of a process, we 

consider the process out of statistical control.

• Typical unnatural patterns in control charts:

• Outliers

• Trending

• Cycling

• Auto-correlative

• Mixture.

• A process is in control if all the data points on the control chart are 

randomly spread out within the control limits.
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Western Electric Rules

• Western Electric Rules are the most popular decision rules to detect 

unnatural patterns in the control charts. They are a group of tests for 

special causes in a process.

• The area between the upper and lower control limits is separated into 

six subzones.

• Zone A: between two and three standard deviations from the center line

• Zone B: between one and two standard deviations from the center line

• Zone C: within one standard deviation from the center line.
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Western Electric Rules

• Zone A: three sigma zone

• Zone B: two sigma zone

• Zone C: one sigma zone

• If a data point falls onto the dividing line of two consecutive zones, the point 
belongs to the outer zone.

C
B
A

A
B
C

Upper control limit

Lower control limit

Center line

Observation
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Western Electric Rules

• Test 1: 1 point more than 3 standard deviations from the center line 

(i.e., 1 point beyond zone A)
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Western Electric Rules

• Test 2: 9 points in a row on the same side of the center line
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Western Electric Rules

• Test 3: 6 points in a row steadily increasing or steadily decreasing
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Western Electric Rules

• Test 4: 14 points in a row alternating up and down
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Western Electric Rules

• Test 5: 2 out of 3 points in a row at least 2 standard deviations from the 

center line (in zone A or beyond) on the same side of the center line
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Western Electric Rules

• Test 6: 4 out of 5 points in a row at least 1 standard deviation from the 

center line (in zone B or beyond) on the same side of the center line
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Western Electric Rules

• Test 7: 15 points in a row within 1 standard deviation from the center 

line (in zone C) on either side of the center line
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Western Electric Rules

• Test 8: 8 points in a row beyond 1 standard deviation from the center 

line (beyond zone C) on either side of the center line
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Next Steps

• If no data points fail any tests for special causes, the process is in 

statistical control.

• If any data point fails any tests for special causes, the process is 

unstable and we will need to investigate the observation thoroughly to 

discover and take actions on the special causes leading to the 

changes.

• Process stability is the prerequisite of process capability analysis.
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5.2.12 Subgroups & Sampling
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Subgroups

• Rational subgrouping is the basic sampling scheme in SPC (Statistical 

Process Control).

• When sampling, we randomly select a group (i.e., a subgroup) of items 

from the population of interest.

• The subgroup size is the count of samples in a subgroup. It can be 

constant or variable.

• Depending on the subgroup sizes, we select different control charts 

accordingly.
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Impact of Variation

• The rational subgrouping strategy is designed to minimize the 

opportunity of having special cause variation within subgroups.

• If there is only random variation (background noise) within subgroups, 

all the special cause variation would be reflected between subgroups. It 

is easier to detect the out-of-control situation.

• Random variation is inherent and indelible in the process. We are more 

interested in identifying and taking actions on special cause variation.
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Frequency of Sampling

• The frequency of sampling in SPC depends on whether we have 

sufficient data to signal the changes in a process with reasonable time 

and costs.

• The more frequently we sample, the higher the costs sampling may 

trigger.

• We need the subject matter experts’ knowledge on the nature and 

characteristics of the process to make good decisions on sampling 

frequency.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1250



www.ABTU.edu

5.3 Six Sigma Control Plans
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Black Belt Training: Control Phase

5.1 Lean Controls

5.1.1 Control Methods for 5S

5.1.2 Kanban

5.1.3 Poka-Yoke (Mistake Proofing)

5.2 Statistical Process Control (SPC)

5.2.1 Data Collection for SPC

5.2.2 I-MR Chart

5.2.3 Xbar-R Chart

5.2.4 U Chart

5.2.5 P Chart

5.2.6 NP Chart

5.2.7 X-S chart

5.2.8 CumSum Chart

5.2.9 EWMA Chart

5.2.10 Control Methods

5.2.11 Control Chart Anatomy

5.2.12 Subgroups, Variation, Sampling

5.3 Six Sigma Control Plans

5.3.1 Cost Benefit Analysis

5.3.2 Elements of the Control Plan

5.3.3 Elements of the Response Plan
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5.3.1 Cost Benefit Analysis
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What is Cost-Benefit Analysis?

• The cost-benefit analysis is a systematic method to assess and 

compare the financial costs and benefits of multiple scenarios in order 

to make sound economic decisions.

• A cost-benefit analysis is recommended to be done at the beginning of 

the project based on estimations of the experts from the finance team 

in order to determine whether the project is financially feasible. 

• It is recommended to update the cost-benefit analysis at each DMAIC 

phase of the project.
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Why Cost-Benefit Analysis?

• In the Define phase of the project, the cost-benefit analysis helps us 

understand the financial feasibility of the project.

• In the middle phases of the project, updating and reviewing the cost-

benefit analysis helps us compare potential solutions and make robust 

data-driven decisions.

• In the Control phase of the project, the cost-benefit analysis helps us 

track the project’s profitability.
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Return on Investment

• Return on investment (also called ROI, rate of return, or ROR) is the 

ratio of the net financial benefits (either gain or loss) of a project or 

investment to the financial costs.

%100=
TotalCosts

nefitsTotalNetBe
ROI

where

TotalCostsitsTotalBenefnefitsTotalNetBe −=
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Return on Investment (ROI)

• The return on investment is used to evaluate the financial feasibility 

and profitability of a project or investment.

• If ROI < 0, the investment is not financially viable.

• If ROI = 0, the investment has neither gain nor loss.

• If ROI > 0, the investment has financial gains.

• The higher the ROI, the more profitable the project.
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Net Present Value (NPV)

• The net present value (also called NPV, net present worth, or NPW) is 

the total present value of the cash flows calculated using a discount 

rate.

t

t

r

wNetCashFlo
NPV

)1( +
=

Where

NetCashFlowt is the net cash flow happening at time t;

r is the discount rate;

t is the time of the cash flow. 
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Cost Estimation

• Examples of costs triggered by the project:

• Administration

• Asset

• Equipment

• Material

• Delivery

• Real estate

• Labor

• Training

• Consulting.
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Benefits Estimation

• Examples of benefits generated by the project:

• Direct revenue increase

• Waste reduction

• Operation cost reduction

• Quality and productivity improvement

• Market share increase

• Cost avoidance

• Customer satisfaction improvement

• Associate satisfaction improvement.
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Challenges in Cost and Benefit Estimation 

• Different analysts might come up with different cost and benefit 

estimations due to their subjectivity in determining:

• The discount rate

• The time length of the project and its impact

• Potential costs of the project

• The tangible/intangible benefits of the project

• The specific contribution of the project to the relevant financial gains/loss.
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5.3.2 Elements of Control Plans
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Control Plans

• The control plans ensure that the changes introduced by a Six Sigma 
project are sustained over time.

• Benefits of the Control phase:

• Methodical roll-out of changes including standardization of processes and work 
procedures

• Ensure compliance with changes through methods like auditing and corrective 
actions

• Transfer solutions and learning across the enterprise

• Plan and communicate standardized work procedures

• Coordinate ongoing team and individual involvement

• Standardize data collection and procedures

• Measure process performance, stability, and capability

• Plan actions that mitigate possible out-of-control conditions

• Sustain changes over time.
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What is a Control Plan?

• A control plan is a management planning tool to identify, describe, and 

monitor the process performance metrics in order to meet the customer 

specifications steadily.

• It proposes the plan of monitoring the stability and capability of inputs 

and outputs of critical process steps in the Control phase of a project.

• It covers the data collection plan of gathering the process performance 

measurements.

• Control plans are the most overlooked element of most projects. It is 

critical that a good solution be solidified with a great control plan!
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Control Plan Elements

• Control Plan

• The clear and concise summary document that details key process steps, 
CTQs metrics, measurements, and corrective actions.

• Standard Operating Procedures (SOPs)

• Supporting documentation showing the “who does what, when, and how” in 
completing the tasks.

• Communication Plan

• Document outlining messages to be delivered and the target audience.

• Training Plan

• Document outlining the necessary training for employees to successfully 
perform new processes and procedures.

• Audit Checklists

• Document that provides auditors with the audit questions they need to ask.

• Corrective Actions

• Activities that need to be conducted when an audit fails.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1265



www.ABTU.edu

Control Plan

• The control plan identifies critical process steps that have significant 

impact on the products or services and the appropriate controls 

mechanisms.

• The control plan includes measurement systems that monitor and help 

manage key process step performance.

• Specified limits and targets of the performance metrics are clearly 

defined and communicated.

• Sampling plans to collect the measurements are declared:
• How many samples are needed?

• How often do we need to sample?

• Where should we sample?
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Control Plan

Key processes and process 

steps are identified
d

Critical information regarding key 

measurements is documented and clarified
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Control Plan

Measurements are clearly 

defined with equations

Customer 

specifications 

are declared 

Other key measurement information is documented: 

sample size, measurement frequency, people responsible 

for the measurement, etc.
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Control Plan

Where will this measurement or report 

be found? Good control plans provide 

linking information or other report 

reference information.

Control plans identify the mitigating action or 

corrective actions required in the event the 

measurement falls out of spec or control. 

Responsible parties are also declared.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1269



www.ABTU.edu

Standard Operating Procedures (SOPs)

• Standard Operating Procedures (SOPs) are documents that focus on 

process steps, activities, and specific tasks required to complete an 

operation.

• SOPs should not be much more than two to four pages.

• SOPs should be written to the user’s level of required detail and information.

• The level of detail is dependent on the position’s required skills and training

• Good SOPs are auditable, easy to follow, and not difficult to find.

• Auditable characteristics are: observable actions and countable frequencies. 

Results should be evident to a third party (compliance to the SOP must be 

measurable).
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SOP Elements

• SOPs are intended to impart high value information in concise and 

well-documented manner.

• SOP Title and Version Number: 

• Provide a title and unique identification number with version information.

• Date: 

• List the original creation date; add all revision dates.

• Purpose: 

• State the reason for the SOP and what it intends to accomplish.

• Scope: 

• Identify all functions, jobs, positions, and/or processes governed or 

affected by the SOP. 

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1271



www.ABTU.edu

SOP Elements

• Responsibilities: 

• Identify job functions and positions (not people) responsible for carrying out 
activities listed in the SOP.

• Materials:

• List all material inputs: parts, files, data, information, instruments, etc.

• Process Map:

• Show high level or level two to three process maps or other graphical 
representations of operating steps.

• Process Metrics:

• Declare all process metrics and targets or specifications.

• Procedures:

• List actual steps required to perform the function.

• References:

• List any documents that support the SOP.
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SOP Template
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Communication Plans

• Communication plans are documents that focus on planning and preparing for the 
dissemination of information.

• Communication plans organize messages and ensure that the proper audiences receive 
the correct message at the right time.

• A good communication plan identifies:

• Audience

• Key points/message

• Medium (how the message is to be delivered)

• Delivery schedule

• Messenger

• Dependencies and escalation points

• Follow-up messages and delivery mediums.

• Communication plans help develop and execute strategies for delivering changes to an 
organization. 
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Communication Plan Template
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Training Plans

• Training plans are used to manage the delivery of training for new processes and 
procedures.

• Most GB or BB projects will require changes to processes and/or procedures that 
must be executed or followed by various employees.

• Training plans should incorporate all SOPs related to performing new or modified 
tasks.

• Training plans use and support existing SOPs and do not supersede them.

• Training plans should include logistics:
• One-on-one or classroom

• Instruction time 

• Location of training materials

• Master training reference materials

• Instructors and intended audience

• Trainee names.

L
e

a
n

 S
ix

 S
ig

m
a

 T
ra

in
in

g
 -

M
T

B
©

 A
m

e
ric

a
n

 B
&

T
 U

n
iv

e
rs

ity

1276



www.ABTU.edu

Training Plan Template
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Audits

• What is an audit?

• ISO 9000 defines an Audit as “a systematic and independent examination 

to determine whether quality activities and related results comply with 

planned arrangements and whether these arrangements are implemented 

effectively and are suitable to achieve objectives.”

• Audits are used to ensure actions, processes, procedures, and other 

tasks are performed as expected.
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Audit Guidelines

• Audits should be directed by managers, supervisors, and other accountable 
positions.

• An audit’s purpose must be well-defined and executed by independent 
unbiased personnel.

• Auditors must:

• Be qualified to perform their tasks

• Attend and successfully complete an internal auditing training session

• Be able to identify whether or not activities are being followed according to the 
defined SOP

• Base conclusions on facts and objective evidence

• Use a well documented audit checklist.

• Audits should confirm compliance or declare non-compliance.
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Audit Checklists

• Auditors should review the SOPs before preparing checklists or ensure that 
existing checklists properly reference SOPs.

• Audit checklists:

• Serve as guides for identifying items to be examined 

• Are used in conjunction with understanding of the procedure

• Ensure a well-defined audit scope

• Identify needed facts during audits

• Provide places to record gathered facts.

• Checklists should include:

• A review of training records

• A review of maintenance records

• Questions or observations that focus on expected behaviors

• Questions should be open-ended where possible

• Definitive observations yes/no, true/false, present/absent, etc.
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Audit Checklist Template
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5.3.3 Response Plan Elements
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What is a Response Plan?

• A response plan should be a component of as many control plan 

elements as possible.

• Response plans are a management planning tool to describe corrective 

actions necessary in the event of out-of-control situations.

• There is never any guarantee that processes will always perform as 

designed. Therefore, it is wise to prepare for occasions when special 

causes are present.

• Response plans help us mitigate risks and, as already mentioned, 

should be part of several control plan elements.
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Response Plan Elements

• Action triggers

• When do we need to take actions to correct a problem or issue?

• Action recommendation

• What activities are required in order to solve the problem in the process? 
The action recommended can be short-term (quick fix) or long-term (true 
process improvement).

• Action respondent

• Who is responsible for taking actions?

• Action date

• When did the actions happen?

• Action results

• What actions have been taken?

• When were actions taken?

• What are the outcomes of the actions taken?
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Response Plan Elements

Note the response plan element in this control plan template
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Response Plan Elements

Note the response plan element in this communication plan template
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Response Plan Elements

Note the response 

plan element in this 

audit checklist
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